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{HEC-RAS, River Analys.is System",
Short Course Outline

Presented by:
David T. Williams, Ph:D:','P.E.

WEST Consultants, Carlsbad, CA:'
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•
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• HEC-RAS, River Analysis System

An Overview

Presented by
David T. Williams, Ph.D., P.E.

WEST Consultants, Inc., Carlsbad, CA

Note: The following information contains selected parts of Chapter 3 of the HEC­
RAS User's Manual

•

•

I. What is HEC-RAS ?

HEC-RAS is an integrated package of hydraulic analysis programs, in which the
user interacts with the system through the use of a Graphical User Interface (GUI).

The system is capable of performing Steady Flow water surface profile calculations,
and will include Unsteady Flow, Sediment Transport, and several hydraulic design
computations in the future.

In HEC-RAS terminology, a Project is a set of data files associated with a particular
river system. The modeler can perform any or all of the various types of analyses,
included in the HEC-RAS package, as part of the project.

The data files for a project are categorized as follows: plan data, geometric data,
steady flow data, unsteady flow' data, and sediment data.

During the course of a study the modeler may want to formulate several different
Plans.

Each plan represents a specific set of geometric data and flow data.
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Once the basic data are entered into the HEC-RAS, the modeler can easily formulate •
new plans.

After simulations are made for the various plans, the results can be compared in both
tabular and graphical form.

This presentation provides an overview of how a study is performed with the HEC­
RAS software. Special topics on how to import HEC-2 data and how to use on-line
help are also covered.

II. Starting HEC-RAS

When you run the HEC-RAS Setup program, you automatically get a new program
group and program icon for HEC-RAS in Windows. They should appear as shown
in Figure 1.

Figure 1. The HEC-RAS Icon in Windows

To Start HEC-RAS from Windows:

• Double-click on the HEC-RAS Icon.

•

When you first start HEC-RAS, you will see the main window as shown in Figure •
2.
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Figure 2. The HEC-RAS Main Window

The HEC-RAS main window has the following options on the menu bar:

File; Edit; View; Options; and Help

III. Steps in Developing a Hydraulic Model
with HEC-RAS

There are five main steps in creating a hydraulic model with HEC-RAS:

• Starting a new project

• Entering geometric data

• Entering flow and/or sediment data

• Performing the hydraulic calculations

• Viewing and printing results

3



A. Starting a Project

The first step in developing a hydraulic model with HEC-RAS is to establish which
directory you wish to work in and to enter a title for the new project.

A new project window is shown in Figure 3.

•

Steady Flow Example from Chapter 4
HEC 201 Test of HEC-2 File Importer
Multiple Opening Test
Mixed Flow Project
Multiple Pipe Run from HEC 2Data
HEC 2Normal BT
HEC-2 One Box Data Set
HEC 2Data Set One Pi e Culvert

exl.prj
hec201.prj
k1 b1 c1.prj
mixed.prj
multpipe.prj
normalbt.prj
onebox.prj
one I e. r •

Figure 3. New Project window

Note: Before any Geometric data and Flow data are entered, the user should
select the Units System (English or Metric) that they would like to work in.

B. Entering Geometric Data

The next step is to enter the necessary geometric data, which consist of connectivity
information for the stream system (Stream Network), cross-section data, and •
hydraulic structure data (bridges, culverts, weirs, etc.).

4



• Geometric data are entered as shown in Figure 4 (except yours will be blank when
you first bring this screen up for a new project).

The modeler develops the geometric data by first drawing in the flver system
schematic.

Butte Cr.

Yolo River

utter

Fall Cr.

Figure 4. Geometric Data Window

•
After the reach is drawn, the user is prompted to enter an identifier for the reach.

As reaches are connected together, junctions are automatically formed by the
interface. The modeler is also prompted to enter an identifier for each junction.
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After the river system schematic is drawn, the modeler can start entering cross- •
section and hydraulic structure data.

Pressing the Cross Section button causes the cross section editor to pop up. This
editor is shown in Figure 5.

110
120
200
210
230
240
350
360

Figure 5. Cross Section Data editor

The Reach and River Station identifiers are used to describe where the cross
section is located in the river system.

6

•

•



•

•

•

Additional cross section features are available under Options from the menu bar.
These options include:

1. adding, copying, renaming and deleting cross sections

2. adjusting cross section elevations, stations, and n-values

3. ineffective flow areas, levees, blocked obstructions

4. adding a lid to a cross section

S. horizontal variation of n-values

6. setting the maximum number of station and elevation points

Also available from the Cross Section Data editor is the ability to plot any cross
section or reach profile.

c. Entering Flow and/or Sediment Data

Once the geometric data are entered, the modeler can then enter any flow data that
are required. An example of the flow data entry form is shown in Figure 6, which
is the Steady Flow Data form (the only one available for this version).

If a subcritical flow analysis is going to be performed, then only the downstream
boundary conditions are required.

If a supercritical flow analysis is going to be performed, then only the upstream
boundary conditions are required.

If the modeler is going to perform a mixed flow regime calculation, then both
upstream and downstream boundary conditions are required.

The Boundary Conditions data entry form can be brought up by pressing the Enter
Boundary Conditions button from the Steady Flow Data entry form.

7



Figure 6. Steady Flow Data Window

D. Performing The Hydraulic Computations

Once all of the geometric data and flow data are entered, the modeler can begin to
perform the hydraulic calculations.

The modeler can select the Steady State Flow hydraulic analysis from the Simulate
menu bar option on the HEC-RAS main window.

An example simulation window is shown in Figure 7.

8
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:

• Figure 7. Steady Flow Analysis window

As shown in Figure 7, the modeler puts together a Plan by selecting a specific set
of geometric data and flow data.

Once a plan has been put together, the modeler must select a Flow Regime for
which the model will perform calculations.

Subcritical, Supercritical, or Mixed flow regime calculations are available.

An option for selecting a Computation Range is also available. This option allows
the modeler to select a specific piece of the river system to work on (not available
in version 1.0).

Once the modeler has selected a Plan and set all of the calculation options, the
steady flow calculations can be performed by pressing the Compute button at the

• bottom of the Steady Flow Analysis window.

9



E. Viewing and Printing Results •Once the model has finished all of the computations, the modeler can begin viewing
the results. Several output features are available under the View option from the
main window.

These options include:

1. cross section plots;
2. profile plots;
3. rating curve plots;
4. X-Y-Z perspective plots;
5. tabular output at specific locations;
6. tabular output for many locations; and
7. the summary of errors, warnings, and notes.

An example of a cross section plot is shown in Figure 8.

•
Upstream Boundary of the Study

•

EGI

"lSI

Ground

•
BnnkStQ

12001000800600

Station (1t)

400

Figure 8. Cross Section Plot
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• The user can plot any cross section by simply selecting the appropriate reach and
river station from the list boxes at the top of the plot.

The user can also step through the plots by using the up and down arrow buttons.

Plots can be sent directly from HEC-RAS to whichever printer or plotter the user
has defined under the Windows Print Manager.

Plots can also be sent to the Windows clipboard. Once the plot is in the clipboard
it can then be pasted into other programs, such as a word processor.

An example of a profile plot is shown in Figure 9. All of the options available in
the cross section plot are also available in the profile plot.

Additionally, the user can select which specific reaches to plot when a multiple­
reach river system is being modeled.

•
ED1

.....'"
\I""

Cilia t

2000

Mixed Flow Plan

1000

f----------- M~d -----------l
r====l

File Options Help

7t:l

74

72

is
c: 70
0

~
> 63Q)

iIi ---- ---t:lt:l

64 -
62

00
0

Main Channel Distance (tt) 1234.41,71.89

• Figure 9. Profile Plot
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An example of an X-Y-Z Perspective Plot is shown in Figure 10.

Figure 10. X-Y-Z Perspective Plot of River Reach with a Bridge

The user has the option of defining the starting and ending location for the extent of
the plot. The plot can be rotated left or right, and up or down, in order to get
different perspectives of the river reach.

•

•

The computed water surface profiles can be overlaid on top of the cross section data. •
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•

The graphic can be sent to the printer or plotter directly, or the plot can be sent
through the Windows Clipboard to other programs.

Tabular output is available in two different formats:

The first type of tabular output provides detailed hydraulic results at a specific cross
section location (cross section table).

An example of this type of tabular output is shown in Figure 11.

Figure 11. Tabular Cross Section Output
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The second type of tabular output shows a limited number of hydraulic variables for
several cross sections and multiple profiles. An example of this type of tabular
output is shown in Figure 12.

Figure 12. Profile Output Table

There are several standard tables that are pre-defined and provided to the user under
the Tables menu from the profile output tables.

Users can also define their own tables by specifying what variables they would like
to have in a table.

•

•

Tabular output can be sent directly to the printer or passed through the clipboard in
the same manner as the graphical output described previously. •
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• IV. Importing HEC-2 Data

A. General

An important feature of HEC-RAS is the ability to import HEC-2 data. This feature
makes it easy for a user to import existing HEC-2 data sets and start using HEC­
RAS immediately.

B. Procedure

To import HEC-2 data, do the following:

1. Start a new project by selecting New Project under the File menu option on
the HEC-RAS main window (Figure 13).

•
Open Project ...
~ave Project

. Save Project As .
Rename Project .
Delete Project ...

Import HEC-2 Data ...
Import RAS Data ...

8sit

d:\vb\ras\data\redfox.prj
d:\vb\ras\data\redbrdg.prj
d:\hecras\hec201.prj
d:\hecras\exl.prj

• Figure 13. HEC-RAS Main Window With File Menu Options Shown
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2. Select the Import HEC-2 Data option under the File menu on the main
window (from Figure 13).

A pop-up window will appear (Figure 14), which will allow you to select a
drive, path, and filename for the HEC-2 data file.

IL Q.AK.8JQq~.l.M.~BG.V.BY...P.RQ.~.~.G.I. J:J.~ Q.l:!.~r.:.~.~~ .
Tl COTTENWOOD CREEK DIVERSION CHANN cwck09.dat
Tl KNOXVILLE. TN. fourth.dat
Tl KNOXVILLE. TN. fourthf3.dat
Tl TEST 9 SPECIAL BRIDGE.CLASS A AND B t9.dat
Tl yolo.dat

Figure 14. Pop-up Window For Importing HEC-2 Data

•

•
C. HEC-2 Options Not Transportable to HEC-RAS

The data associated with HEC-2 options that are not currently supported in HEC­
RAS are ignored. This includes:

1. vertical n values;
2. k values;
3. cross section interpolation;
4. split flow data;
5. channel improvements;
6. n value calibration; and
7. ice options.

The information from these options will be added to the HEC-2 import routine as the
options become available in HEC-RAS.

16
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• D. Importing HEC-2 Bridge Routines

When bridge data are imported, the user must take special care to ensure that the
data are correctly representing the bridge.

The bridge routines in HEC-RAS are different than HEC-2, and therefore you may
have to modify some data and/or enter some additional data.

Whenever you import an HEC-2 data set with bridge data, carefully review all the
data for each bridge. Chapter 6 of the User's manual describes the required data for
bridges in HEC-RAS.

V. Getting and Using Help

At this time, on-line help is not available in HEC-RAS. The Help system will be
added before the first official release. For any questions that you currently have,
please refer to the User's manual or the Hydraulics Reference manual.

•

•
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HEC-RAS, River Analysis System

Basic Input Data

Presented by
David T. Williams, Ph.D., P.E.

WEST Consultants, Inc., Carlsbad, CA

Note: This lecture is based upon Chapter 3 of the HEC-RAS Hydraulic
Reference Manual

I. General

This lecture describes the basic data requirements for performing the one­
dimensional flow calculations within HEC-RAS. The basic data are defined and
discussions of applicable ranges for parameters are provided.

The main objective of the HEC-RAS program is quite simple - compute water
surface elevations at all locations of interest for given flow values.

The data needed to perform these computations are divided into the following
categories:

1. Geometric data

2. Steady flow data

Geometric data are required for any of the analyses performed within HEC-RAS.

The current version of HEC-RAS is limited to steady flow computations, therefore,
geometric data and steady flow data are the only available data categories.



II. Geometric Data

•Hydraulic structure data (bridges, culverts, etc .. ), which are also considered
geometric data, will be described in later lectures.

A. The River System Schematic

General

The river system schematic is required for any geometric data set within the HEC­
RAS system.

The schematic defines how the various river reaches are connected, as well as
establishing a naming convention for referencing all the other data.

The river system schematic is developed by drawing and connecting the various
reaches of the system within the geometric data editor (see chapter 6 of the HEC- •
RAS User's Manual for details on how to develop the schematic from within the
user interface).

The user is required to develop the river system schematic before any other data can
be entered.

River Reach Identifier and Location

Each river reach on the schematic is given a unique identifier. As other data are
entered, the data are referenced to a specific reach of the schematic.

For example,_ each cross section must have a "reach" and "river station" identifier.
The reach identifier defines which reach the cross section lives in, while the river
station identifier defines where that cross section is located within the reach, with
respect to the other cross sections for that reach.

The user is required to draw each reach from upstream to downstream, in what is
considered to be the positive flow direction. •

2



• Junctions

The connection of reaches are considered junctions.

Junctions should not be established with a single reach flowing into another single
reach. These two reaches should be combined and defined as one reach.

An example river system schematic is shown in Figure 1.

Reach 13

~ Reach5

~ Reach 14

Reach 4

\

Junct 6

Reach 7

~

Reach 12

Reach 3

Reach 11

Reach 8

\

Reach 9

•

Figure 1. Example River System Schematic

• Arrows are automatically drawn on the schematic in the assumed positive flow
direction. Junctions are automatically formed as reaches are connected.
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A "network" model is where river reaches split apart and then come back together,
forming looped systems. An example schematic of a stream network is shown in
Figure 2. •

Reach 2~~",Junct 1
~

Reach 8

Reach 3

•

Reach 9

;;
Junct4

Reach 10

~ Reach 11

~

\Reach 13

Reach 1

{

Reach 7

J
Junct 5

~Reach 12

Junct 6

Reach 4

J
unct 3

Reach 6~

Junct 2

Reach 5~

Figure 2. Example Schematic for a Looped Network of Reaches

The current version of the steady flow model within HEC-RAS does not determine
the amount of flow going to each reach at a flow split, therefore, the user must
define the direction and amount of flow in each reach.

After a simulation is made, the user should adjust the flow (if it is a variable) in the
reaches in order to obtain a balance in energy around the junction of a flow split.

•
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•

•

B. Cross Section Geometry

Ground Points

1) Layout and Numbering of Cross Sections

Boundary geometry for the analysis of flow in natural streams is specified in terms
of ground surface profiles (cross sections) and the measured distances between them
(reach lengths).

Cross section spacing and location considerations will be discussed in later lectures
of this course.

Each cross section in an HEC-RAS data set is identified by a Reach· and River
Station label.

The River Station identifier may correspond to stationing along the channel, mile
points, or any fictitious numbering system.

The numbering system must be consistent, in that the program assumes that higher
numbers are upstream and lower numbers are downstream within a reach.

2) Data Entry

The cross section is described by entering the station and elevation (X-Y data) from
left to right, with respect to looking in the downstream direction.

The program considers the left side of the stream to have the lowest station numbers
and the right side to have the highest.

The left and right stations separating the main channel from the overbank areas must
be specified on the cross section data editor.

Up to 500 data points may be used to describe each cross section.

More than one point can have the same stationing value.

Cross section data are allowed to have negative stationing values.

5



3) Extension of Geometry End Points

End points of a cross section that are too low (below the computed water surface •
elevation) will automatically be extended vertically and a note indicating that the
cross section had to be extended will show up in the output for that section.

The program adds additional wetted perimeter for any water that comes into contact
with the extended walls.

Other Geometric Data

Other data that are required for each cross section consist of: downstream reach
lengths; roughness coefficients; and contraction and expansion coefficients. These
data will be discussed in detail later.

C. Optional Cross Section Properties

A series of program options are available to restrict flow to the effective flow areas
of cross sections. All of these capabilities are available from the "Options" menu •
of the Cross Section Data editor.

Ineffective Flow Areas

This option allows the user to define areas of the cross section that will contain water
that is not actively being conveyed (ineffective flow).

Ineffective flow areas are often used to describe portions of a cross section in which
water will pond, but the velocity of that water, in the downstream direction, is close
to zero.

This water is included in the storage calculations and other wetted cross section
parameters, but it is not included as part of the active flow area.

When using ineffective flow areas, no additional wetted perimeter is added to the
active flow area.

•
6



•
An example of an ineffective flow area is shown in Figure 3. The cross-hatched
area on the left of the plot represents what is considered to be the ineffective flow
area.

Reach 1, River station 3.0

1780 .1 0 1----.1~

4 Groud

•
8alkS1a

1775 - -.--
1.f:1'I'

£ Left ineffective tlUSl

c 1770
flow station

0
.~

>
(l)

W
1765

Right ineffective
flow station

1760

• 1755
0 500 1000 1500

Station (ft)

Figure 3. Cross section with ineffective flow areas

Two alternatives are available for setting ineffective flow areas.

1. Allows the user to define a left station and elevation and a right station
and elevation (normal ineffective areas).

When this option is used, and if the water surface is below the
established ineffective elevations, the areas to the left of the left station
and to the right of the right station are considered ineffective.

•
Once the water surface goes above either of the established elevations,
then that specific area is no longer considered ineffective.
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2. Allows for the establishment of blocked ineffective flow areas.
Blocked ineffective flow areas require the user to enter an elevation, a
left station, and a right station for each ineffective block. •
Up to five blocked ineffective flow areas can be entered at each cross
section.

Once the water surface goes above the elevation of the blocked
ineffective flow area, the blocked area· is no longer considered
ineffective.

Levees

This option allows the user to establish a left and/or right levee station and elevation
on any cross section. When levees are established, no water can go to the left of the
left levee station or to the right of the right levee station until either of the levee
elevations are exceeded.

Levee stations must be defined explicitly, or the program assumes that water can go
anywhere within the cross section. An example of a cross section with a levee on
the left side is shown in Figure 4. •

•
140012001COJ

~

Left levee station

Station (tt)

600400200

Figure 4. Example of the Levee Option
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>
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1800
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•
In this example the levee station and elevation is associated with an existing point
on the cross section.

The user may want to add levees into a data set in order to see what effect a levee will
have on the water surface. A simple way to do this is to set a levee station and
elevation that is above the existing ground.

If a levee elevation is placed above the existing geometry of the cross section, then
a vertical wall is placed at that station up to the established levee height.

Additional wetted perimeter is included when water comes into contact with the levee
wall. An example of this is shown in Figure 5.

Reach 1, River Station 3.0

• 1780 I .1 '1 0 I--- .1 ----I .
4 GrOlld

•
Left levee station la'kSlO

1775 and elevation
0

J
l>uet

- -&--

g htfr

C 1770 1JUS2
0
.~

>
(lJ

iIi
1765

1760

1755
0 500 1000 1500

Station (ftl

•
Figure 5. Example Levee Added to a Cross Section
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Blocked Obstructions

This option allows the user to define areas of the cross section that will be •
permanently blocked out. Blocked obstructions decrease flow area and add wetted
perimeter when the water comes in contact with the obstruction.

A blocked obstruction does not prevent water from going outside of the obstruction.

Two alternatives are available for entering blocked obstructions.

The first option allows the user to define a left station and elevation and a right
station and elevation (normal blocked areas).

When this option is used, the area to the left of the left station and to the right of the
right station will be completely blocked out.

An example of this type of blocked obstruction is shown in Figure 6.

•
Reach 1, River Station 80

002

001

lro:J1000

1--------- .1 --------i·I OI-- .1 ---j

4
1005

lOCO

g 1795
c
0
ij3

~ 1700
UJ

1785

1700
0

Staten ~

Figure 6. Example of Normal Blocked Obstructions •
10



•
The second option, for blocked obstructions, allows the user to enter up to 20
individual blocks (Multiple Blocks).

With this option the user enters a left station, a right station, and an elevation for each
of the blocks. An example of a cross section with multiple blocked obstructions is
shown in Figure 7.

Reach 8, River Station 8.0

""2

"'"
"""2

""'"

.
"""'".
Izri;SilII

1~1(0)

1--------.1------~I0f--.l --1

4
lW5

la:Il

g 1795
c::
0

~
6;

1700W

1785

• 1700
0

Slaton ~

Figure 7. Example of a Cross Section With Blocked Obstructions

D. Reach Lengths

The measured distances between cross sections are referred to as reach lengths. The
reach lengths for the left overbank, right overbank and channel are specified on the
cross section· data editor.

•
Channel reach lengths are typically measured along the thalweg.

Overbank reach lengths should be measured along the anticipated path of the center
of mass of the overbank flow.

11



Often, these three lengths will be of similar value.

There are conditions where they will differ significantly, such as at river bends, or •
where the channel meanders and the overbanks are straight.

Where the distances between cross sections for channel and overbanks are different,
a discharge-weighted reach length is determined based on the discharges in the main
channel and left and right overbank segments of the reach.

E. Energy Loss Coefficients

Several types of loss coefficients are utilized by the program to evaluate energy
losses:

1) Manning's n values for friction loss,

2) Contraction and expansion coefficients to evaluate transition (shock)
losses,

3)

Manning's n

Bridge and culvert loss coefficients to evaluate losses related to weir
shape, pier configuration, and pressure flow, and entrance and exit
conditions. Energy loss coefficients associated with bridges and
culverts will be discussed in chapters 5 and 6 of the Hydraulic
Reference Manual.

•

Selection of an appropriate value for Manning's n is very significant to the accuracy
of the computed water surface profiles.

The value of Manning's n is highly variable and depends on a number of factors
including: surface roughness; vegetation; channel irregularities; channel alignment;
scour and deposition; obstructions; size and shape of the channel; stage and
discharge; seasonal change; temperature; and suspended material and bedload.

In general, Manning's n values should be calibrated whenever observed water
surface profile information (gaged data, as well as high water marks) is available .

12
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When gaged data are not available, values of n computed for similar stream
conditions or values obtained from experimental data should be used as guides in

• selecting n values.

There are several references a user can access that show Manning I s n values for
typical channels. An extensive compilation of n values for streams and floodplains
can be found in Chow I s book "Open-Channel Hydraulics" [Chow, 1959].

Other sources that include pictures of selected streams as a guide to n value
determination are available (Fasken, 1963; Barnes, 1987; and Hicks and Mason,
1991). In general, these references provide color photos with tables of calibrated n
values for a range of flows.

Contraction and Expansion Coefficients

•

•

Contraction or expansion of flow due to changes in the cross section is a common
cause of energy losses within a reach (between two cross sections).

Whenever this occurs, the loss is computed from the contraction and expansion
coefficients specified on the cross section data editor.

The coefficients, which are applied between cross sections, are specified as part of
the data for the upstream cross section.

Where the change in river cross section is small, coefficients contraction and
expansion are typically on the order of 0.1 and 0.3, respectively.

When the change in effective cross section area is abrupt such as at bridges,
contraction and expansion coefficients of 0.3 and 0.5 are often used

On occasion, the coefficients of contraction and expansion around bridges and
culverts may be as high as 0.6 and 0.8, respectively.

These values may be changed at any cross section.

The maximum value for the contraction and expansion coefficient would be one
(1.0).
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F. Stream Junction Data

General Definition

Stream junctions are defined as locations where two or more streams come together
or split apart. Junction data consists of reach lengths across the junction and
tributary angles (only if the momentum equation is selected).

Reach Lengths Across Junctions

Reach lengths across the junction are entered in the Junction Data editor. This
allows for the lengths across very complicated confluences (e.g. flow splits) to be
accommodated.

An example of this is shown in Figure 8.

Reach 1

Figure 8. Example of a Stream Junction

•

•

As shown in Figure 8, using downstream reach lengths, for the last cross section in •
Reach 1, would not adequately describe the lengths across the junction.
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•

It is therefore necessary to describe lengths across junctions in the Junction Data
editor. For the example shown in Figure 8, two lengths would be entered.

These lengths should represent the average distance that the water will travel from
the last cross section in Reach 1 to the first cross section of the respective reaches.

In general, the cross sections that bound a junction should be placed as close
together as possible.

Junction Modeling Methods

In HEC-RAS a junction can be modeled by either the energy equation or the
momentum equation.

1) Energy Method

The energy equation does not take into account the angle of any tributary coming in
or leaving the main stream, while the momentum equation does.

In most cases, the amount of energy loss due to the angle of the tributary flow is not
significant, and using the energy equation to model the junction is more than
adequate.

2) Momentum Method

There are situations where the angle of the tributary can cause significant energy
losses. In these situations it would be more appropriate to use the momentum
approach.

When the momentum approach is selected, an angle for all tributaries of the main
stem must be entered.

A detailed description of how junction calculations are made can be found ill

Chapter 4 of the Hydraulic Reference Manual.
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III. Steady Flow Data

•Steady flow data are required in order to perform a steady water surface profile
calculation. Steady flow data consist of: flow regime; boundary conditions; and
peak discharge information.

A. Flow Regime

Profile computations begin at a cross section with known or assumed starting
conditions and proceed upstream for subcritical flow or downstream for supercritical
flow.

The flow regime (subcritical , supercritical, or mixed flow regime) is specified on
the Steady Flow Analysis window of the user interface.

Subcritical profiles computed by the program are constrained to critical depth or
above, and supercritical profiles are constrained to critical depth or below.

In cases where the flow regime will pass from subcritical to supercritical, or •
supercritical to subcritical, the program should be run in a mixed flow regime mode.

B. Boundary Conditions

General

Boundary conditions are necessary to establish the starting water surface at the ends
of the river system (upstream and downstream).

A starting water surface is necessary in order for the program to begin the
calculations. -

WSEL Requirements by Flow Regime

In a subcritical flow regime, boundary conditions are only necessary at the •
downstream ends of the river system.
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•

•

If a supercritical flow regime is going to be calculated, boundary conditions are only
necessary at the upstream ends of the river system.

If a mixed flow regime calculation is going to be made, then boundary conditions
must be entered at all ends of the river system.

Entering Boundary Condition Data

The boundary conditions editor contains a table listing every reach.

Each reach has an upstream and a downstream boundary condition.

Connections to junctions are considered internal boundary conditions. Internal
boundary conditions are automatically listed in the table, based on how the river
system was defined in the geometric data editor.

The user is only required to enter the necessary external boundary conditions. There
are four types of boundary conditions available to the user:

Known Water Surface Elevations

For this boundary condition the user must enter a known water surface elevation for
each of the profiles to be computed.

Critical Depth

When this type of boundary condition is selected, the user is not required to enter
any further information.

The program will calculate critical depth for each of the profiles and use that as the
boundary condition.

Norillal Depth

For this type of boundary condition, the user is required to enter an energy slope
that will be used in calculating normal depth (Manning I s equation) at that location.

17



A normal depth will be calculated for each profile based on the user entered slope.

In general, the energy slope can be approximated by using the average slope of the •
channel or the average slope of the water surface in the vicinity of the cross section.

Rating Curve

When this type of boundary condition is selected, a popup window appears allowing
the user to enter an elevation versus flow rating curve.

For each profile, the elevation is interpolated from the rating curve given the flow.

Guidelines for Estimating Starting WSEL

Using an estimated water surface can incorporate an error in the water surface
profile in the vicinity of the boundary condition.

If it is important to have accurate answers at cross sections near the boundary
condition, additional cross sections should be added.

1) Locations of Additional Cross Sections by Flow Regime

If a subcritical profile is being computed, then additional cross sections need only
be added below the downstream boundaries.

If a supercritical profile is being computed, then additional cross sections should be
added upstream of the relevant upstream boundaries.

If a mixed flow regime profile is being computed, then cross sections should be
added upstream and downstream of all the relevant boundaries.

2) Check. for Sufficiency of Additional Cross Sections

In order to test whether the added cross sections are sufficient for a particular
boundary condition, the user should try several different starting elevations at the
boundary condition, for the same discharge.
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•

If the water surface profile converges to the same answer, by the time the
computations get to the cross sections that are in the study area, then enough sections
have been added, and the boundary condition is not effecting the answers in the
study area.

C. Discharge Information

Discharge information is required at each cross section in order to compute the
water surface profile.

Discharge data are entered from upstream to downstream for each reach.

At least one flow value must be entered for each reach in the river system.

Once a flow value is entered at the upstream end of a reach, it is assumed that the
flow remains constant until another flow value is encountered with the same reach.

The flow rate can be changed at any cross section within a reach.

The flow rate can not be changed in the middle of a bridge, culvert, or stream
junction.

Flow data must be entered for the total number of profiles that are requested to be
computed.
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HEC-RAS Workshop 1

Introduction to HEC-RAS

Objective: Show how to create a working directory, create a new project, create a
single plan, input geometry, hydraulic and flow information, and
examine output.

1. Creating a Working Subdirectory and Creating a New Project

After entering HEC-RAS, click on File and select New Project. Double click on
c:\ in the directory window and then click on Create Directory. Type "workshpl"
for the name of the working directory. Type the title at the top as "Workshop #1".
Enter WORKSHP1.prj as the filename and click OK.

2. Entering New Geometric Data

At the top of the HEC-RAS menu, click on Edit and then Geometric Data (you can
also do this by clicking on the third icon from the left). The Geometric Data menu
will appear.

A. Create River Reach

Click River Reach and then move the cursor (which will now look like a cross hair)
to about 1/4 from the top and centered. Press the button and while holding it down,
move the cursor to about the bottom 1/4 of the page and centered. Release the
button. Enter the name of the reach as "Testy Creek".

You decide that you do not like this position and want it from the upper left to the
lower right. Click Edit, then Move Object and then move the cursor to the upper
part of the reach. Press the button and hold it down as you move the cursor laterally
to the left and then release. Move the cursor to the lower end of the reach and while
holding the button down, move it to the right and release. Move the cursor to the
reach name (Testy Creek) and move it to a "nice" pQsition. An example is shown
in the following after the cross sections are entered.

1



2.1

TESTY CREEK
1.68

1.0

B. Enter Geometric Data

1) We are going to enter three cross sections. The first is located at River Mile
(R.M.) 1.0, the next is at R.M. 1.68, and the last, which is a copy of R.M. 1.68 and
slightly modified, is at R.M. 2.1.

2) Click Cross Section on the left, click on Options and then on Add a New Cross
Section. For River Station, enter 1.0 (River Mile). For Description, enter "R.M.
1.0 at Testy Creek; This is a test to see additional info. about the cross section." Do
not press enter but Home. Click the button with the 3 dots, which is located just to
the right of the description window. Click OK if the entry is correct but if not,
move the cursor to make the corrections and then click OK. Enter the following
data in the proper fields.
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• x y

0 18 LOB Channel ROB
50 14
120 12 Downstream Reach Lengths: 0 0 0
132 13
135 15 Manning "n" values: 0.08 0.04 0.06
140 6
144 4
150 7
155 15
170 20

Once all the data is entered, click Apply Data to tell the program to put it in
memory for displays but not to save it yet.

•
3) Click Plot at the top of the window and click Plot Cross Section. From the plot,
decide where the channel banks should be. Double click the upper left button to
return and enter the left and right bank stations. Plot again to check the results. The
results should look as follows:
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4) We now want to add R.M. 1.68. From the "Cross Section Data - Basic
Geometry" screen, click on Options and then on Add a New Cross Section. Enter
1.68 (R.M. 1.68) for the new river station. Note that when the previous screen is
returned, the River sta. should have 1.68. Now enter a description such as "R.M.
1.68 at Testy Creek". Input the following data for R.M. 1.68.

•
x y

2 22 LOB Channel ROB
60 11

130 10 Downstream Reach Lengths: 3200 3590 4200
140 15
143 7 Manning "n" values: 0.085 0.035 0.055
146 6
151 10
155 18
151 10
160 12 •178 21

When finished, click Apply Data, click Plot at the top of the screen, then Plot
Cross Section. Ignore any warnings for now.

From the plot and the warning, it is obvious that point 9 (151,10) is a repeat of point
7 and that point 9 must be removed. Move the cursor to the station of point 8, hold
the button down and move the cursor to the elevation and release. Click Edit, then
Delete, then Shift aU columns up one row, and then click OK.

Plot again and determine where you want the bank stations, enter them, and double
check by pl0!ting the cross section.

5) We now want to add R.M. 2.1, which is a copy of R.M. 1.68 but is raised by
1.5 feet, the left overbank area is 10% larger, the channel is the same, and the right
overbank is 5 % smaller.

4
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• From the "Cross Section Data - Basic Geometry" screen, click on Options, and
then Copy Current Cross Section. Enter 2.1 for the river sta. and update the
description. Enter the following for R.M. 2.1.

LOB Channel ROB

Downstream Reach Lengths: 2100

Manning "n" values: 0.07

2218

0.04

2300

0.05

•

•

Click Options, then Adjust Elevations, enter 1.5, and click OK. Note that all the
elevations in the window have been adjusted to reflect this change.

Next click Options, then Adjust Stations, and then Multiply by a Factor. Enter
1.1 (10% increase) for the LOB, 1.0 (or leave blank) for the Channel, and 0.95
(5 % decrease) for ROB. When finished, click OK or press enter. Note that the
geometry stations have been adjusted as well as the bank stations.

Plot as before to check the new geometry. Check the relative changes in cross
section shape and other features by scrolling through the plots by clicking the up and
down arrows to the right of the River Sta. heading in the plot screen.

6) Now save the geometry by clicking Exit or by double clicking the upper left of
the screen, then click File at the top of the screen, then Save Geometry. Enter
"Existing Conditions, Basic Geometry" for the Title.

Note that if you had edited an existing file, modified it, and wanted to save it under
a different name, you would have selected Save Geometry Data As instead.

To see the cross section locations and R.M., click View, then Display River
Stations. Repeat this to turn it off.

Check the invert of the reach by clicking the Cross Section button, then Plot, then
Plot Profile. Ignore any warning since we have not done the flow data yet.
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3. Entering Flow Data

We want to run 3 subcritical flow conditions utilizing the following data:

FLOW CONDITIONS FOR EXISTING CONDITIONS

•
Profile

1
2
3

Flow Event. yr

1
5
10

Discharge. cfs

100
500

1000

Starting Elev.. ft
at R.M. 1.0

7
14
18

Click the upper left of the screens until you get to the main HEC-RAS menu. Click
on Edit and then Steady Flow Data or click on the fourth icon from the left. Enter
3 for the "Number of Profiles to be Calculated". Enter the 3 discharges for Profiles •
1, 2, and 3 from the previous table.

Click Boundary Conditions, click the field just below the heading "Down Stream",
and then click Known W.S. Enter the elevations from the previous table. When
finished, click File, then Save Flow Data. Enter the following for the Title - "1,
5, 10 yr. Qs; Existing Conditions" .

4. Simulation

A Creating a Plan

Exit the Steady Flow Data screen to get to the HEC-RAS main menu and click
Simulate, then Steady Flow Analysis or click the fifth icon from the left (running
stick man). Click File and then New Plan.

For the Title, enter "Plan 1, Existing Cond.; 1, 5, and 10 year Qs." and then click
OK. For "Short ID", enter "Plan 1". For the flow regime, click Subcritical. Note
the Geometric and Steady Flow Files are used for Phm 1. •
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• Click Options to see what is available.

What is the default method for Friction Slope?

B. Executing and Viewing of the Output

Click Compute at the bottom. A window showing computations will be displayed.
Close this window by double clicking the upper left of the immediate screen.

Examine the graphic and tabular output by clicking View at the top of the HEC-RAS
main screen. If you want to go straight to the cross section, profile, rating curve or
perspective plots, click the appropriate icon at the top of the main menu. Navigate
your way through the output to answer the following questions.

Find the energy slope at R.M. 2.1 for Profile 2.

• Find the top width at R.M. 1.68 for Profile 1.

Find the flow area at R.M. 1.0 for Profile 3.

Find the following velocities at R.M. 2.1 for Profile 2.

Total LOB Channel LOB

•

For R.M. 2.1, Profile 2, what is the warning?

What would you do to correct this?
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HEC-RAS Workshop #1
Solutions

What is the default method for Friction Slope? Average Conveyance

Find the energy slope at R.M. 2.1 for Profile 2. _~0~.0~0~0.:.:..:32!:::<.ol,,-- _

Find the top width at R.M. 1.68 for Profile 1. _----'='8"""'-8"'-'.4'-"'6-"f..>:....t _

Find the flow area at R.M. 1.0 for Profile 3. 199.5 sq. ft.

Find the following velocities at R.M. 2.1 for Profile 2.

•

For R.M. 2.1, Profile 2, what is the warning?

Total 1.07 fps LOB 1.03 fps Channel 1.49 fps LOB 0.77 fps

•
Ans. Divided flow and energy loss is greater than 1.0 feet.

What would you do to correct this?

Ans. Divided flow is OK since it just means that water is divided by a high
ground level, which is correct given the geometric conditions. For the
energy loss, add cross sections by inserting real ones or have the program
interpolate.

1
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HEC-RAS, River Analysis SysteDl

Working With Projects

Presented by
David T. Williams, Ph.D., P.E.

WEST Consultants, Inc., Carlsbad, CA

Note: This lecture is derived from a portion of Chapter 5 of the HEC-RAS
User's Manual

I. Introduction

• To create a river hydraulics application with HEC-RAS, one works with projects.
A project is a collection of files that are used to build models. This lecture
describes projects and how one builds and manages them.

II. Understanding Projects

Management of all the files that get created is accomplished through the user
interface.

When a new project is started, the user is requested to enter a title and filename for
the project.

All other data are automatically stored by the user interface using the same name as
the project file, except for the three character extension.

•



A project consists of:

• One Project file (.PRJ)

• One file for each Plan (. PO1 to .P99)

• One Run file for each plan (.R01 to .R99)

• One Output file for each plan (. 001 to .099)

• One file for each set of Geometry data (. GO1 to .G99)

• One file for each set of Steady Flow data (. FO1 to .F99)

The Project File contains:

•

1. Title of the project

2. List of all the files that are associated with the project

3. List of default variables that can be set from the interface •
4. A reference to the last plan that the user was working with

(updated every time you save the project)

III. Elements of a Project

The following sections describe the various types of files that can be included in a
project. All of these files are either created by the user interface or the various
computation engines. The modeler interacts with the data through the user interface,
and is not required to create any of these files.

A. Plan Files

Plan files have the extension .P01 to .P99. The "P" indicates a Plan file, while the
number represents the plan number. As plans are created, they are numbered from •
01 to 99.
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•

•

The plan file contains: a description and short identifier for the plan; a list of files
that are associated with the plan (e. g., geometry file and steady flow file); and a
description of all the simulation options that were set for the plan.

The plan file is created automatically by the interface each time the user selects New
Plan or Save Plan As from the simulation windows.

B. Run Files

Run files have the extension .R01 to .R99. The "R" indicates a Run file, while the
number represents an association to a particular plan file.

A file with an extension of .R01 is the run file that corresponds to the plan file with
the extension .PO1.

The run file contains all of the necessary data to perform the computations that are
requested by the associated plan file.

The run file contains the input to any of the computational engines available in the
HEC-RAS system.

The run file is automatically generated by the interface whenever the user presses
the Compute button on the Simulation windows.

The run file is in an ASCII format, but it is not self explanatory.

C. Output Files

Output files have the extension .001 to .099.

The "0" ind~cates an Output file, while the number represents an association to a
particular plan file.

A file with the extension .012 is the output file that corresponds to the plan file with
an extension .P12.

• The output file contains all of the computed results from the requested computational
engme.
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The output files are in a binary file format and can only be read from the user
interface.

D. Geometry Files

Geometry files have the extension .GO1 to .G99.

The "G" indicates a Geometry file, while the number corresponds to the order in
which they were saved for that particular project.

Geometry files contain all of the geometric data for the river system being analyzed.

The geometry data are stored in an ASCII format.

The file contains key words to describe each piece of data, and is, for the most part,
self explanatory.

A geometry file is created by the user interface whenever the modeler selects New
Geometry Data or Save Geometry Data As from the Geometric Data window.

E. Steady Flow Data Files

Steady flow data files have the extension .FO1 to .F99.

The "F" represents that it is a steady Flow data file, while the number corresponds
to the order in which they were saved for that particular project.

The steady flow data files are stored in an ASCII format.

The file contains key words to describe each piece of data, and is for-the-most-part
self explanatory.

Steady flow data files are automatically created by the user interface when the
modeler selects New Flow Data or Save Flow Data As from the Steady Flow Data
window.
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•
IV. Creating, Opening, Saving, Renaming,

and Deleting Projects

The following commands from the File menu of the HEC-RAS main window allow
you to create, open, save, rename, and delete projects.

•

File menu command

New Project

Open Project

Save Project

Save Project As

Rename Project

Delete Project

Description

Closes the current project, prompts to save the data
if anything has been changed. The user is then
prompted to enter a title and filename for the new
project.

Closes the current project, prompts to save the data
if anything has been changed. Opens an existing
project and all of the associated files.

Updates the project file and all other files in which
data have been modified.

Updates the project file and all other associated
data, saving all the information and prompts for a
filename.

Allows the user to rename the title of the currently
opened project.

Deletes the project file and all other files associated
with the selected project. The user is prompted
again before the project is deleted.

•
These commands are similar for all of the other data types that are created by the
user interface (Plan data, geometry data, steady flow data, unsteady flow data,
sediment data, and hydraulic design data).
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v. Project Options

The following four Project options are available from the Options menu of the main •
window:

Options menu command

Program Setup

- BW to Printer

- BW to Clipboard

- Default Margins

Description

Sends all graphics to the printer\plotter in Black and
White. When turned off, all graphics are sent as
color drawings. Color drawings that are sent to a
black and white printer will come out in grey scale
shadings.

Sends all graphics to the Windows Clipboard in a
Black and White mode. When turned off, the
graphics are sent to the Clipboard as color
drawings.

Allows the user to change the default margins for
printing graphics and tables. The default settings
are 1 inch margins on all four sides.

•
- Default File Viewer Allows the user to change which program is used

for viewing the logfile output. The default is the
Windows Write program.

- Open last project Opens the last project worked on, during startup.

Default Parameters Allows the user to set defaults for some of the
hydraulic variables.

Unit System' Allows the user to set the default units system to
either English or Metric. Once the units system is
set, the program assumes that all input data (and
output) are entered in that system.

Convert Project Units Allows the user to convert an existing project from
Metric to English units or vice versa.
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• HEC-RAS, River Analysis System

Viewing HEC-RAS Output

Presented by
David T. Williams, Ph.D., P.E.

WEST Consultants, Inc., Carlsbad, CA

Note: This lecture is derived from Chapter 8 of the HEC-RAS User's Manual.

•

•

I. General

Output is available in a graphical and tabular format.

The current version of the program allows the user to view cross sections, profiles,
rating curves, X-Y-Z perspective plots, detailed tabular output at a single cross
section, and limited tabular output at many cross sections.

Users also have the ability to develop their own output tables.

II. Cross Sections, Profiles, and Rating Curves

A. General

Graphical displays are often the most effective method of presenting input data and
computed results.

Graphics allow the user to easily spot errors in the input data, as well as providing
an overview of the results in a way that tables of numbers cannot.

1



B. Viewing Graphics on the Screen •To view a graphic on the screen, select either:

Cross Sections, Profiles, or, Rating Curves

from the View menu on the HEC-RAS main window.

Once you have selected one of these options, a window will appear with the graphic
plotted in the viewing area.

An example cross section plot is shown in Figure 1.

Upstream Inside - Easy creek bridge
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Figure 1. Example Cross Section Plot •
2



• The user can plot any cross section by simply selecting the appropriate reach and
river station from the list boxes at the top of the plot.

The user can also step through the cross section plots by using the up and down
arrow buttons next to the river station box.

An example profile plot is shown in Figure 2.

File Options Help
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Figure 2. Example Profile Plot

The profile plot displays the water surface profile for the first reach in the river
system.

•
If there is more than one reach, additional reaches can be selected from the Options
menu on the plot.
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An example rating curve plot is shown in Figure 3.

The rating curve is a plot of the water surface elevation versus flow rate for the
profiles that were computed.

A rating curve can be plotted at any location by selecting the appropriate reach and
river station from the list boxes at the top of the plot.
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Figure 3. Example Rating Curve Plot
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• C. Graphical Plot Options

General

Several plotting features are available from the Options menu on all of the graphical
plots.

These options include: zoom in; zoom out; selecting which plans, profiles, reaches
and variables to plot; and control over labels, lines, symbols, scaling, and grid
options.

In general, the options are about the same on all of the graphics.

Zoom In

allows the user to zoom in on a portion of the graphic

•

•

Zoom Out

define the zoom area by placing the mouse pointer at a corner of the
desired zoom area

press down on the left mouse button and drag the mouse to define a box
containing the desired zoom area

release the left mouse button and the viewing area will display the
zoomed-in area of the graphic

re-displays the graphic back into its original size before you zoomed in

allows the user to select from the available Plans for plotting

default plan is the currently opened plan

can select additional plans to view for comparison of results graphically

5



Profiles

allows the user to select which profiles they would like to have
displayed on the graphic

does not apply to the rating curve

automatically plots all of the profiles (can be changed by user)

Reaches

allows the user to select which river reaches they would like to have
displayed

applies only to the profile plot

Variables

allows the user to select what ever variables are available for plotting

number and type of variables depends on what type of graphic is being
displayed

Labels

allows the user to change the labels on the plot

includes the plot caption, the X axis title, and the Y axis title

Legend

allows the user to change the labels of the legend

Lines and Symbols

•

•

allows the user to change the line types, line colors, line widths,
symbol types, symbol colors, symbol sizes, fill patterns, and the line
labels •
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•

•

Scaling

allows the user to define the scaling used for the plot

can set the minimum, maximum, and labeling increment for the X and
Yaxis

scaling can be set temporarily, or scaling can be set to be persistent
(scaling stays constant for all cross sections)

persistent scaling is only available for the cross section and rating curve
plots

allows the user to overlay a grid on top of the graphic

can have both major and minor tics displayed

D. Plotting Velocity Distribution Output

General

The user has the option of plotting velocity distribution output from the cross section
VIewer.

Velocity distributions can only be plotted at locations in which the user specified that
flow distribution output be calculated during the computations.

Plotting the Velocity Distribution

To view the velocity distribution plot, first bring up a cross section plot (select
"Cross Sections" from the view menu of the main HEC-RAS window).

Select the cross section in which you would like to see the velocity distribution
output.

7



Select Velocity Distribution from the Options menu of the cross section window,
which will bring up a pop-up window that will allow you to set the minimum
velocity, maximum; velocity, and velocity increment for plotting.

In general, it is better to let the program use the maximum velocity range for
plotting.

Next, the user selects Plot Velocity Distribution. Then press the "OK" button and
the velocity distribution plot will appear as shown in Figure 4.
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Figure 4. Velocity Distribution Plot

Activating the Velocity Distribution Computation Option

For details on how to select the locations for computing the velocity distribution, see
Chapter 7 of the User's Manual.

For information on how the velocity distribution is actually calculated, see Chapter
4 of the Hydraulic Reference Manual. •
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• D. Plotting Ot er Variables in Profile

General

The profile plotting window has the ability to plot other variables, besides water
surface and energy, in profile.

Any variable that is computed at a cross section can be displayed in profile.

An example would be to plot velocity versus distance.

Plotting Variables in Profile

•

•

To plot other variables in profile, first select the General Profile option from the
Options menu of the Profile plot.

The plot automatically switches to a plot of channel velocity versus distance .

Other variables can be selected from the Variables option under the Options menu.

The user can plot several different variable types at one time ( e.g. velocity and
area versus distance), but the scaling may not be appropriate when this is done.

An example of plotting other variables in profile is shown in Figure 5.
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Figure 5. General Profile Plot of Variables Versus Distance

Main Channel Distance (tt) 2345.29,14.03

•
E. Plotting One Variable Versus Another

General

The rating curve plotting window has the ability to plot other variables besides
discharge versus water surface elevation.

Any variable that is computed at a cross section can be displayed against other
computed variable (or variables).

An example of this capability is shown in Figure 6.

10
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Discharge vs Flow Area Total and Channel
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Figure 6. Example of Plotting One Variable Against Other Variables

In this example, Discharge (x-axis) is being plotted against total flow area and main
channel flow area (y-axis).

Selecting Different Variables to Plot

To plot other variables, the user selects the X Axis Variable and Y Axis Variable
from the Options menu of the rating curve plotting window.

When selecting variables to plot, keep in mind that all variables selected for a
particular axis should have a similar range in magnitude.
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F. Sending Graphics to the Printer or Plotter

General

All of the graphical plots in HEC-RAS can be sent directly to a printer or plotter.

The printer or plotter used depends on what you currently have set as the default
printer or plotter in the Windows Print Manager.

Sending Graphics to the Output Device

To send a graphic to the printer or plotter, do the following:

•

1. Display the graphic of interest (cross section, profile, rating curve, or
river system schematic) onto the screen.

2. Using the available graphics options (scaling, labels, grid, etc ... ),
modify the plot to be exactly what you would like printed. •

3. Select Print Current (or just Print on the from the profile plot) from
the File menu of the displayed graphic. A pop-up window will appear
allowing you to modify the default print options.

Change any desired options and press the Print button.

The graphic will be sent to the Windows Print Manager which will send
the plot to the default printer or plotter.

Multiple Plots on a Single Page

The user can print multiple cross sections at one time by using the Print Multiple
option from the File Menu of the cross section and rating curve plots.

This option also allows the user to establish how many cross sections or rating
curves they would like to have printed on each page. •

12



• G. Sending Graphics to the Windows Clipboard

General

All of the HEC-RAS graphics can be sent to the Windows Clipboard.

Passing a graphic to the clipboard allows that graphic to then be pasted into another
piece of software (i.e., a word processor).

Sending· Graphics to Clipboard

To pass a graphic to the windows clipboard, and then to another program, do the
following:

1. Display the graphic of interest on the screen

• 2. Using the options, modify the plot to be exactly what you want

•

3. Select Copy to Clipboard from the File menu of the displayed graphic

4. Bring up the program that you want to pass the graphic into

Select Paste from the Edit menu of the receiving program and adjust
as necessary

HEC-RAS sends and displays all graphics in a Window's Meta file format. Since
Meta files are vector based graphics, the graphic can be resized without causing the
image to distort.

13



III. X-Y-Z Perspective Plots

A. General

Another type of graphic available to the user is the X-Y-Z Perspective Plot.

The X-Y-Z plot is a pseudo 3-dimensional plot of multiple cross sections within a
reach.

An example X-Y-Z Perspective plot is shown in Figure 7.

Figure 7. Example X-Y-Z Perspective Plot

14
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• Plotting Options

The user has the ability to select the reach to be plotted, the range of the river
stations, and which plans and profiles to be displayed.

1) can rotate left and right, as well as up and down, in order to get
different perspectives of the river system

2) can choose to overlay the water surface or not and can be displayed in
an outline format, a shaded but transparent format, or a solid filled
format

3) can send the graphic to the printer or clipboard is accomplished by
pressing the printer or clipboard button, located on the lower left hand
side of the plot

4) can also be aligned in several different ways, including:

a. left edge of the cross section (default)• b. left bank station of the main channel

c. channel invert

d. right main channel bank station

E. right edge of the cross section data.

This is accomplished by using the data alignment buttons above the printer
and clipboard buttons.

•
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IV. Tabular Output

A. General

Tabular output allows the user to display large amounts of detailed information in
a concise format. HEC-RAS has two basic types of tabular output: cross section
tables and profile tables.

B. Cross Section Tables

Cross section tables show detailed hydraulic information at a single location, for a
single profile.

Select Cross Section Table from the View menu of the main HEC-RAS window and
a cross section table similar to Figure 8 will be displayed.

Figure 8. Example Cross Section Table
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Any cross section can be displayed in the table by selecting the appropriate reach
and river station from the list boxes at the top of the table.

Any of the computed profiles can be displayed by selecting the desired profile from
the profile list box.

Other table types are selected from the Type menu on the cross section table
window.
The following types are available in addition to the normal cross section table (which
is the default):

Culvert

The culvert table type brings up detailed culvert information. This table can be
selected for normal culverts, or for culverts that are part of a multiple opening river
crossing. An example culvert specific table is shown in Figure 9.

50
5.2

f------
5.23
0.05
0.39
0.17

86.23-------_._----
962.52

1047.57
0.01

-----·0.67

Figure 9. Example Culvert Type of Cross Section Table
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Bridge

The bridge table type brings up detailed output for the cross sections inside the
bridge as well as just upstream of the bridge.

The bridge table type can selected for normal bridge crossings, or for bridges that
are part of a multiple opening river crossing.

An example of the bridge specific cross section table is shown in Figure 10.

525.401----...525Ji6r.------
517.491

15.061 15.03.........................-.-:i:T .
4.66, 4.68

····················································t· .
1715.441 1710.78

0.24 0.24
11908.15 11856.62

11.75 11.72

Figure 10. Example Bridge Type of Cross Section Table

Conveyance

The conveyance type of table is similar to a cross section table.

•

•

A conveyance type of table is used for viewing the hydraulic results of a portion of
a multiple opening river crossing if the user has defined an open channel flow type
of opening (i.e. conveyance area) at a multiple opening crossing. •
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• Flow Distribution

The Flow Distribution table type can be used to view the computed flow distribution
output at any cross section.

An example of the flow distribution table output is shown in Figure 11.

1.67 121.17 186.34 1351.4 0.65!
7.57 320.05 218.23 6138.6 1.47!

16.74 514.70 217.84 13567.6 2.36:
12.95 441.26 217.861 10496.2 2.03:

0.80 11.34 5.801 658.9 2.22'
3.19 26.88 6.30 2627.2 5.27'..__.._._- M_M.___••_

5.631• 7.64 43.45 6303.6 8.52,
8.87 45.69 5.1 01 7316.4 8.96'
8.72 45.24 5.11 7195.0 8.87!

Figure 11. Example of the Flow Distribution Type of Table

At the bottom of each of the cross section tables are two text boxes for displaying
messages.

The bottom text box is used to display the definition of the variables listed in the
table.

When the user presses the left mouse button over any data field, the description for
• that field is displayed in the bottom text box.
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The other text box is used to display any Errors, Warnings, and Notes that may
have occurred during the computations for the displayed cross section.

C. Cross Section Table Options

Under the Options menu of the cross section table window, the user has the
following options:

Include Interpolated XS's

This option allows the user to either view interpolated cross section output or not.

Turning the "include interpolated XS's" option on (which is the default), allows
interpolated sections to be selected from the river station box.

Turning this option off gets rid of all the interpolated sections from the river station
selection box, and only the user entered cross sections are displayed.

Units System For Viewing

This option allows the user to view the output in either English or Metric units.

It does not matter whether the input data is in English or metric, the output can be
viewed in either system.

D. Profile Tables

Profile tables are used to show a limited number of hydraulic variables for several
cross sections.

To display a profile table on the screen, select Profile Table from the View menu
of the main HEC-RAS window.

An example profile table is shown in Figure 12.

20
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Figure 12. Example Profile Table

The standard table types available to the user are:

Standard Table 1

This is the default profile type of table.

The table gives you a summary of some of the key output variables.

Standard Table 2

This table provides information on the distribution of flow between the left
overbank, main channel, and right overbank.

The table also shows the friction losses, as well as contraction and expansion losses
that occurred between each section.

Energy losses displayed at a particular cross section are for the losses that occurred
between that section and the next section downstream.

21



Four XS Culvert

This standard table provides summary results for the four cross sections around each
of the culverts in the model.

The four cross sections are the two immediately downstream and upstream of the
culvert.

The table will list all of the culverts in the model for the selected reaches.

Culvert Only

This standard table provides hydraulic information about the culvert, as well as the
inlet control and outlet control computations that were performed.

Six XS Bridge

This table provides summary results for the six cross sections that make up a normal
bridge transition.

The six cross sections include the two cross sections just downstream of the bridge;
the two cross sections inside of the bridge; and the two cross sections just upstream
of the bridge.

The program will display results for all the bridges in the model within the selected
reaches.

When viewing this table, on occasion there will be no displayed results for the cross
sections inside 0 the bridge.

This occurs only when the user has selected a bridge modeling approach that does
not compute results inside of the bridge. This includes: Yarnells method; the
contracted opening method (not in version 1.0); both pressure flow equations; and
pressure and weir flow solutions.

Bridge Only

The bridge only table shows summary information specifically for bridges.
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Bridge Comparison

The bridge comparison table shows the results for all of the user selected bridge
modeling approaches that were computed during the computations.

For example, the program can calculate low flow bridge hydraulics by four different
methods.

The resulting upstream energy for the user selected methods will be displayed in this
table.

Multiple Opening

This table shows a limited number of output variables for each opening of a multiple
.. .

operung flver crossmg.

Encroachment 1. 2. and 3

These three standard tables provide various types of output for the computations of
floodway encroachments.

To view one of the types of tables, select the desired table type from the Std. Tables
menu'on the profile table.

The user can specify which plans, profiles and reaches to include in the table
through the Options menu on the profile plot.

Interpolated Cross Sections

The user has "the ability to view interpolated cross sections.

The default is to view all cross sections, including the interpolated ones.

To prevent the interpolated sections from showing up in the table, de-select Include
• Interpolated XS' s from the Options menu.
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Setting the Decimal Place

Another feature available to users is the ability to set the number of decimal places
that will be displayed for any variable of the pre-defined tables.

Once a pre-defined table is selected from the Tables menu, select Standard Table
# Dec Places from the Options menu.

A window will appear displaying the current number of decimal places for each
variable.

Selection of System Units for Output

User's also have the ability to view profile output tables in either English or metric
units.

•

This is available from the Options menu on the profile tables.

It does not matter whether the input data is in English or metric, the output can be •
viewed in either system.

E. User Defined Output Tables

General

A special feature of the profile tables is the ability for users to define their own
output tables.

User defined output tables are available by selecting Derme Table from the Options
menu of the profile table.

When this option is selected, a window will appear, as shown in Figure 13.

•
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Figure 13. User Defined Tables Window

•

At the top of the window is a table for the user selected variable headings (Table
Column Headings), the units, and the number of decimal places to be displayed for
each variable.

Below this table is a table containing all of the available variables that can be
included in your user defined table.

The variables are listed in alphabetical order.

Below the list of variables is a message box that is used to display the definition of
the selected variable.

25



Adding/Deleting Variables to/from the Table

To add variables to the column headings, simply double click the left mouse button
while the mouse pointer is over the desired variable.

The variable will be placed in the active field of the table column headings.

To select a specific column to place a variable in, click the left mouse button once
while the mouse pointer is over the desired table column field.

To delete a variable from the table headings, double click the left mouse button
while the mouse pointer is over the variable that you want to delete.

The number of decimal places for each variable can be changed by simply typing in
a new value.

User defined tables are limited to 15 variables.

•

O~ce you have selected all of the variables that you want, press the OK button at the
bottom of the window. The profile table will automatically be updated to display the •
new table.

Saving the User Defined Table

Once you have the table displayed in the profile table window, you can save the
table headings for future use.

To save a table heading, select Save Table from the Options menu on the profile
table window and a pop-up window will appear, prompting you to enter a name for
the table.

Enter the name and press the OK button at the bottom of the pop-up window.

The table name will be added to a list of tables included under the User Tables
menu on the profile table window.

•
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Deleting a User Specified Table

To delete a table from the list of user defined tables, select Remove Table from the
Options menu of the profile table window.

When this option is selected, a pop-up window will appear displaying a list of all the
user defined tables.

Click the left mouse button over the tables that you want to delete, then press the
OK button.

The selected tables will then be deleted from the User Tables menu list.

F. Sending Tables to the Printer

Sending the Entire Table to the Printer

To send a table to the printer:

1. Bring up the desired table from the tabular output (cross section or
profile tables) section of the program.

2. Select Print from the File menu of the displayed table. A pop-up
window will appear allowing you to modify the default print options.

Once you have set the printer with the desired options, press the Print button to send
the table to the Windows Print Manager. The Windows Print Manager will control
the printing of the table.

Sending a Portion of the Table to the Printer

The profile type of tables allow you to print a specific portion of the table, rather
than the entire table.

27



If you desire to only print a portion of the table, do the following:

1. Display the desired profile type table on the screen.

2. Using the mouse, press down on the left mouse button and highlight the
area of the table that you would like to print.

To get an entire row or column, press down on the left mouse button
while moving the pointer across the desired row or column headings.

3. Select Printer from the File menu of the displayed table. Only the
highlighted portion of the table and the row and column headings will
be sent to the Windows Print Manager.

G. Sending Tables to the Windows Clipboard

To pass a table to the Windows Clipboard, and then to another program, do the
following:

1. Display the desired table on the screen.

2. Select Copy to Clipboard from the File menu of the displayed table.

3. Bring up the program that you want to pass the table into.

Select Paste from the Edit menu of the receiving program.

Portions of the profile tables can be sent to the Clipboard in the same manner as
sending them to the printer.
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• V. Viewing Results From the
River System Schematic

General

The user has the option of either bringing up graphics and tables from the View
menu on the main HEC-RAS window (as discussed above), or from the river system
schematic (found under geometric data) after a successful simulation has been made.

When the left mouse button is pressed over the river system schematic, a pop-up
menu will appear listing options that are relevant to the area of the schematic that
is located under the mouse pointer.

An example of this is shown in Figure 14.

Butte Cr.

Edit Cross Section
Plot Cross Section

utter Plot Profile
Tabular Output ~

Rating Curve

Fall Cr.

Figure 14. Geometric Data Window With Pop-up Menu

•

•
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In Figure 14, the pop-up menu shown comes up whenever the user presses the left
mouse button over a cross section.

In this particular example, the mouse button was pressed over the cross section
located at river station 0.1 of the Butte Cr.. river reach.

The user has the choices outlined in the box in Figure 14.

Other pop-up menus are available for bridges; culverts; junctions; and reach data.
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HEC-RAS Workshop 2

Creating Networks and Plans

Objective: Show how to create Plans with different geometric and hydrologic
conditions and comparison with the existing conditions.

1. Copying a Project and Putting it into another Directory

A. Opening the Project

From the HEC-RAS main screen, click File. At the bottom, you should see the
following: C:\workshp1\workshpl.prj. This is because HEC-RAS lists the last
projects that were used (from Workshop 1). Double click on this project.

If for some reason you did not finish Workshop 1, click on File from the HEC-RAS
main screen and then Open File. Utilizing the Directories window, go to the
Workshp1 directory off of the root c: and open the solution for Workshop 1, which
is wrkshp1s.prj, and skip the instructions in the next paragraph.

If your project is not exhibited but you did finish and it was saved, click Open File,
go to the C: \workshp1 directory and double click on workshp1.prj, which should be
your workshop #1 results.

B. Creating Your Project File

Click on File and then on Save Project As. Double click on c:\ in the directory
window on the right and then on Create Directory.

Type in "workshp2" and press enter. Make sure that the directory is from the root
of the c drive (c:\) instead of as a subdirectory of workshpl.

For the Title, type in "WORKSHOP 2: CREATING NETWORKS AND PLANS",
press enter and type in workshp2.prj for the filename.

1



2. Creating a Project Conditions Network Geometry

A. Creating the River Network

We want to have Takeo Creek enter Testy Creek at Testy Creek R.M. 2.1. Takeo
Creek will have two cross sections located at R.M. 0.001 and R.M. 0.5.

We also want to add the Upper Testy to the Testy Creek immediately upstream of
the confluence of Testy Creek with Takeo Creek. The Upper Testy's downstream
cross section is at R.M. 2.101, which is a copy of R.M. 2.1 of Testy Creek. It is
20% smaller and at the same elevation. R.M. 2.5, which is a copy of R.M. 2.101,
is 5 feet higher than R.M. 2.101. The stream network will look similar to the
following:

TAKEO CREEK

JUNCTION 1

TESTY CREEK
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From the main HEC-RAS screen, click on the third icon from the left. This will
give you the screen similar to the above from Workshop 1. Press Edit and select
Move object. Move the cross hairs to upper end of TESTY Creek, press the left
mouse button, move it to the center of the screen, and release the button. In a
similar manner, move the label TESTY CREEK to a "nicer" location and release
the button.

To add Takeo Creek, click on River Reach, move the cross hairs to the location of
the upstream portion of Takeo Creek as shown above, press the button and move the
cursor to cross section 2.1 of TESTY Creek, and release the button. You will be
prompt to enter the reach name. Type"TAKEO CREEK" and enter.

You will then be prompted to enter the junction name. Type "JUNCTION 1" and
enter.

To enter Upper Testy Creek, click River Reach again, move the cross hairs to the
upper left of the screen (similar to the upstream end of UPPER TESTY on the
previous page), press the button, move the cross hairs to cross section 2.1 of TESTY
Creek, and release. When prompt for the reach name, enter "UPPER TESTY".
As described earlier, move the text or reach position as necessary.

B. Junction Data

We now need to give additional information at the junction. Click Junct. and the
"Junction Data - Basic Geometry" screen will appear. Junction 1 should appear as
the junction name. For the description, enter "Confluence of Upper Testy and
Takeo Creeks with Testy Creek main stem" .

Note on the right the option to change the junction computations to either energy or
momentum. We want to use the momentum method since Takeo Creek comes into
the main stem at a significant angle (see schematic on the previous page). Click on
the small cir~le to the left of Momentum and, for the tributary angles, enter 45
(degrees) for Takeo Creek to Testy Creek and 0 (degrees) for Upper Testy to Testy
Creek.

Note that the options under Momentum include add friction and add weight. Add
friction is the default. Leave this as it is. In the Length across Junction window,
enter 100 feet for each reach. Click on Apply Data and then OK.
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C. Add Geometry for Upper Testy

We want to copy R.M. 2.1 on Testy Creek to create R.M. 2.101 on the Upper
Testy. Click the Cross Section button and then in the "Reach" window near the
top, select Testy Creek and for the "River Sta.", select R.M. 2.1. Click Options
and then Copy Current Cross Section. In the next screen, in the "Reach" window,
select "Upper Testy", and type in 2.101 (R.M. 2.101) in the "River Sta." window.
Enter or click OK. Note that the you will be returned to the "Cross Section Data"
screen with the Upper Testy and R.M. 2.101 appearing.

Change the "Description" to "R.M. 2.101 at Upper Testy Creek". Change the
"Downstream Reach Lengths" to zero (0) for call subsections. Click Options, then
Adjust Stations, then Adjust Stations, then Multiply by a Factor. Enter 0.8 (20%
smaller) for each subsection and enter or click OK. Click Apply Data.

•

We now want to add R.M. 2.5. Copy R.M. 2.101, and raise it 5 feet, and change
the downstream reach lengths for all subsections to 2,100 feet in a similar manner
to the above. Remember to change the description and click Apply Data. Use the •
Plot option to check the cross sections and profiles.

Add Geometry for Takeo Creek

From the "Cross Section Data" screen, change the "Reach" at the upper left of the
screen to Takeo Creek. Click Options and Add a New Cross Section. Enter 0.001
for the river station. Enter a description for R.M. 0.001. Enter the following data:

x y

10 17 LOB Channel ROB
18 14
24 7.5 Downstream Reach Lengths: 0 0 0
28 8
32 15 Manning "n" values: 0.05 0.03 0.06
50 19

The left and right channel stations are 18 and 32, respectively. Click Apply Data
and plot to check the data. •
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• Copy R.M. 0.001 to create R.M. 0.05, which is 1.5 feet higher and 2,640 feet (all
subsections) upstream of R.M. 0.001. Use the same "n" values. Use the Plot
option to check the cross sections and profiles. Return to the "Geometric Data"
screen, click File, and then Save Geometry Data.

3. Entering Steady Flow Data

A. Discharges

Return to the HEC-RAS main screen and click the fourth icon from the left to get
to the Steady Flow Data screen. Note that the discharges shown are only for Testy
Creek and we need to add the discharges for Upper Testy at R.M. 2.5 and Takeo
Creek at R.M. 0.5.

Click the "Reach" window and select Upper Testy, and then click Add A Flow
Change Location. Repeat for Takeo Creek. Note that HEC-RAS assumes that you
want to apply the discharges at the upstream end of each reach.

• If you have a flow change somewhere downstream of the upstream-most cross
section of the reach, change the "River Sta." to that location and then click on Add
A Flow Change Location.

Enter the following flow data with the starting water surface elevations for Testy
Creek in parenthesis:

FLOW CONDITIONS FOR EXISTING CONDITIONS

Discharges, cfs

Profile Flow Event. yr Testy Creek Upper Testy TakeoCreek

1 1 100 (7 ft.) 70 30
2 5 500 (14 ft.) 400 100
3 10 1000 (18 ft.) 850 150

•
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B. Boundary Data

Click Boundary Condition and look at the information. Since we are going to
assume subcritical flow for all reaches, we only have to specify the downstream
starting water surface elevation for Testy Creek.

How will the starting water surface elevations at R.M. 9.001 of Takeo Creek and
R.M. 2.101 of Upper Testy Creek be determined?

The starting water surface elevations for Testy Creek were entered in Workshop 1
and also apply to this Workshop. To see what has been entered, click the "Known
WS" window under "Down Stream" and to the right of reach Testy Creek and then
click on Known W.S. at the upper left of the window. Click File and then Save
Flow Data.

C. Computations

Return to the main HEC-RAS screen and click on the fifth icon from the left (the
running stick man), look at the inputs, click Options, the Critical Depth
Computation Method and then on Multiple Critical Depth Search. Save the
Steady Flow Analysis file and then click Compute.

Exit the computation screen.

D. Examination of Output

We want to look at the profile plot of Testy Creek and Upper Testy Creek on the
same plot. ~eturn to the main HEC-RAS screen and click the profile icon. Click
Options and then Reaches. Click Clear Ail and double click on Testy Creek and
Upper Testy Creek under "Avail Reaches". Check to see if the inverts of each
reach look reasonable and there are no unjustified changes. Do the same for Testy
Creek and Takeo Creek.

6
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• We now want to see the profile table for all the reaches. Return to the main HEC­
RAS screen and click View, then Profile Table. Note that only information from
Testy Creek is shown. To add the other reaches, click Options and then Reaches.
Double click on all the available reaches and then OK.

View the output and answer the following:

What R.M., reaches and profiles does the flow go critical?

For Upper Testy and Takeo Creeks, would you be concerned about the critical depth
results? Why or why not?

• Fill out the following table:

R.M. Profile WSEL Top Width

•

Upper Testy Creek

Takeo Creek

Testy Creek

2.101

2.5

0.001

0.5

1.68

2.1

2.1

1

2

2

3

2

2

3
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4. Setting Up Geometry and Hydrology for Project Conditions

A. General Information

We are to analyze a plan to levee the left side of Testy Creek up to R.M. 2.1. We
are then asked to analyze the system with a detention basin upstream of Upper Testy
Creek which reduces the peak discharges. The required analyses are:

1. Existing Conditions

2. Project geometry with existing conditions hydrology

3. Existing conditions geometry with project hydrology

3. Project geometry with project hydrology

•

B. Project Conditions Geometry

From the Geometry Data screen, move the cursor to R.M. 1.0 of Testy Creek at the •
bottom right of the screen and click the button (you may need to try this several
times by moving the cursor). When you get a window with "River Station = 1.0",
click on Edit Cross Section.

Click Options and then Levees. For the left levee elevation, enter 15.0 feet and for
the station, enter 100 feet, and then click OK. Notice the note at the bottom of the
resulting screen. Click Apply Data and then plot the cross section to check if the
levee was placed properly.

Click the up arrow at the top of the screen to bring up R. M. 1.68. Place a left levee
at station 100 feet and elevation 15.5 feet in the same manner. In a likewise
manner, for ~.M. 2.1, place a levee at station 120 feet and elevation 18.5. Plot to
check the input.

Return to the Geometry Data screen and click File and Save Geometry As. For the
title, type "Levee on Testy Creek".

•
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• C. Project Conditions Hydrology

From the HEC-RAS main screen, click the fourth icon from the left. Change the
discharges to the following in the same manner as for the existing conditions.

FLOW CONDITIONS FOR PROJECT CONDITIONS

Discharges, cfs

Profile Flow Event. yr Testy Creek Upper Testy Takeo Creek

1 1 40 (5 ft.) 10 30
2 5 350 (12 ft.) 250 100
3 10 650 (16 ft.) 500 150

•

•

Do not forget to change the starting water surface elevations for Testy Creek.

Click File, then Save Flow Data AS, then, for the title, type "1, 5, and 10 year Qs
for Proposed Cond."

Creating Project Plans

A. Plan 1, Existing Conditions

Plan 1 has already been set up as existing conditions geometry and hydrology. We
now want to set up the different plans.

B. Plan 2, Project Geometry and Existing Conditions Hydrology

From the main HEC-RAS screen, click the icon of the running stick man, then File,
then New Plan. For the title, enter "Plan 2, Project Geometry and Existing
Hydro", press enter, and then type "Plan 2" for the short ID.

For the geometry file, select the proposed conditions, "Levee on Testy Creek", and
fo~ the Steady Flow File, select the existing conditions file.

9



Click File and then Save Plan.

In the same manner, create Plan 3 (existing geometry with proposed hydrology) and
Plan 4 (proposed geometry with proposed hydrology).

Execute each Plan by clicking on the run icon from the HEC-RAS main screen,
then the File, then Open File, double clicking the appropriate Plan, then clicking
Compute.

View the cross section plots by clicking on the cross section icon from the HEC­
RAS main screen, then Options, then Plans, and make your selection of Plans to
look at.

Note that when you plot the cross sections, it will show the cross section geometry
of the last Plan that you executed.

The limits of the water surface elevations are for that last Plan but the plots of the
water surface elevations are at the correct elevation but the lateral limits may not be
accurate.

From the HEC-RAS main screen, click on the last icon, which is for the Profile
Table. Click Options, then Plans, and then Select All. Click OK and then click
Options again, then Profiles, and the Select All. In the same manner, you can
select which reaches to be displayed.

From the output, answer the following questions.

1. For the 1 year flood at R.M. 1.68 on Testy Creek, what is the difference in the
water surface elevations between existing conditions (Plan 1) and project
geometry with proposed hydrology (Plan 2)? Hint: to go faster in answering
these questions, use the Plans, Profiles, and Reach options of the Profile Table
option (l~st icon on the main HEC-RAS screen)

Between Plan 1 and Plan 3?

Between Plan 2 and Plan 3?

10
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•

•

•

Between Plan 3 and Plan 4?

Between Plan 1 and Plan 4?

2. For the 10 year flood at R.M. 2.1 on Testy Creek~ why is the water surface
elevation for Plan 2 higher than Plan 1 even though both use the entire cross
section for flow and have the same discharge?

3. Would you expect what happened for question 2 to happen if we had used the
normal ineffective flow area option and set the station and elevation of
overtopping at the same point as the levee? Why?

4. What is the backwater effect (in feet) of the proposed project at R.M. 0.5 on
Takeo Creek for the 5 year flood ?

5. For the 5 year flood on Testy Creek with the levee in place, is the lateral extent
of the water surface at R.M. 1.0 consistent with R.M. 1.68? Why or why not?

11



HEC-RAS Workshop 2

Creating Networks and Plans

SOLUTIONS

How will the starting water surface elevations at R.M. 0.001 of Takeo Creek and
R.M. 2.101 of Upper Testy Creek determined?

What R.M., reaches and profiles is the flow go critical?

For Upper Testy and Takeo Creeks, would you be concerned about the critical depth
results? Why or why not?

Fill out the following table:

•

•

Upper Testy Creek

Takeo Creek

R.M.

2.101

2.5

0.001

0.5

Profile

1

2

2

3

1

WSEL Top Width

•



• Testy Creek

R.M.

1.68

2.1

2.1

Profile

2

2

3

WSEL Top Width

•

•

From the output, answer the following questions.

1. For the 1 year flood at R.M. 1.68 on Testy Creek, what is the difference in the
water surface elevations between existing conditions (Plan 1) and project
geometry with proposed hydrology (Plan 2)? Hint: to go faster in answering
these questions, use the Plans, ProfIles, and Reach options of the Profile Table
option (last icon on the main HEC-RAS screen)

Between Plan 1 and Plan 3?

Between Plan 2 and Plan 3?

Between Plan 3 and Plan 4?

Between Plan 1 and Plan 4?

2. For the io year flood at R.M. 2.1 on Testy Creek, why is the water surface
elevation for Plan 2 higher than Plan 1 even though both use the entire cross
section for flow and have the same discharge?

2



3. Would you expect what happened for question 2 to happen if we had used the
normal ineffective flow area option and set the station and elevation of
overtopping at the same point as the levee? Why?

4. What is the backwater effect (in feet) of the proposed project at R.M. 0.5 on
Takeo Creek for the 5 year flood?

5. For the 5 year flood on Testy Creek with the levee in place, is the lateral extent
of the water surface at R.M. 1.0 consistent with R.M. 1.68? Why or why not?

3
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• HEC-RAS, River Analysis System

Theoretical Basis of HEC-RAS

Presented by
David T. Williams, Ph.D., P.E.

WEST Consultants, Inc., Carlsbad, CA

Note: This lecture is derived from Chapter 2 of the HEC-RAS Hydraulic Reference
Manual

•

•

Objectives:

This lecture describes the methodologies used in performing the one-dimensional
flow calculations within HEC-RAS. The basic equations are presented along with
discussions of the various terms. Discussions are provided as to how the equations
should be applied, as 'vvell as applicable limitations.

I. General

This lecture IS limited to discussions about steady flow water surface profile
calculations.

II. Steady Flow Water Surface Profiles

HEC-RAS is currently capable of performing one-dimensional water surface profile
calculations for steady gradually varied flow in natural or constructed channels.

Subcritical, supercritical, and mixed flow regime water surface profiles can be
calculated.

1



A. Equations for Basic Profile Calculations

Water surface profiles are computed from one cross section to the next by solving the
Energy equation with an iterative procedure called the standard step method.

The Energy equation is written as follows:

•

Where: WS/, WS2 water surface elevations at cross sections

Vb V2 average velocities (total discharge/ total flow area)

Ct l , Ct2 velocity weighting coefficients

g = gravitational acceleration

energy head loss

(1)

•
The energy head loss (he) between two cross sections is comprised of friction losses
and contraction or expansion losses.

The equation for the energy head loss is as follows:

Ct
2

V
2

2

h = LS + C 1--
e f 2g

(2)

Sf - representative friction slope between two sections

Where: L

c

discharge weighted reach length

expansion or contraction loss coefficient

2
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• A diagram showing the terms of the energy equation is shown in Figure 1.

(X2V \
2g

-- -- - - --- - - - ---~l!eIgy_q~Q~..Line I he
-----------1

I

Water surface I~
2g

A

•

Channel bottom

DATUM

Figure 1. Representation of Terms in the Energy Equation

The distance weighted reach length, L, is calculated as:

Where:

L =
L Q +L Q +L Q

lob lob ch ch rob rob

Q lob + Q ch + Q rob

(3)

•
Q/ob 1 Qch 1 Qrob

cross section reach lengths for flow in left overbank,
main channel, and right overbank, respectively

arithmetic average of the flows between sections for
the left overbank, main channel, and right overbank,
respectively
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B. Cross Section Subdivision for Conveyance Calculations •

HEC-RAS Subdivision

The determination of total conveyance and the velocity coefficient for a cross section
requires that flow be subdivided into units for which· the velocity is uniformly
distributed.

The approach used in HEC-RAS is to subdivide flow in the overbank areas using the
input cross section n-value break points (locations where n-values change) as the
basis for subdivision (Figure 2).

n n n
ch n

31 2

A P I A P A P
2 2 ch ch 3 3

K =K +~ K =K •lob I rob 3

Kch

Figure 2. HEC-RAS Default Conveyance Subdivision

Conveyance is calculated within each subdivision by the following equation (based
on English units):

K = 1.486 A R 2/3

n
(4)

where: K

n

= conveyance for subdivision

= Manning's roughness coefficient for subdivision •
4



• A = flow area for subdivision

•

R = hydraulic radius for subdivision (area / wetted perimeter)

The program sums up all the incremental conveyances in the overbanks to obtain a
conveyance for the left overbank and the right overbank.

The main channel conveyance is normally computed as a single conveyance element.

The total conveyance for the cross section is obtained by summing the three
subdivision conveyances (left, channel, and right).

HEC-2 Style Subdivision

An alternative method available in HEC-RAS is to calculate conveyance between
every coordinate point in the overbanks (Figure 3). The conveyance is then summed
to get the total left overbank and right overbank values.

n n nch n
31 2

I I
I I I

P
3

IA P A P lAs Ps
IA

6 P6 : A 7 P7I 4 4 ch ch I

K =K+K+K+K K =K+K+K+Klob 1 2 3 4 rob 5 6 7 8

K
ch

Figure 3. Alternative Conveyance Subdivision Method (HEC-2 style)

This method is used in the Corps' HEC-2 program. The method has been retained as
an option within HEC-RAS in order to reproduce studies that were originally

• developed with HEC-2.
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The two methods for computing conveyance will produce different answers whenever
portions of the overbanks have ground sections with significant vertical slopes.

Possible Discrepancies Between the Two Methods

In general, the HEC-RAS default approach will provide a lower total conveyance for
the same water surface elevation.

Results from comparisons do not show which method is more accurate, they only
show differences.

In general, it is felt that the HEC-RAS default method is more commensurate with the
Manning equation and the concept of separate flow elements.

c. Composite Manning's n for the Main Channel

•

Conditions for Subdivision of Channel

Flow in the main channel is not subdivided, except when the roughness coefficient •
is changed within the channel area.

HEC-RAS tests the applicability ofsubdivision ofroughness within the main channel
portion of a cross section, and if it is not applicable, the program will compute a
single composite n value for the entire main channel.

Criterion and Method for Compositing the Channel

The program determines if the main channel portion of the cross section can be
subdivided or if a composite main channel n value will be utilized based on the
following criterion:

If a main channel side slope is steeper than 5H: 1V and the main channel has more
than one n-value, a composite roughness ne will be computed [Equation 6-17, Chow,
1959].

The channel side slope used by HEC-RAS is defined as the horizontal distance
between adjacent n-value stations within the main channel over the difference in •

6



• elevation of these two stations (see SL and SR of Figure 4).
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• Figure 4. Definition of Bank Slope for Composite nc Calculation

For the determination of ne, the main channel is divided into N parts, each with a
known wetted perimeter Pi and roughness coefficient ni .

n =c p

(5)

where:. composite or equivalent coefficient of roughness

P = wetted perimeter of entire main channel

Pi = wetted perimeter of subdivision I

• n·I coefficient of roughness for subdivision I
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The computed composite nc should be checked for reasonableness. The computed
value is the composite main channel n value in the output and summary tables.

D. Velocity Coefficient, Alpha

The velocity coefficient, Ct., is computed based on the conveyance in the three flow
elements: left overbank, right overbank, and channel. It is obtained with the
following equation:

•

(A)2
(K/ob )3 (K )3 (Krob )3

+ ch +
(A /Ob)2 (A )2 (A rob )2

Ct.
ch=

(K
t
)3

(6)

where:
total flow area of cross section

flow areas of left overbank, main channel and right
overbank, respectively

total conveyance of cross section

•
= conveyances of left overbank, main channel and

right overbank, respectively

E. Friction Loss Evaluation

Friction loss is evaluated in HEC-RAS as the product ofSf and L (Equation 2), where
Sf is the representative friction slope for a reach and L is defined by Equation 3.

The friction slope (slope of the energy gradeline) at each cross section is computed
from Manning's equation as follows:

(7)

8
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• Alternative expressions for the representative reach friction slope (Sf) in HEC-RAS
are as follows:

Average Conveyance Equation

(8)

Average Friction Slope Equation

(9)

• Geometric Mean Friction Slope Equation

(10)

Harmonic Mean Friction Slope Equation

(11)

Equation 8 is the 'default' equation used by the program.

The program also contains an option to select equations, depending on flow regime
• and profile type (e.g., SI, Ml, etc.).
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F. Contraction and Expansion Loss Evaluation •Contraction and expansion losses in HEC-RAS are evaluated by the following
equation:

v 2

h = Cl ex -'
o , 2g

v 2

ex _2_1
2 2g

(12)

Where: C = The contraction or expansion coefficient.

G. Computation Procedure

Iterative Method for Balancing Energies

The unknown water surface elevation at a cross section is detennined by an iterative
solution of Equations 1 and 2. The computational procedure is as follows:

1. Assume a water surface elevation at the upstream cross section (or
downstream cross section if a supercritical profile is being calculated). •

2. Based on the assumed water surface elevation, detennine the
corresponding total conveyance and velocity head.

3. With values from step 2, compute Sf and solve Equation 2 for he.

4. With values from steps 2 and 3, solve Equation 1 for WS2•

5. Compare the computed value ofWS2 with the value assumed in step 1;
repeat steps 1 through 5 until the values agree to within .01 feet (.003
m), or the user-defined tolerance.

WSEL Selection Process if Convergence is not Achieved

The program is constrained by a maximum number ofiterations (the default is 20) for
balancing the water surface.

10
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•

Program remembers the mInImUm amount of error between the assumed and
computed values. This water surface is called the minimum error water surface.

Program will calculate calculate critical depth (if this has not already been done) if
water surface is not balanced after 20 iterations.

The program the error associated with the minimum error water surface to see if it
is within a predefined tolerance (the default is 0.3 ft or 0.1 m).

If the minimum error water surface has an associated error less than the predefined
tolerance, and this water surface is on the correct side of critical depth, then the
program will use this water surface as the final answer and set a warning message.

If the minimum error water surface has an associated error that is greater than the
predefined tolerance, or it is on the wrong side of critical depth, the program will use
critical depth as the final answer for the cross section and set a warning message.

Cautions on Selected WSEL

The rationale for using the minimum error water surface is that it is probably a better
answer than critical depth, as long as the above criteria are met. Neither of these two
answers are considered to be valid solutions.

In general, when the program can not balance the energy equation at a cross section,
it is usually caused by an inadequate number of cross sections (cross sections spaced
too far apart) or bad cross section data.

Occasionally, this can occur because the program is attempting to calculate a
subcritical water surface when the flow regime is actually supercritical.

Checks on WSEL Related to Flow Regime

When a "balanced" water surface elevation has been obtained for a cross section,
checks are made to ascertain that the elevation is on the "right" side of the critical
water surface elevation (e.g., above the critical elevation if a subcritical profile has
been requested by the user).

11



If the balanced elevation is on the "wrong" side of the critical water surface elevation,
critical depth is assumed for the cross section and a "warning" message to that effect
is displayed by the program.

The program user should be aware of critical depth assumptions and determine the
reasons for their occurrence, because in many cases they result from reach lengths
being too long or from misrepresentation of the effective flow areas of cross sections.

Froude Number Checks

For a subcritical profile, a preliminary check for proper flow regime involves
checking the Froude number. The program calculates the Froude number of the
"balanced" water surface for both the main channel only and the entire cross section.

•

If either Froude numbers are greater than 0.94, then the program checks the flow
regime by calculating a more accurate estimate of critical depth using the minimum
specific energy method.

A Froude number of 0.94 is used instead of 1.0, because the calculation of Froude •
number in irregular channels is not accurate. Therefore, using a value of 0.94 is
conservative, in that the program will calculate critical depth more often than it may
need to.

For a supercritical profile, critical depth is automatically calculated for every cross
section, which enables a direct comparison between balanced and critical elevations.

H. Critical Depth Determination

Critical depth for a cross section will be determined if any of the following conditions
are satisfied:

(1) The supercritical flow regime has been specified.

(2) The calculation of critical depth has been requested by the user.

•
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• (3) This is an external boundary cross section and critical depth must be
determined to ensure the user entered boundary condition is in the
correct flow regime.

(4) The Froude number check for a subcritical profile indicates that critical
depth needs to be determined to verify the flow regime associated with
the balanced elevation.

(5) The program could not balance the energy equation within the specified
tolerance before reaching the maximum number of iterations.

The total energy head for a cross section is defined by:

H WS +
aV 2

(13)=
2g

• where: H total energy head

WS water surface elevation

aVl
velocity head=

2g

The critical water surface elevation is the elevation for which the total energy head
is a minimum (i.e. minimum specific energy for that cross section for the given flow).

The critical elevation is determined with an iterative procedure whereby values ofWS
are assumed and corresponding values ofH are determined with Equation 13 until a
minimum value for H is reached.

•
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•Water
Surface
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Total Energy H

Figure 5. Energy vs. Water Surface Elevation Diagram

The HEC-RAS program has two methods for calculating critical depth: a "parabolic" •
method and a "secant" method.

Parabolic Method

1) General

The parabolic method is computationally faster, but it is only able to locate a single
minimum energy. For most cross sections there will only be one minimum on the
total energy curve, therefore the parabolic method has been set as the default method
(the default method can be changed from the user interface).

If the parabolic method is tried and it does not converge, then the program will
automatically try the secant method.

2) Causes of Multiple Minimum Energies

In certain situations it is possible to have more than one minimum on the total energy
curve. Multiple minimums are often associated with cross sections that have breaks
in the total energy curve. •

14



•

•

•

These breaks can occur do to very wide and flat overbanks, as well as cross sections
with levees and ineffective flow areas.

3) Procedure of Parabolic Method

When the parabolic method is used on a cross section that has multiple minimums on
the total energy curve, the method will converge on the first minimum that it locates.
This approach can lead to incorrect estimates of critical depth. If the user thinks that
the program has incorrectly located critical depth, then the secant method should be
selected and the model should be re-simulated.

The "parabolic" method involves determining values ofH for three values ofWS that
are spaced at equal LlWS intervals. The WS corresponding to the minimum value for
H, defined by a parabola passing through the three points on the H versus WS plane,
is used as the basis for the next assumption of a value for WS.

It is presumed that critical depth has been obtained when there is less than a 0.01 ft.
(0.003 m) change in water depth from one iteration to the next and provided the
energy head has not either decreased or increased by more than .01 feet (0.003 m).

Secant Method

1) WSEL Intervals and Locations

The "secant" method first creates a table ofwater surface versus energy by slicing the
cross section into 30 intervals.

If the maximum height of the cross section (highest point to lowest point) is less than
1.5 times the maximum height of the main channel (from the highest main channels
bank station to the invert), then the program slices the entire cross section into 30
equal intervals.

If this is not" the case, the program uses 25 equal intervals from the invert to the
highest main channel bank station, and then 5 equal intervals from the main channel
to the top of the cross section.

15



2) Determination of Local Minimums •The program then searches this table for the location of local minimums. When a
point in the table is encountered such that the energy for the water surface
immediately above and immediately below are greater than the energy for the given
water surface, then the general location of a local minimum has been found.

The program will then search for the local minimum by using the secant slope
projection method. The program will iterate for the local minimum either thirty times
or until the critical depth has been bounded by the critical error tolerance. After the
local minimum has been determined more precisely, the program will continue
searching the table to see if there are any other local minimums.

3) Selection of Proper Minimum Energy WSEL

The program can locate up to three local minimums in the energy curve. If more than
one local minimum is found, the program sets critical depth equal to the one with the
mInImUm energy.

If this local minimum is due to a break in the energy curve caused by overtopping a •
levee or and ineffective flow area, then the program will select the next lowest
minimum on the energy curve.

If all of the local minimums are occurring at breaks in the energy curve (caused by
levees and ineffective flow areas), then the program will set critical depth to the one
with the lowest energy.

Ifno local minimums are found, then the program will use the water surface elevation
with the least energy.

Ifthe critical depth that is found is at the top of the cross section, then this is probably
not a real critical depth. Therefore, the program will double the height of the cross
section and try again.

Doubling the height of the cross section is accomplished by extending vertical walls
at the first and last points of the section. The height of the cross section can be
doubled five times before the program will quit searching.

•
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• I. Applications of the Momentum Equation

•

•

Conditions for Applications of the Momentum Equation

Whenever the water surface passes through critical depth, the energy equation is not
considered to be applicable. The energy equation is only applicable to gradually
varied flow situations, and the transition from subcritical to supercritical or
supercritical to subcritical is a rapidly varying flow situation.

There are several instances when the transition from subcritical to supercritical and
supercritical to subcritical flow can occur. These include significant changes in
channel slope, bridge constrictions, drop structures and weirs, and stream junctions.

In some of these instances empirical equations can be used (such as at drop structures
and weirs), while at others it is necessary to apply the momentum equation in order
to obtain an answer.

When HEC-RAS uses the Momentum Equation

Within HEC-RAS, the momentum equation can be applied for the following specific
problems: the occurrence of a hydraulic jump; low flow hydraulics at bridges; and
stream junctions.

The application of the momentum equation to hydraulic jumps and stream junctions
is discussed in detail in Chapter 4 of the Hydraulic Reference Manual and detailed
discussions on applying the momentum equation to bridges is discussed in Chapter
5.

J. Program Limitations

Assumptions

The following assumptions are implicit in the analytical expressions used in the
current version of the program:

(1) Flow is steady,

17



(2) Flow is gradually varied (except at hydraulic structures such as: bridges;
culverts; and weirs. At these locations, where the flow can be rapidly
varied, the momentum equation is used),

(3) Flow is one dimensional (i.e., velocity components in directions other
than the direction of flow are not accounted for),

(4) River channels have"small" slopes, say less than 1: 1O.

Bases of Assumptions

Flow is assumed to be steady because time-dependent terms are not included in the
energy equation (Equation 1). Flow is assumed to be gradually varied because
Equation 1 is based on the premise that a hydrostatic pressure distribution exists at
each cross section.

•

At locations where the flow is rapidly varied, the program switches to the momentum
equation or other empirical equations. Flow is assumed to be one-dimensional •
because Equation 4 is based on the premise that the total energy head is the same for
all points in a cross section.

Small channel slopes are assumed because the pressure head, which is a component
of WS in Equation 1, is represented by the water depth measured vertically.

The program does not currently have the capability to deal with movable boundaries
(i.e., sediment transport) and requires that energy losses be definable with the terms
contained in Equation 2.

•
18



•

•

•



• HEC-RAS, River Analysis System

Modeling Bridges

Presented by
David T. Williams, Ph.D., P.E.

WEST Consultants, Inc., Carlsbad, CA

Note: This lecture is derived from Chapter 5 of the HEC-RAS Hydraulics
Reference Manual

• I. Introduction

A. Energy Losses at Bridges and Culverts

HEC-RAS computes energy losses caused by structures such as bridges and culverts
in three parts.

One part consists of losses that occur in the reach immediately downstream from the
structure, where an expansion of flow generally takes place.

The second part is the losses at the structure itself, which can be modeled with
several different methods.

The third part consists of losses that occur in the reach immediately upstream of the
structure, where the flow is generally contracting to get through the opening.

•
1



B. Contents of Lecture

This lecture discusses how bridges are modeled using HEC-RAS.

Contents

• General Modeling Guidelines

• Hydraulic Computations Through the Bridge

• Selecting a Bridge Modeling Approach

• Unique Bridge Problems and Suggested Approaches

II. General Modeling Guidelines

Considerations for modeling the geometry of a reach of river in the vicinity of a
bridge are essentially the same for any of the available bridge modeling approaches
within HEC-RAS.

A. Cross Section Locations

1. General

The bridge routines utilize four user-defined cross sections in the computations of
energy losses due to the structure.

During the hydraulic computations, the program automatically formulates two
additional cross sections inside of the bridge structure.

A plan view of the basic cross section layout is shown in Figure 1.
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Figure 1. Cross Section Locations at a Bridge

2. Cross Section 1

Cross Section 1 is located sufficiently downstream from the structure so that the flow
is not affected by the structure (i.e. the flow has fully expanded).

This distance should generally be determined by field investigation during high
flows.

•
If field investigation is not possible, then there are two sets of criteria for locating
the downstream section.
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1. The USGS suggests locating cross section 1 a distance downstream
from the bridge equal to one times the bridge opening width (the
distance between points Band C on Figure 1). •

2. Traditionally, the Corps of Engineers criterion has been to locate the
downstream cross section about four times the average length of the
side constriction caused by the structure abutments (the average of the
distance from A to Band C to D on Figure 1).

The expansion distance will vary depending upon the degree of constriction, the
shape of the constriction and the magnitude and velocity of the flow.

Both criteria should be used as rough guidance for placing cross section 1.

If the expansion reach requires a long distance, then intermediate cross sections
should be placed within the expansion reach in order to adequately model friction
losses.

The ineffective flow option can be used to limit the effective flow area of the •
intermediate cross sections in the expansion reach.

3. Cross Section 2

Cross Section 2 is located immediately downstream from the bridge (i.e. within a
few feet).

This cross section should represent the effective flow area just outside the bridge.

4. Cross section 3

Cross Section 3 should be located just upstream from the bridge.

The distance between cross section 3 and the bridge should be relatively short (l to
5 feet). This distance should reflect the length required for the abrupt acceleration
and contraction of the flow that occurs in the immediate area of the opening. •
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• Cross section 3 represents the effective flow area just upstream of the bridge.

Both cross sections 2 and 3 will have ineffective flow areas to either side of the
bridge opening during low flow and pressure flow profiles and should use the
ineffective flow option in HEC-RAS.

5. Cross Section 4

Cross Section 4 is an upstream cross section where the flow lines are approximately
parallel and the cross section is fully effective.

Because flow contractions can occur over a shorter distance than flow expansions,
the distance between cross section 3 and 4 should be rougWy one times the average
width of the opening.

•

•

This criteria for locating the upstream cross section may result in too short a reach
length for situations where the width of the bridge opening is very small in
comparison to the floodplain.

An alternative criterion would be to locate the cross section a distance upstream
equal to the average contraction width (the average of the distance from A to Band
C to D on Figure 1).

6. Relation of Cross Sections and Computations

During the hydraulic computations, the program automatically formulates two
additional cross sections inside of the bridge structure.

The geometry inside of the bridge is a combination of the bounding cross sections
(sections 2 and 3) and the bridge geometry.

The bridge geometry consists of the bridge deck and roadway, sloping abutments if
necessary, and any piers that may exist.

The user can specify different bridge geometry for the upstream and downstream
sides of the structure if necessary .

5



Cross section 2 and the structure information on the downstream side of the bridge •
are used as the geometry just inside the structure at the downstream end.

Cross section 3 and the upstream structure information are used as the bridge
geometry just inside the structure at the upstream end.

B. Defining Ineffective Flow Areas

1. General

A basic problem in setting up the bridge routines is the definition of ineffective flow
areas near the bridge structure.

Referring to Figure 1, the dashed lines represent the effective flow boundary for low
flow and pressure flow conditions. Therefore, for cross sections 2 and 3, ineffective
flow areas to either side of the bridge opening (along distance AB and CD) should
not be included as part of the active flow area for low flow or pressure flow.

The bridge example shown in Figure 2 is a typical situation where the bridge spans
the entire floodway and its abutments obstruct the natural floodway and is the same
situation as was shown in plan view in Figure 1.

The cross section numbers and locations are the same as those discussed in the
"Cross Section Locations" section of this lecture.

2. Adjusting Natural Geometry for Bridge Hydraulics

By redefining the cross section, a fixed boundary is used at the sides of the cross
section to contain the flow, when in fact a solid boundary is not physically there.

The use of the ineffective area option does not add wetted perimeter to the flow
boundary above the given ground profile.

The ineffective area option is used at sections 2 and 3 to keep all the flow in the area
of the bridge opening until the elevations associated with the left and/or right
ineffective flow areas are· exceeded by the computed water surface elevation.

6
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A. Channel Profile and cross section locations

B. Bridge cross section on natural ground

I
I

I

I

V
C. Portion of cross section 2 & 3 that is effective for low and pressure flow

Figure 2. Cross Sections Near Bridges

The program allows the stations and controlling elevations of the left and right
ineffective flow areas to be specified by the user.

The stations of the ineffective flow areas do not have to coincide with stations of the
ground profile, the program will interpolate the ground station.

The default stations and elevations are set to the main channel bank stations when

• the option is turned on.
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3. Setting Ineffective Flow Elevations for Cross Section 2

The elevations specified for ineffective flow should correspond to elevations where
significant flow passes over the bridge or roadway (overtopping flow).

The threshold water surface elevation for significant flow is not usually known on
the initial run, so an estimate must be made.

Some people use an average between the low chord and minimum top-of-road
elevation as a first estimate.

An elevation near the minimum top-of-road elevation can be used as a first estimate
but the average described above is generally recommended.

The assumption is that under overtopping flow conditions, the water can generally
flow across the whole bridge length and the entire overbank in the vicinity of the
bridge would be effectively carrying flow up to and over the bridge.

•

If it is more reasonable to assume only part of the overbank is effective for carrying
flow when the bridge is under weir flow, then the overbank n values (if not assigned •
for weir flow) can be increased to reduce the amount of conveyance in the overbank
areas under weir flow conditions.

4. Setting Ineffective Flow Elevations for Cross Section 3

Cross section 3, just upstream from the bridge, is usually defined in the same
manner as cross section 2.

The elevation for ineffective flow usually would be the low point of the top-of-road
or bridge deck, whichever is lowest.

5. Checking the Solution

Using the ineffective area option in the manner just described for the two cross
sections on either side of the bridge provides for a constricted section when all of the
flow is going under the bridge. When the water surface is higher than the control
elevations used, the entire cross section is used. •

8
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The program user should check the computed solutions on either side of the bridge
section to ensure they are consistent with the type of flow.

For low flow or pressure flow solutions (non-overtopping flow), the output should
show the effective area restricted to the main channel.

When the bridge output indicates weir flow, the solution should show that the entire
cross section is effective.

During overflow situations, the modeler should ensure that the overbank flow
around the bridge is consistent with the weir flow.

C. Contraction and Expansion Losses

The computations and explanation of contraction and expansion losses are described
in the Theoretical Basis of HEC-RAS lecture.

As shown in Figure 1, the flow contraction occurs between cross sections 4 and 3,
while the flow expansion occurs between sections 2 and 1.

The loss due to expansion of flow is usually much larger than the contraction loss,
and losses from short abrupt transitions are larger than losses from gradual
transitions. Typical values for contraction and expansion coefficients are shown in
Table 1 below:

Table 1, Contraction and Expansion Coefficients

. No transition loss
Gradual transition
Typical Bridge Sections
Abrupt transitions

Contraction

0.0
0.1
0.3
0.6

Expansion

0.0
0.3
0.5
0.8

• The maximum value for the expansion coefficient would be one (1.0).
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III. Hydraulic Computations Through the Bridge

A. General

The bridge routines in HEC-RAS allow the modeler to analyze a bridge with several
different methods without changing the bridge geometry.

The bridge routines have the ability to model:

1. low flow (Class A, B, and C)

2~ low flow and weir flow (with adjustments for submergence on the weir)

3. pressure flow (orifice and sluice gate equations)

•

4. pressure and weir flow

5. highly submerged flows (the program will automatically switch to the
energy equation when the flow over the road is highly submerged) •

B. Low Flow Computations

1. General

Low flow exists when the flow going through the bridge opening is open channel
flow (water surface below the highest point on the low chord of the bridge opening).

2. Use of the Momentum Equation to Determine Controlling Section

For low flow computations, the program first uses the momentum equation to
identify the class of flow by first calculating the momentum at critical depth inside
the bridge at the upstream and downstream ends.

10
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•

The end with the higher momentum (therefore most constricted section) will be the
controlling section in the bridge and if the two sections are identical, the program
selects the upstream bridge section as the controlling section.

3. Use of the Momentum Equation to Determine Flow Class

The momentum at critical depth in the controlling secti'on is then compared to the
momentum of the flow downstream of the bridge when performing a subcritical
profile (upstream of the bridge for a supercritical profile).

If the momentum downstream is greater than the critical depth momentum inside the
bridge, the class of flow is considered to be completely subcritical (i.e. class A low
flow).

If the momentum downstream is less than the momentum at critical depth, in the
controlling bridge section, then it is assumed that the constriction will cause the flow
to pass through critical depth and a hydraulic jump will occur at some distance
downstream (i.e. class B low flow).

If the profile is completely supercritical through the bridge, then this is considered
class C low flow.

4. Class A low flow

Class A low flow exists when the water surface through the bridge is completely
subcritical (i. e. above critical depth).

Energy losses through the expansion (sections 2 to 1) are calculated as friction losses
and expansion losses.

Energy losse's through the contraction (sections 3 to 4) are calculated as friction
losses and contraction losses.

11



Computation of Loss Through the Bridge

There are four methods available for computing losses through the bridge (sections
2 to 3):

- Energy Equation (standard step method)

- Momentum Balance

- Yarnell Equation

- USGS Contracted Opening method (not available in version 1.0)

The user can select any or all of these methods in the computations.

If more than one method is selected, the user must choose either a single method as
the final solution or direct the program to use the method that computes the greatest
en~rgy loss through the bridge as the answer at section 3.

This allows the modeler to compare the answers from several techniques all in a
single execution of the program.

Minimal results are available for all the methods computed, but detailed results are
available for the method that is selected as the final answer. A detailed discussion
of each method follows:

Energy Equation (standard step method):

The energy based method treats a bridge in the same manner as a natural river cross
section, except:

1) area of the bridge below the water surface is subtracted from the total

2) wetted perimeter is increased where the water is in contact with the
bridge structure

12
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• Two cross sections are formulated inside the bridge by combining the geometry of
sections 2 and 3 with the bridge geometry.

As shown in Figure 3, for the purposes of discussion, these cross sections will be
referred to as sections BD (Bridge downstream) and BU (Bridge Upstream).

The sequence of calculations starts with a standard step calculation from just
downstream of the bridge (section 2) to just inside of the bridge (section BD) at the
downstream end, then a standard step through the bridge (from section BD to section
BU) and lastly from section BU to section 3.

•

3
~2

I

Figure 3. Cross Sections Near and Inside the Bridge

The energy based method requires Manning's n values for friction losses and
contraction and expansion coefficients for transition losses.

Detailed output is available for cross sections inside the bridge (sections BD and BU)
• as well as the user entered cross sections (sections 2 and 3).
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Momentum Balance Method:

The momentum method is based on performing a momentum balance from cross
section 2 to cross section 3. The momentum balance is performed in three steps.

The first step is to perform a momentum balance from cross section 2 to cross
section BD inside the bridge.

The second step is a momentum balance from section BD to BU (see Figure 3).

The final step is a momentum balance from section BU to section 3 (see Figure 3).

The equation of these relations are described in Chapter 5, pages 5-10 and 5-11 of
the HEC-RAS Hydraulic Reference Manual.

The momentum balance method requires the use of roughness coefficients for the
estimation of the friction force and a drag coefficient for the force of drag on piers.

•

Drag coefficients are used to estimate the force due to the water moving around the
piers, the separation of the flow, and the resulting wake that occurs downstream. •

The following table shows some typical drag coefficients that can be used for piers:

Table 2, Typical drag coefficients for various pier shapes

Pier Shape

Circular pier
Elongated piers with semi-circular ends
Elliptical piers with 2: 1 length to width
Elliptical piers with 4: 1 length to width
Elliptical piers with 8: 1 length to width
Square nose piers
Triangular nose with 30 degree angle
Triangular nose with 60 degree angle
Triangular nose with 90 degree angle
Triangular nose with 120 degree angle

14
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1.20
1.33
0.60
0.32
0.29
2.00
1.00
1.39
1.60
1.72 •



•

•

The momentum method provides detailed output for the cross sections inside the
bridge (BU and BD) as well as outside the bridge (2 and 3).

The user has the option of turning the friction and weight force components off; the
default is to include these two terms in the momentum balance.

When this option is turned off, no output is available inside the bridge at sections BU
and BD.

Yarnell Equation:

1) Description of Method

The Yarnell equation is an empirical equation that is used to predict the change in
water surface from just downstream of the bridge (section 2 of Figure 3) to just
upstream of the bridge (section 3).

The equation is based on approximately 2600 lab experiments in which the
researchers varied the shape of the piers, the width, the length, the angle, and the
flow rate.

The Yarnell equation is as follows (Yarnell, 1934):

v 2

H
3

-
2

= 2K (K + lOw - 0.6)(a + 15(4
) 2

2g
(1)

where:

K

The drop in water surface from section 3 to 2.

Yarnell's pier shape coefficient

Ratio of velocity head to depth at section 2

•
Obstructed area of the piers divided by the total
unobstructed area.

Velocity downstream at section 2
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The computed upstream water surface elevation is simply the downstream water •
surface elevation plus H3-2.

With the upstream water surface known, the program computes the corresponding
velocity head and energy elevation for the upstream section (section 3).

When the Yarnell method is used, hydraulic information is only provided at cross
sections 2 and 3 (no information is provided for sections BU and BD).

2) Sensitivity of Yarnell Equation

The Yarnell equation is sensitive to the pier shape (K coefficient), the pIer
obstructed area, and the velocity of the water.

The method is not sensitive to the shape of the bridge opening, the shape of the
abutments, or the width of the bridge. Because of these limitations, the Yarnell
method should only be used at bridges where the majority of the energy losses are
associated with the piers.

3) Yarnell Pier Shape Coefficient

When Yarnell's equation is used for computing the change in water surface through
the bridge, the user must supply the Yarnell pier shape coefficient, K. The following
table gives values for Yarnell's pier coefficient, K, for various pier shapes:

Table 3, Yarnell's pier coefficient, K, for various pier shapes

•

Pier Shape

Semi-circular nose and tail
Twin-cylinder piers with connecting diaphragm
Twin-cylinder piers without diaphragm
90 degree triangular nose and tail
Square nose and tail
Ten pile trestle bent
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0.90
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• 5. Class B low flow

General

Class B low flow can exist for either subcritical or supercritical profiles and occurs
when the profile passes through critical depth in the bridge constriction.

For a subcritical profile, the momentum equation or the energy equation can be
used to compute an upstream water surface (section 3 of Figure 5.3) above critical
depth and a downstream water surface (section 2) below critical depth.

For a supercritical profile, the bridge is acting as a control and is causing the
upstream water surface elevation to be above critical depth.

Momentum or energy can be used to calculate an upstream water surface above
critical depth and a downstream water surface below critical depth.

Mixed Regime Flow

• If the user is running a mixed flow regime profile, the program will proceed with
backwater calculations upstream, and later with forewater calculations downstream
from the bridge.

Whenever class B flow is found to exist, the user should run the program in a mixed
flow regime mode.

The mixed flow regime mode is capable of calculating a subcritical profile upstream
from the bridge and a supercritical profile downstream from the bridge. Also, any
hydraulic jumps can be located if they exist.

6. Class C low flow

Class C low flow exists when the water surface through the bridge is completely
supercritical.

The program can use either the energy equation or the momentum equation to
• compute the water surface through the bridge for this class of flow.

17



C. High Flow Computations

1. General

The HEC-RAS program has the ability to compute high flows (flows that come into
contact with the maximum low chord of the bridge deck) by either the Energy
equation (standard step method) or by using separate hydraulic equations for
pressure and/or weir flow.

Energy Equation (standard step method):

Computations are based on balancing the energy equation in three steps through the
bridge.

Energy losses are based on friction and contraction and expansion losses.

•

Output from this method is available at the cross sections inside the bridge as well •
as outside.

At the cross sections inside the bridge, the area obstructed by the bridge piers,
abutments, and deck is subtracted from the flow area and additional wetted perimeter
is added.

Occasionally the resulting water surfaces inside the bridge (at sections BU and BD)
can be computed at elevations that would be inside of the bridge deck.

The water surfaces inside of the bridge reflect the hydraulic grade line elevations,
not necessarily the actual water surface elevations.

Pressure and Weir Flow Method:

A second approach for the computation of high flows is to utilize separate hydraulic
equations to compute the flow as pressure and/or weir flow as described in the
following.

18
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• 2. Pressure Flow Computations

Flow Phenomenon

Pressure flow occurs when the flow comes into contact with the low chord of the
bridge.

Once the flow comes into contact with the upstream side of the bridge, a backwater
occurs and orifice flow is established.

The program will handle two cases of orifice flow; the first is when only the
upstream side of the bridge is in contact with the water; and the second is when the
bridge constriction is flowing completely full.

The HEC-RAS program will automatically select the appropriate equation,
depending upon the flow situation.

• Sluice Gate Flow

For the first case (see Figure 4), a sluice gate type of equation is used (FHWA,
1978):

(2)

where: Q Total discharge through the bridge opening

•

Cd Coefficient of discharge for pressure flow

ABU Net area of the bridge opening at section BU

Y3 Hydraulic depth at section 3

Z Vertical distance from maximum bridge low chord
to the mean river bed elevation at section BU
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w.s.

I

z

Figure 4. Example of a bridge under sluice gate type of pressure flow •
The discharge coefficient Cd' can vary depending upon the depth of water upstream.

Values for Cd range from 0.35 to 0.5, with a typical value of 0.5 commonly used in
practice.

The user can enter a fixed value for this coefficient or the program will compute one
based on the amount that the inlet is submerged.

A diagram relating Cd to Y3/Z is shown in Figure 5.

•
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• Coefficient of Discharge
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Figure 5. Coefficient of discharge for sluice gate type flow

Applicability of Sluice Equation

The limiting value of Y3/Z is 1.1 in Figure 5.

There is a transition zone between Y/Z = 1.0 and 1.1 where free surface flow
changes to orifice flow and flow in this range is unpredictable; therefore, equation
5 is not applicable.

Full Submerged Flow

When both the upstream and downstream side of the bridge are submerged (see
Figure 6), the standard full flowing orifice equation is used. This equation is as

• follows:
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Q = CAV2gH (3) •
where: c

H

Coefficient of discharge for fully submerged
pressure flow. Typical value of C is 0.8.

The difference between the energy gradient
elevation upstream and the water surface elevation
downstream

2 2
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Figure 6. Example of a bridge under fully submerged pressure flow

Selection of Dischar~eCoefficient. C

Typical values for the discharge coefficient C range from 0.7 to 0.9, with a value of
0.8 commonly used for most bridges.

•

The user must enter a value for C whenever the pressure flow method is selected. •
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• The discharge coefficient C can be related to the total loss coefficient, which comes
from the form of the orifice equation that is used in the HEC-2 computer program
(HEC, 1990):

where: K Total loss coefficient

(4)

•

The conversion from K to C is as follows:

(5)

•

The program will begin checking for the possibility of pressure flow when the
computed low flow energy grade line is above the maximum low chord elevation at
the upstream side of the bridge.

Once pressure flow is computed, the pressure flow answer is compared to the low
flow answer and the higher of the two is used.

The user can use the water surface, instead of energy, to trigger the pressure flow
calculation.
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3. Weir Flow Computations

General Equation

Flow over the bridge, and the roadway approaching the bridge, is calculated using
the standard weir equation (see Figure 7):

•

where: Q

c

L

Q = CLH 3/2

Total flow over the weir

Coefficient of discharge for weir flow

Effective length of the weir

(6)

H

H

Difference between energy upstream and road crest

•

Figure 7. Example bridge with pressure and weir flow

The approach velocity is included by using the energy grade line elevation in lieu of
the upstream water surface elevation for computing the head, H. •
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• Discharge Coefficient. C

1) General

Under free flow conditions (discharge independent of tailwater) the coefficient of
discharge C, ranges from 2.5 to 3. 1 (1. 38 - 1.71 metric) for broad-crested weirs
depending primarily upon the gross head on the crest (C increases with head).

Increased resistance to flow caused by obstructions such as trash on bridge railings,
curbs, and other barriers would decrease the value of C.

For rectangular weirs with a breadth of 15 feet and a H of 1 foot or more, the given
value is.2.63 (1.45 for metric).

Trapezoidal shaped weirs generally have a larger coefficient with typical values
ranging from 2.7 to 3.08 (1.49 to 1.70 for metric).

•

•

2) Roadways

Hydraulics of Bridge Waterways [Bradley, 1978] provides a curve of C versus the
head on the roadway with the roadway section shown as a trapezoid and the
coefficient rapidly changes from 2.9 for a very small H to 3.03 for H = 0.6 feet and
levels off near a value of 3.05 (1.69 for metric).

If weir flow is over the roadway approaches to the bridge, a value of 3.0 (1.66 for
metric) would be consistent with available data.

3) Bridge Deck

With very little prototype data available, an assumption of rectangular weir for flow
over the bridge deck (assuming the bridge can withstand the forces) and a coefficient
of 2.6 (1.44 for metric) appears reasonable.

4) Combined Roadway and Bridge Deck Weir Flow

If weir flow occurs a combination of bridge and roadway, an average coefficient
(weighted by weir length) could be used.
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5) Submergence Conditions

For high tailwater elevations, the program will automatically reduce the amount of
weir flow to account for submergence on the weir.

The weir coefficient is reduced based on the amount of submergence and corrections
are based on a trapezoidal weir shape or optionally, an ogee spillway shape.

The submergence correction for a trapezoidal weir shape is from "Hydraulics of
Bridge Waterways" [Bradley, 1978].

Figure 8 shows the relationship between the percentage of submergence and the flow
reduction factor.

•

Discharge Reduction for Submerged Flow
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Figure 8. Factor for reducing weir flow for submergence
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•

•

The total weir flow is computed by subdividing the weir crest into segments,
computing L, H, a submergence correction, and a Q for each section, then summing
the incremental discharges.

When the weir becomes highly submerged the program will automatically switch to
calculating the upstream water surface by the energy equation (standard step
backwater) instead of using the pressure and weir flow equations.

The criteria for when the program switches to energy based calculations is user
controllable. A default maximum submergence is set to 0.95 (95 percent).

D. Combination Flow

Sometimes combinations of low flow or pressure flow occur with weir flow.

The program iterates between the two types of flows until both the low flow method
(or pressure flow) and the weir flow method have the same energy (within a
specified tolerance) upstream of the bridge (section 3).

The combination of low flow and weir flow can be computed with any of the low
flow methods mentioned previously, except the momentum based method.
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IV. Selecting a Bridge Modeling Approach

A. General

For low flow (water surface is below the maximum low chord of the bridge deck),
the user can select any or all of the four available methods.

For high flows, the user must choose between either the energy based method or the
pressure and weir flow approach.

Each method should be considered and the following discussion provides some basic
guidelines.

B. Low Flow Methods

General

•

For low flow conditions (water surface below the highest point on the low chord of •
the bridge opening), the Energy and Momentum methods are the most physically
based, and in general are applicable to the widest range of bridges and flow
situations.

Both methods account for friction losses and changes in geometry through the
bridge.

The energy method accounts for additional losses due to flow transitions and
turbulence through the use of contraction and expansion losses.

The momentum method can account for additional losses due to pier drag.

Both the Yamen equation and the contracted opening method are empirical formulas
and when applying these two methods, the user should ensure that the problem is
within the range of data that these methods were developed for.

•
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•
Suggestions for Low Flow Modeling of Bridges and Culverts

The following examples are some typical cases where the various low flow methods
might be used:

1. In cases where the bridge piers are a small obstruction to the flow, and
friction losses are the predominate consideration, the energy based
method or the momentum method should give the best answers.

2. In cases where pier losses and friction losses are both predominant, the
momentum method should be the most applicable, but any of the
methods can be used.

3. Whenever the flow passes through critical depth within the vicinity of
the bridge, both the momentum and energy methods are capable of
modeling this type of flow transition.

• 4.

The Yarnell and Contracted opening methods are for subcritical flow
only.

For supercritical flow, both the energy and the momentum method can
be used.

The momentum based method may be better at locations that have a
substantial amount of pier impact and drag losses.

•

5. For bridges in which the piers are the dominant contributor to energy
losses and the change in water surface, either the momentum method
or the Yarnell equation would be most applicable.

6. For long culverts under low flow conditions, the energy based standard
step method is the most suitable approach.

Several sections can be taken through the culvert to model changes in
grade or shape or to model a very long culvert which has the benefit of
providing detailed answers at several locations within the culvert but
cannot be modeled in this way with the culvert routines in HEC-RAS.

If the culvert flows full, or if it is controlled by inlet conditions, the
culvert routines would be the best approach.
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C. High Flow Methods

General

For high flows (flows that come into contact with the maximum low chord of the
bridge deck), the energy based method is applicable to the widest range of problems.

Suggestions for High Flow Modeling of Bridges and Culverts

The following examples are some typical cases where the various high flow methods
might be used.

1. When the bridge deck is a small obstruction to the flow, and the bridge
opening is not acting like an pressurized orifice, the energy based
method should be used.

•

2. When the bridge deck is a large obstruction to the flow, and a
backwater is created due to the bridge deck, the pressure and weir
method should be used. •

3. When the bridge is overtopped, and the water going over top of the
bridge is llQ1 highly submerged by the downstream tailwater, the
pressure and weir method should be used.

The pressure and weir method will automatically switch to the energy
method if the bridge becomes 95 percent submerged (default) and can
be changed by the user.

4. When the bridge is highly submerged, and flow over the road is not
acting like weir flow, the energy based method should be used.
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A.

v. Unique Bridge Problems and
Suggested Approaches

General

Many bridges are more complex than the simple examples presented in the previous
sections.

The following discussion is intended to show how HEC-RAS can be used to
calculate profiles for more complex bridges crossings.

B. Perched Bridges

Definition

A perched bridge is one for which the road approaching the bridge is at the
floodplain ground level, and only in the immediate area of the bridge does the road

• rise above ground level to span the watercourse.

A typical flood-flow situation with this type of bridge is low flow under the bridge
and overbank flow around the bridge.

Modeling Approach

Because the road approaching the bridge is usually not much higher than the
surrounding ground, the assumption of weir flow is often not justified.

A solution based on the energy method (standard step calculations) would be better
than a solution based on weir flow with correction for submergence.

This type of-bridge should generally be modeled using the energy based method,
especially when a large percentage of the total discharge is in the overbank areas.

•
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c. Low Water Bridges

Definition

A low water bridge is designed to carry only low flows under the bridge.

Flood flows are carried over the bridge and road.

Modeling Approach

When modeling this bridge for flood flows, the anticipated solution is a combination
of pressure and weir flow.

With most of the flow over the top of the bridge, the correction for submergence
may introduce considerable error.

If the tailwater is going to be high, it may be better to use the energy based method.

If almost all the water is over the top of the bridge, the bridge may be modeled as
a cross section over the top of the bridge, ignoring the flow under the bridge .

D. Bridges on a Skew

Definition

Skewed bridge crossings are generally handled by making adjustments to the bridge
dimensions to define an equivalent cross section perpendicular to the flow lines.

Adjustments to Geometry

In the current version of HEC-RAS, it is up to the user to make these adjustments.

The cross sections that bound the bridge can be adjusted from the cross section
editor and the bridge information (bridge deck/roadway, abutments, and Piers)
should be adjusted before you enter the information.

32

•

•

•



•

•

•

In a future version of HEC-RAS, the user will be able to enter a skew angle for the
bridge deck, piers, and abutments from the bridge and culvert editor of the user
interface.

Effects of Skews on Bridge Hydraulics

In the publication "Hydraulics of Bridge Waterways" [Bradley, 1978] the effect of
skew on low flow is discussed.

In model testing, skewed crossings with angles up to 20 degrees showed no
objectionable flow patterns.

A graph illustrating the impact of skewness indicates that using the projected length
is adequate for angles up to 30 degrees for small flow contractions.

E. Parallel Bridges

Definition

Parallel bridges are usually caused by construction of divided highways or highway
and railroad bridges side by side.

For new highways, these bridges are often identical structures.

Hydraulic Losses

The hydraulic losses through the two structures has been shown to be between one
and two times the loss for one bridge [Bradley, 1978].

The model re.suIts [Bradley, 1978] indicate the loss for two bridges ranging from 1.3
to 1.55 times the loss for one bridge crossing, over the range of bridge spacings
tested.

Presumably if the two bridges were far enough apart, the losses for the two bridges
would equal twice the loss for one.
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Modeling Approach

If the parallel bridges are very close to each other, and the flow will not be able to
expand between the bridges, the should be modeled as a single bridge.

If there is enough distance between the bridge, in which the flow has room to
expand and contract, the bridges should be modeled as two separate bridges.

If both bridges are modeled, care should be exercised in depicting the expansion and
contraction of flow between the bridges.

F. Multiple Bridge Opening

Multiple culverts, bridges with side relief openings, and separate bridges over a
divided channel are all examples of multiple opening problems.

With more than one bridge opening, and possible different control elevations, the
problem can be very complicated.

HEC-RAS can handle multiple bridge and/or culvert openings.

Detailed discussions on how to model multiple bridge and/or culvert openings is
covered under chapter 7 of the Hydraulic Reference Manual.
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HEC-RAS Workshop 3

Bridge Example

Objective: Show how to compare an existing conditions and project conditions with
a bridge added.

1. Accessing the Existing Condition File

A. Accessing the Project

From the HEC-RAS main screen, click File, then Open Plan. Go to the Workshp3
directory and open the project "Workshop 3; Bridge Problem" (workshp3.prj file).

This file contains an existing conditions file set up to run 4 discharges with a
geometric file containing 4 cross sections spaced so that a bridge can be properly
placed. The "n" values have also been entered for the existing condition.

The proposed bridge is located between Cross Section 2.0 and 5.0.

B. Examination of Input

Look at the distances between the cross sections and verify that they are spaced
within the "rule of thumb" for expansion and contraction limits at bridges taking into
consideration the contracted width.

The existing conditions Plan 1 has already been executed. Plot the cross sections
and profiles, examine the flow conditions (and boundary conditions) for Plan 1.

2. Getting into the Bridge Data Editor

A. General

From the Geometric Data screen, click on Bridge/Culvert. Enter a bridge on
WEST Creek as described on page 6-21 in the HEC-RAS User's Manual.

1



Enter or use the following data:

B. General Information

1. Use appropriate expansion and contraction coefficients.

2. River Station Identifier for bridge: R.M. 3.5

3. Title: 1-15 bridge on WEST Creek

4. Ineffective flow areas for Cross Sections 2.0 and 5.0 should be set at the edge
of the opening of the bridge and allow effective flow when the water surface
elevation exceeds the top of the bridge deck/roadway.

5. The "n" values of the channel under the bridge will not be affected.

C. Bridge Geometry and Associated Data

1. Upstream and downstream geometry of the bridge are the same.

2. Distance of bridge upstream of Cross Section 2.0: 5 feet

3. Width of bridge: 40 feet

•

•
4. Weir coefficient: use appropriate for weir flow that is predominately over a

bridge deck.

5. The top of the road/bridge deck is at el. 530 feet, horizontal, and extends to
where they intercept the ground points (extend ends to sta. 220 and 1000 to
assure that there are no" slivers") .

6. The low chord of the bridge is at el. 525, horizontal, and extends from sta. 400
to 550.

7. Use submergence method and correction appropriate for flow over the bridge
deck and approach roads similar to a trapezoidal weir.

2
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• D. Pier Data

1. There are two piers, centered at 440 and 500.

2. Piers are square nosed and tailed.

3. Piers are four feet wide from el. 510 to 515 and 2 feet wide from el. 515 to 525
(remember to extend ends of piers slightly beyond the ground and low chord of
bridge).

E. Modeling Approach

1. For low flow conditions, use all three methods and have HEC-RAS select the
highest energy as the final answer.

•

•

2. Select the pier drag coefficient from Table 5.2, page 5-11, of the Hydraulic
Reference Manual.

3. Select the pier coefficient from Table 5.3, page 5-13, of the Hydraulic
Reference Manual.

4. It was determined that when the bridge and/or approach roads are overtopped,
the flow can be simulated as combined pressure and/or weir flow.

5. Estimate the discharge coefficient for full flowing orifice flow based upon
reading page 5-17 of the Hydraulic Reference Manual.

6. Use the defaults for all other inputs.

F. Save Geometry

From the Geometry editor, click File, then Save Geometry Data As and enter the
title as "Bridge Geometry".

4. Executing Plans

3



A. Plan 1. Existing Condition

Execute Plan 1 with the existing condition geometry.

B. Plan 2. Bridge Condition

Create Plan 2 by combining the bridge geometry file with the flow data and saving
it with the title "Bridge in Place" and the short ID as "Plan 2". Execute Plan 2.

6. Output Results

A. Profile Output. Graphical

Plot all profiles for both plans.

•

For profile 2, why is the water surface profile at cross section 2 for the bridge
condition is lower than the existing condition but they are the same for profile I? •

For profile 1, why is the water surface elevation at cross section 5 for the bridge
condition lower than for the existing condition?

B. Profile Output. Tabular

View the tabular output for profiles using the Standard Table "Six XS Bridge"
option.

For the bridge conditions, why is the expansion loss greater for profile 2 than profile
3 when profile 3 has a greater discharge than profile I?

4
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C. Cross Section Output

View the cross section tabular as well as graphical output. Also, from the Cross
Section Output screen, click Type, then Bridge to obtain specific information about
the bridge results. Answer the following:

1. For the bridge condition, profile 1, do you have any suggestions on the
modeling improvements (hint: see notes and warnings for the cross sections)?

2. Find the maximum weir depth for profile 3 from the bridge table. If the bridge
deck is at 530 ft. and the water surface is 535.77 ft. at the upstream end of the
bridge, why is the maximum weir depth greater than 5.77 feet?

3. For profile 3, what is the discharge through the bridge in metric units?

5



HEC-RAS Workshop 3

Bridge Example Solutions

1. Ineffective flow areas for Cross Sections 2.0 and 5.0

2. Bridge Deck/Roadway Information

1
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•
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• 3. Pier #1 Information

•
4. Pier #2 Information

•
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s. Modeling Approach
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•
6. Cross Section Plot of Bridge

•
Reach: WEST Creek Riv.Sta.: 5 (Bridge)

•
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7. Profile Results of Bridge (6 XS Bridge Output Option)

RAS Reach: WEST Creek

River Sta. Plan E.G. Elev W.S. Elev Crit W.S. Frctn Loss C & E Top Width QLeft QChannel QRight Vel Chnl
Loss

(ft) (ft) (ft) (ft) (ft) (ft) (cfs) (cfs) (cfs) (fils)

6 Bridge. 514.29 514.08 0.56 0.06 96.22 1000.00 3.68

6 Exist. 514.40 514.20 0.44 0.03 97.51 1000.00 3.53

6 Bridge 530.95 529.86 0.15 0.30 401.33 922.53 22087.95 1989.53 8.87

6 Exist. 528.68 526.77 0.36 0.44 331.24 436.73 23242.30 1320.96 11.46

6 Bridge 537.25 535.30 0.17 0.65 594.83 3686.29 40782.85 5530.86 12.33

6 Exist. 536.55 534.33 0.21 0.73 546.64 3335.03 41338.90 5326.06 13.07

5 Bridge 513.68 513.28 512.52 87.65 1000.00 5.05

5 Exist. 513.93 513.64 0.38 0.17 91.47 1000.00 4.35

5 Bridge 530.49 530.01 522.78 736.20 913.99 16683.71 7402.30 6.63

5 Exist. 527.88 526.85 0.10 0.01 639.38 381.28 18872.15 5746.58 9.25

5 Bridge 536.43 535.77 528.36 829.43 4684.59 27997.61 17317.80 8.29

5 Exist. 535.62 534.86 0.05 0.00 827.14 4203.89 28696.88 17099.24 8.85

•
5
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River Sta. Plan E.G. Elev W.S. Elev Crit W.S. Frctn Loss C & E Top Width QLeft QChannel QRight Vel Chnl

Loss

(ft) (ft) (ft) (ft) (ft) (ft) (cfs) (cfs) (cfs) (ftls)

3.5 BUBridge 530.49 530.01 523.07

3.5 BUBridge 536.43 535.77 533.64

3.5 BDBridge 513.53 512.62 512.62 72.56 1000.00 7.67
3.5 BDBridge 530.49 530.01 523.07

3.5 BDBridge 536.34 534.80 533.64

2 Bridge 513.38 512.52 512.52 0.13 0.37 79.59 1000.00 7.42
2 Exist. 513.38 512.52 512.52 0.13 0.37 79.59 1000.00 7.42
2 Bridge 528.60 525.91 522.78 0.09 0.91 608.27 25000.00 13.16
2 Exist. 527.77 526.70 0.07 0.10 634.50 360.39 19005.62 5633.99 9.42
2 Bridge 535.57 534.80 528.36 0.05 0.14 826.99 4172.28 28743.52 17084.20 8.89
2 Exist. 535.57 534.80 0.05 0.14 826.99 4172.28 28743.52 17084.20 8.89

1 Bridge 510.68 510.57 508.03 0.00 0.00 106.75 1000.00 2.69
1 Exist. 510.68 510.57 508.03 0.00 0.00 106.75 1000.00 2.69
1 Bridge 527.60 526.73 518.48 0.00 0.00 432.51 1159.12 21577.47 2263.41 8.00
1 Exist. 527.60 526.73 518.48 0.00 0.00 432.51 1159.12 21577.47 2263.41 8.00

1 Bridge 535.38 534.15 523.95 0.00 0.00 762.28 4965.65 38392.30 6642.05 10.08
1 Exist. 535.38 534.15 523.95 0.00 0.00 762.28 4965.65 38392.30 6642.05 10.08
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8. Profiles of Plans

Workshop 3; Bridge Problem Solutions Plan: 1) Exist. Condo 2) Plan 2
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• 9. Answers to Questions

A. Profile Output. Graphical

For profile 2, why is the water surface profile at cross section 2 for the bridge
condition is lower than the existing condition but they are the same for profile I?

For profile 1, why is the water surface elevation at cross section 5 for the bridge
condition lower than for the existing condition?

• B. Profile Output. Tabular

For the bridge conditions, why is the expansion loss greater for profile 2 than profile
3 when profile 3 has a greater discharge than profile I?

C. Cross Section Output

1. For the bridge condition, profile 1, do you have any suggestions on the
modeling improvements (hint: see notes and warnings for the cross sections)?

•
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2. Find the maximum weir depth for profile 3 from the bridge table. If the bridge
deck is at 530 ft. and the water surface is 535.77 ft. at the upstream end of the
bridge, why is the maximum weir depth greater than 5.77 feet?

3. For profile 3, what is the discharge through the bridge in metric units?

1
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• HEC-RAS, River Analysis System

Modeling Culverts

Presented by
David T. Williams, Ph.D., P.E.

WEST Consultants, Inc., Carlsbad, CA

I. Introduction

• A. General

HEC-RAS computes energy losses, caused by structures such as culverts, in three
parts as previously presented for bridge modeling.

HEC-RAS has the ability to model single culverts; multiple identical culverts; and
multiple non-identical culverts.

This lecture discusses how culverts are modeled within HEC-RAS.

B. Contents

• General Modeling Guidelines

•
• Culvert Hydraulics

• Culvert Data and Coefficients
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II. General Modeling Guidelines

A. General

The culvert routines in HEC-RAS are similar to the bridge routines, except that the
Federal Highway Administration's (FHWA, 1985) standard equations for culvert
hydraulics are used to compute inlet control losses at the structure.

Figure 1 illustrates a typical box culvert road crossing and is similar to a bridge in
many ways with the walls and roof of the culvert correspond to the abutments and
low chord of the bridge, respectively.

•
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Figure 1. Typical Culvert Road Crossing

Because of the similarities between culverts and other types of bridges, culverts are
modeled in a similar manner to bridges.

The layout of cross sections, the use of the ineffective areas, the selection of loss
coefficients, and most other aspects of bridge analysis apply to culverts as well. •
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• B. Types of C lverts

HEC-RAS has the ability to model six of the most commonly used culvert shapes.

These shapes include: circular; box (rectangular); arch; pipe arch; elliptical; and
semi-circular culverts (Figure 2).

The program has the ability to model up to ten different culvert types (any change
in shape, slope, roughness, or chart and scale number requires the user to enter a
new culvert type) at any given culvert crossing.

For a given culvert type, the number of identical barrels is limited to 20.

• Circular

Arch

Box (Rectangular)

Pipe Arch

Elliptical

Semi-Circle

•
Figure 2. Commonly used culvert shapes
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C. Cross Section Locations

1. General

The culvert routines in HEC-RAS require the same four cross sections and locations
as the bridge routines.

Note, the cross sections at the two ends of the culvert represent the channel outside
of the culvert.

The separate culvert data will be used to create cross sections inside of the culvert.
Figure 3 illustrates the cross sections required for a culvert model.
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Figure 3. Cross Section Layout for Culvert Method
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• 2. Cross Section 1 of Culvert Model

•

•

Cross section 1 for a culvert model should be located at a point where flow has fully
expanded from its constricted top width caused by the culvert constriction.

The cross section spacing downstream of the culvert can be based on the 1: 1 or 4: 1
criterion stated under the bridge modeling lecture.

The entire area of cross section 1 is usually considered to be effective in conveying
flow.

3. Cross Section 2 of Culvert Model

Location and Shape of Section

Cross section 2 of a culvert model is located at the downstream end of the culvert.

It does not include any of the culvert structure or embankments, but represents the
physical shape of the channel just downstream of the culvert.

The shape and location of the culvert is entered separately from the Bridge and
Culvert editor in the user interface.

Ineffective Flow Areas

The HEC-RAS ineffective area option is used to restrict the effective flow area of
cross section 2 to the flow area around or near the edges of the culverts, until flow
overtops the roadway.

The ineffective flow areas are used to represent the correct amount of active flow
area just downstream of the culvert.

Figure 4 illustrates cross section 2 of a typical culvert model of a circular culvert.

The cross section data does not define the culvert shape for the culvert model.
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On Figure 4, the channel bank locations are indicated by small circles and the
stations and elevations of the ineffective flow areas are indicated by triangles.

Cross sections 1 and 2 are located so as to create a channel reach downstream of the
culvert in which the HEC-RAS program can accurately compute the friction losses
and expansion losses downstream of the culvert.
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Figure 4. Cross Section 2 of Culvert Model

4. Cross Section 3 of Culvert Model

Location and Shape of Cross Section

Cross section 3 of a culvert model is located just upstream of the culvert (a short
distance), and represents the physical configuration of the channel immediately
upstream of the culvert.

•

•

The culvert method uses a combination of a bridge deck, cross sections 2 and 3, and
culvert data, to describe the culvert or culverts and the roadway embankment. •
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• The culvert data describing the culvert crossing is located at a river station between
cross section 2 and cross section 3.

Ineffective Flow Areas

The HEC-RAS ineffective area option is used to restrict the effective flow area of
cross section 3 to the flow area around or near the edges of the culverts, until flow
overtops the roadway.

Figure 5 illustrates cross section 3 of a typical culvert model of a circular culvert,
including the roadway profile defined by the bridge deck, and the culvert shape
defined in the bridge and culvert editor.

The ground profile does not define the culvert shape for the culvert model.
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Figure 5. Cross Section 3 of the Culvert Model
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4. Cross Section 4 of Culvert Model •The final cross section in the culvert model is located at a point where flow has not
yet begun to contract from its unrestrained top width upstream of the culvert to its
constricted top width near the culvert.

This distance is normally determined assuming a one to one contraction of flow and
the entire area of the cross section is considered to be effective in conveying flow.

D. Expansion and Contraction Coefficients

User-defined coefficients are required to compute head losses due to the contraction
and expansion of flows upstream and downstream of a culvert.

These losses are computed by multiplying an expansion or contraction coefficient by
the absolute difference in velocity head between two cross sections.

Recommended values for the expansion and contraction coefficients have been given
in-Chapter 3 of the Hydraulic Reference Manual (table 3.2).

For culverts with unusual abrupt flow transitions, the contraction and expansion loss
coefficients should be increased to account for additional energy losses.

E. Limitations of the Culvert Routines in HEC-RAS

The HEC-RAS culvert routines are subject to the following limitations:

1. Constant Cross Section

The culvert shape, flow rate, bottom slope, and roughness are assumed to be
constant throughout the length of each culvert.

8
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• 2. Positive or Horizontal Culvert Slope

The culvert bottom slope is required to be positive or zero.

That is, the upstream invert elevation of the culvert must be equal to or greater than
the downstream invert elevation.

3. No Supercritical Profiles Through the Culvert

The current version of HEC-RAS does not have the ability to compute a supercritical
water surface profile through a culvert.

•

•

If the user requests a supercritical profile computation for a data set that has
culverts, the program calculates the correct supercritical water surface upstream of
the culvert, then skips the culvert calculation and sets a critical depth boundary
condition at the downstream end of the culvert.

The same procedure is used for a mixed flow regime profile, if it is found that
supercritical flow will continue through the culvert.

It is very rare to have supercritical flow continue through a culvert in a supercritical
or mixed flow regime profile but if it does, the culvert crossing should be converted
to a bridge model.

The bridge routines can easily model a supercritical profile through the structure
with either the energy or momentum based computational methods.
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III. Culvert Hydraulics •
A. Introduction to Culvert Terminology

Physical Features of Culverts

A culvert is a relatively short length of closed conduit which connects two open
channel segments or bodies of water.

Two of the most common types of culverts are:

circular pipe culverts, which are circular in cross section

box culverts, which are rectangular in cross section

Figure 6 shows an illustration of circular pipe and box culverts.

In addition to box and pipe culverts, HEC-RAS has the ability to model arch; pipe
arch; elliptical; and semi-circular culvert shapes. •
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Figure 6. Cross section of a circular pipe and box culvert, respectively •
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• Culverts are made up of an entrance where water flows into the culvert, a barrel,
which is the closed conduit portion of the culvert, and an exit, where the water flows
out of the culvert (see Figure 7).
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Figure 7. Full flowing culvert with energy and hydraulic grade lines

Hydraulic Features of Culverts

The total flow capacity of a culvert depends upon the characteristics of the entrance
as well as the culvert barrel and exit.

The Tailwater at a culvert is the depth of water on the exit or downstream side of
the culvert, as measured from the downstream invert of the culvert.

The invert is the lowest point on the inside of the culvert at a particular cross
section.

The tailwater depth depends on the flow rate and hydraulic conditions downstream
of the culvert.
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The Headwater at a culvert is the depth of water on the entrance or upstream side •
of the culvert, as measured from the upstream invert of the culvert.

The Specific Energy at the upstream end of a culvert is equal to the headwater depth
plus the upstream velocity head.

The specific energy at the downstream side of the culvert is equal to the tailwater
depth plus the downstream velocity head.

The Total Energy at any location is equal to the elevation of the invert plus the
specific energy (depth of water + velocity heady) at that location.

Culvert Computations

All of the culvert computations within HEC-RAS compute the total energy for the
upstream end of the culvert.

The upstream water surface (Headwater) is then obtained by placing that energy into
the upstream cross section and computing the water surface that corresponds to that •
energy for the given flow rate.

B. Flow Analysis for Culverts

General

The analysis of flow in culverts is quite complicated.

It is common to use the concepts of "inlet control" and "outlet control" to simplify
the analysis.

Inlet control .

This occurs when the flow capacity of the culvert entrance is less than the flow
capacity of the culvert barrel.

The control section of a culvert operating under inlet control is located just inside •
the entrance of the culvert.
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•

•

The water surface passes through critical depth at or near this location, and the flow
regime immediately downstream is supercritical.

Outlet control

This occurs when the culvert flow capacity is limited by downstream conditions
(high tailwater) or by the flow carrying capacity of the culvert barrel.

The HEC-RAS culvert routines compute the upstream energy required to produce
a given flow rate through the culvert for inlet control conditions and for outlet
control conditions.

The higher upstream energy "controls" and determines the type of flow in the
culvert for a given flow rate and tailwater condition.

C. Computing Inlet Control Headwater

General

For inlet control conditions, the capacity of the culvert is limited by the capacity of
the culvert opening, rather than by conditions farther downstream.

Extensive laboratory tests by the National Bureau of Standards, the Bureau of Public
Roads, and other entities resulted in a series of equations which describe the inlet
control headwater under various conditions.

These equations form the basis of the FHWA inlet control nomographs shown in the
"Hydraulic Design of Highway Culverts" publication [FHWA, 1985].

The FHWA inlet control equations are used by the HEC-RAS culvert routines in
computing the upstream energy.

FHWA Nomographs

The nomographs in the FHWA report are considered to be accurate to within about
10 percent in determining the required inlet control headwater [FHWA, 1985].
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The nomographs were computed assuming a culvert slope of 0.02 feet per foot (2
percent).

For different culvert slopes, the nomographs are less accurate because inlet control
headwater changes with slope.

The culvert routines in HEC-RAS considers the slope in computing the inlet control
energy.

The culvert routines in HEC-RAS should be more accurate than the nomographs,
especially for slopes other than 0.02 feet per foot.

D. Computing Outlet Control Headwater

For outlet control flow, the required upstream energy to pass the given flow must
be computed considering several conditions within and downstream of the culvert.

Figure 6.8, page 6-11 ,of the Hydraulics Reference Manual illustrates the logic of
the outlet control computations:

E. FHWA Full Flow Equations

For culverts flowing full, the total head loss, or energy loss, through the culvert is
measured in feet (or meters).

The head loss, HL , is computed using the following formula:

•

•

H
L

= h + h + h
en / ex (1)

where: hen - entrance loss (feet or meters)

hf friction loss (feet or meters)

hex exit loss (feet or meters) •
14



I. The friction loss in the culvert is computed using Manning's formula.

The entrance energy losses is computed as a coefficient times the velocity head
inside the cuIvert at the upstream end.

The exit energy loss is computed as a coefficient times the change in velocity head
from just inside the culvert, at the downstream end, to outside of the culvert, at the
downstream end.

The exit and entrance loss coefficients are described in the next section of this
lecture.

F. Direct Step Water Surface Profile Computations

General

For culverts flowing partially full, the water surface profile in the culvert IS

• computed using the direct step method.

The water surface profile is computed for small increments of depth (usually
between 0.01 and 0.05 feet).

If the flow depth equals the height of the culvert before the profile reaches the
upstream end of the culvert, the friction loss through the remainder of the culvert is
computed assuming full flow.

The Direct Step Method in the Culvert

The first step in the direct step method is to compute the exit loss and establish a
starting water surface inside the culvert.

If the tailwater depth is below critical depth inside the culvert, then the starting
condition inside the culvert is assumed to be critical depth.

•
If the tailwater depth is greater than critical depth in the culvert, then a mini energy
balance is performed from the downstream cross section to inside of the cuIvert.
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Once a water surface is computed inside the culvert at the downstream end, the next
step is to perform the direct step backwater calculations through the culvert.

The direct step backwater calculations will continue until a water surface and energy
are obtained inside the culvert at the upstream end.

The final step is to add an entrance loss to the computed energy to obtain the
upstream energy outside of the culvert at section 3 (Figure 7).

The water surface outside the culvert is then obtained by computing the water
surface at section 3 that corresponds to the calculated energy for the given flow rate.

G. Normal Depth of Flow in the Culvert

Normal depth is the depth at which uniform flow will occur in an open channel.

Normal depth often represents a good approximation of the actual depth of flow
within a channel segment.

For inlet control conditions, the depth of flow within the culvert is assumed to be
equal to normal depth.

This assumption is only valid if the culvert barrel is sufficiently long to allow the
flow depth to stabilize at normal depth.

The program computes normal depth using an iterative approach to arrive at a value
which satisfies Manning's equation.

If the normal depth is greater than the culvert rise (from invert to top of the culvert),
the program sets the normal depth equal to the culvert rise.

H. Critical Depth of Flow in the Culvert

•

•

Terms

Critical depth occurs when the flow in a channel has a minimum specific energy. •
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• Specific energy refers to the sum of the depth of flow and the velocity head.

Critical depth depends only on the channel shape and flow rate.

Computations

The depth of flow at the culvert outlet is assumed to be equal to critical depth for
culverts operating under outlet control with low tailwater.

Critical depth may also influence the inlet control headwater for unsubmerged
conditions.

The culvert routines compute critical depth in the culvert by an iterative procedure.

•

•

I. Horizontal Culvert Slope

The culvert routines also allow for horizontal culvert slopes.

The primary difference is that normal depth is not computed for a horizontal culvert.

Outlet control is either computed by the direct step method for an unsubmerged
outlet or the full flow equation for a submerged outlet.

J. Weir Flow

The first solution through the culvert is under the assumption that all of the flow is
going through the culvert barrels.

Once a final upstream energy is obtained, the program checks to see if the energy
elevation is greater than the minimum elevation for weir flow to occur.

If the computed energy is less than the minimum elevation for weir flow, then the
solution is final.
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If the computed energy is greater than the minimum elevation for weir flow, the
program performs an iterative procedure to determine the amount of flow over the
weir and flow through the culverts.

During this iterative procedure, the program recalculates both inlet and outlet control
culvert solutions for each estimate of the culvert flow.

The higher of the two is always used for the culvert portion of the solution.

The program will continue to iterate until it finds a flow split that produces the same
upstream energy (within the error tolerance) for both weir and culvert flow.

K. Supercritical Culvert Flow

General

The culvert routines allow supercritical flow in the culvert as a temporary condition
in-an otherwise subcritical stream profile.

If the user is running a supercritical flow profile, the program will not calculate a
supercritical water surface profile through the culvert.

During a supercritical profile, the culvert is bypassed and the downstream cross
section is set to critical depth.

The program continues the supercritical profile from the critical depth boundary
condition.

Modeling Guidelines

In general, if you have culvert crossings that will maintain supercritical flow through
the culvert, the crossing should be modeled as a bridge.

The bridge routines are capable of modeling supercritical flow through the opening
by either the energy or momentum based methods.
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•

•

If you have a steep reach with a culvert crossings, it may be better to run the
program in a mixed flow regime mode.

This will allow the program to evaluate if the culvert crossing will cause a hydraulic
jump and backwater to occur due to the constriction.

IV. Culvert Data and Coefficients

A. General

This section describes the basic data that are required for each culvert.

Discussions include how to estimate the various coefficients that are required in
order to perform inlet control, outlet control, and weir flow analyses.

The culvert data are entered on the Culvert Data Editor in the user interface.

Discussions about the culvert data editor can be found in Chapter 6 of the HEC-RAS
User's Manual.

B. Culvert Shape and Size

Dimensions of Culverts

The shape of the culvert is defined by picking one of the five available shapes.

For non-circular culverts, the size of the culvert is defined by entering a rise, which
refers to the maximum inside height of the culvert and the span, which represents
the maximum inside width.

• Both the circular and semi-circular culverts are defined by entering a diameter.
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The inside height (rise) of a culvert opening is important not only in determining the
total flow area of the culvert, but also in determining whether the headwater and
tailwater elevations are adequate to submerge the inlet or outlet of the culvert.

Chamfered Culvert Corners

Most box culverts have chamfered corners on the inside (see Figure 1).

The chamfers are ignored by the culvert routines in computing the cross-sectional
area of the culvert opening.

Some manufacturers I literature contains the true cross-sectional area for each size
of box culvert, considering the reduction in area caused by the chamfered corners.

If you wish to consider the loss in area due to the chamfers, then you should reduce
the span of the culvert.

•

You should not reduce the rise of the culvert, because the program uses the culvert •
rise to determine the submergence of the culvert entrance and outlet.

C. Culvert Length

The culvert length is measured in feet (or meters) along the center-line of the
culvert.

The culvert length is used to determine the friction loss in the culvert barrel and the
slope of the culvert.

D. Number of Identical Barrels

The user can specify up to 25 identical barrels.

•
20



•

•

•

To use the identical barrel option, all of the culverts must have identical;

1) cross-sectional shape

2) upstream and downstream invert elevations

3) roughness coefficients

4) inlet shapes

If more than one barrel is specified, the program automatically divides the flow rate
equally among the culvert barrels and then analyzes only a single culvert barrel.

The hydraulics of each barrel is assumed to be exactly the same as the one analyzed.

E. Manning's Roughness Coefficient

The Manning's roughness coefficient must be entered for each culvert type.

HEC-RAS uses Manning's equation to compute friction losses in the culvert barrel.

Suggested values for Manning's n-value are listed in Table 6.1 and Table 6.2 of the
Hydraulic Reference Manual, and in many hydraulics reference books.

F. Entrance Loss Coefficient

General Equation

Entrance losses are computed as a function of the velocity head inside the culvert
at the upstream end.

21



The entrance loss for the culvert is computed as: •
V 2

enh
en = k

en 2g
(2)

where: Energy loss due to the entrance

ken Entrance loss coefficient

Yen Flow velocity inside the culvert at the entrance

g Acceleration due to gravity

Determining the Loss Coefficient

The velocity head is multiplied by the entrance loss coefficient to estimate the
amount of energy lost as flow enters the culvert.

A higher value for the coefficient gives a higher head loss.

Entrance loss coefficients are shown in Tables 6.3 and 6.4 of the Hydraulic
Reference Manual.

These coefficients were taken from the Federal Highway Administrations "Hydraulic
Design of Highway Culverts" manual (FHWA, 1985).

F. Exit Loss Coefficient

General Equation

Exit losses are computed as a coefficient times the change in velocity head from just
inside the culvert, at the downstream end, to the cross section just downstream of
the culvert.
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• The equation for computing exit losses is as follows:

V 2 V 2
h = k (---.!!- __2_)

ex ex 2g 2g
(3)

where: Energy loss due to exit

kex. Exit loss coefficient

Vex. Velocity inside of culvert at exit

•

•

V2 Velocity outside of culvert at downstream cross
section

Suggested Values of Exit Loss Coefficient

For a sudden expansion of flow, such as in a typical culvert, the exit loss coefficient
(leex.) is normally set to 1.0 (FHWA, 1985).

In general, exit loss coefficients can vary between 0.3 and 1.0.

The exit loss coefficient should be reduced as the transition becomes less abrupt.

H. FHWA Chart and Scale Numbers

General Description

The FHWA chart and scale numbers are required input data.

The FHWA chart number and scale number refer to a series of nomographs
published by the Bureau of Public Roads (now called the Federal Highway
Administration) in 1965 [BPR, 1965], which allowed the inlet control headwater to
be computed for different types of culverts operating under a wide range of flow
conditions.
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These nomographs and others constructed usmg the original methods were
republished [FHWA, 1985].

Determining Chart and Scale Numbers

Each of the FHWA charts has from two to four separate scales representing different
culvert entrance designs.

The appropriate FHWA chart number and scale number should be chosen according
to the type of culvert and culvert entrance.

Tables 6.5 of the Hydraulic Reference Manual, which is from the 1985 FHWA
publication, may be used for guidance in selecting the FHWA chart number and
scale number.

Chart numbers 1, 2, and 3 apply only to pipe culverts.

Chart numbers 8,9, 10, 11, 12, and 13 apply only to box culverts.

HEC-RAS checks the chart number to assure that it is appropriate for the type of
culvert being analyzed.

HEC-RAS also checks the value of the Scale Number to assure that it is available
for the given chart number.

For example, a scale number of 4 would be available for chart 11, but not for chart
12.

Figures 6.9 through 6.18 of the Hydraulic Reference Manual can be used as guides
in determining which chart and scale numbers to select for various types of culvert
inlets.

I. Culvert Invert Elevations

•

•

The culvert flow-line slope is the average drop in elevation per foot of length along
the culvert. •
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The culvert slope is computed from the upstream invert elevation, the downstream
invert elevation, and the culvert length.

A sufficient slope to maintain a minimum flow velocity of 3 feet per second is often
required in order to prevent sediment accumulation in the culvert.

The slope of the culvert is used by the program to compute the drop in invert
between the upstream and downstream ends of the culvert.

It is also used to compute the normal depth of flow in the culvert under outlet control
conditions.

J. Weir Flow Coefficient

Weir flow over a roadway is computed in the culvert routines using exactly the same
methods used in the HEC-RAS bridge routines.

Refer to the Bridge Modeling lecture for appropriate values to use for the weir flow
coefficient.
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• HEC-RAS, River Analysis Systelll

Computational Differences Between
HEC-2 and HEC-RAS and

New Computational Features of HEC-RAS

Presented by
David T. Williams, Ph.D., P.E.

WEST Consultants, Inc., Carlsbad, CA

Note: Most of the following material was provided by Mr. Gary Brunner and the
• HEC staff. Their assistance is gratefully acknowledged.

I. Cross Section Conveyance Calculations

A. HEC-2 Method

HEC-2 calculates conveyance between every conveyance point in the cross section
overbanks as shown in Figure 1. The conveyance is then summed to obtain the total
left and right overbank values.

HEC-2 does not subdivide the main channel for conveyance calculations.

This method can result in different amounts of conveyance simply by adding points
to the geometry without changing the shape of the cross section.
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Figure 1. Alternative Conveyance Subdivision Method (HEC-2 style)

B. HEC-RAS Method

HEC-RAS supports the HEC-2 method for calculating conveyance, but it must be
user specified.

The HEC-RAS default method is to make conveyance calculations only at n value
break points as shown in Figure 2.
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Figure 2. HEC-RAS Default Conveyance Subdivision
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Comparisons between HEC-2 and HEC-RAS computed profiles using the HEC-2
conveyance method showed very good agreement.

Most of the difference (62.2 %) can be attributed to the difference in computing
critical depth (discussed later) and 34 % to the upstream propagation of downstream
differences.

In general, using the HEC-RAS default method for conveyance will result in higher
water surface elevations compared to the HEC-2 method since the default method
provides a lower overall conveyance for the same water surface elevation.

II. Critical Depth Computations

A. Multiple Minimum Specific Energies

For most natural channels, there is only one minimum specific energy for the entire
range of the specific energy curve.

Some rivers can have more than one minimum specific energy (up to three have
been identified) due to unusual geometric and hydraulic roughness effects.

The most common cause is the occurrence of large changes in hydraulic depth for
a small change in flow depth, such as for wide and flat overbanks.

Another is when levees contain the water within channel banks at one discharge and
for a slightly large discharge, the levees are overtopped and the overbank areas
immediately become available for conveyance.

To correctly analyze these phenomena, a technique must be developed to find these
critical depths and to decide which is the correct one to use.

HEC-RAS has 2 methods for calculating critical depth:
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A. Parabolic Method

This method is used in HEC-2. It is computationally fast but locates only one
minimum specific energy.

This method is the default for HEC-RAS but can be changed by the user.

For HEC-2, the default tolerance for convergence to critical depth is 2.5 % of the
flow depth whereas if HEC-RAS uses the parabolic method, it converges at an
accuracy of 0.01 feet (0.003 m). This can cause small differences between HEC-2
and HEC-RAS critical depths.

c. Secant Method

Method Description

•

The secant method creates a table of water surface elevation verses specific energy
comprised of up to 30 equal vertical intervals. From this table, up to three local •
minimum specific energies are determined.

Selection of Appropriate Minimum Specific Energy

If more than one is found, the critical depth is assigned to the lowest (global)
minimum specific energy.

If this minimum specific energy and resulting elevation is at the top of a levee or
ineffective flow area elevation, the next lowest local minimum specific energy is
used.

If all the minimum specific energies are caused by these phenomena, HEC-RAS will
use the lowest energy.

If the critical depth is found at the highest point of the cross section (probably not
a true critical depth), the cross section height is doubled by extending the first and
last points. This will be done up to 5 times before HEC-RAS quits searching for the
critical depth.

4

•



• The default tolerance for convergence is 0.01 feet (0.003 m).

If HEC-RAS cannot converge on a minimum specific energy and the parabolic
method was used, it will automatically try the secant method and specify that this
occurred in the output.

HEC-RAS also uses the secant method if it converges on a critical depth at the top
of a levee or ineffective flow elevation.

III. Bridge Hydraulic Computations

A. General

•

•

HEC-2 has basically 2 bridge methods - Special and Normal.

HEC-RAS has just one bridge routine that can reproduce the special features of the
two HEC-2 routines and actually provides improvements to them.

The largest differences in bridge modeling results are related to the use of the HEC­
2 special bridge routine versus the equivalent modeling method in HEC-RAS.

To better illustrate the differences and the enhancements to HEC-RAS, the following
discusses them in relation to the HEC-2 bridge routines.

B. HEC-2 Special Bridge Methodology

1. Trapezoidal Approximation for Low Flow

HEC-2 utilizes a user input trapezoid shape for the channel geometry under low
(non-pressure) flow conditions. All low flow methodologies then use this shape.

HEC-RAS utilizes the actual bridge opening geometry.
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2. Piers •HEC-2 uses a single pier (for low flows), placed at the middle of the trapezoid, and
has a width equivalent to the sum of all the pier widths.

HEC-RAS utilizes the actual geometry of each pier and computes the hydraulic
computations on each one individually.

3. Pressure Flow Area

HEC-2 uses the net flow area (input by the user) for pressure flow computations.

HEC-RAS computes the flow area from the bridge and cross section geometry

4. Pressure Flow Computations

HEC-2 computes pressure flow using a fully submerged condition, i.e., both
upstream and downstream sides of the bridge are considered submerged.

HEC-RAS uses the fully submerged equation when applicable. If only the upstream
side of the bridge is submerged, it computes pressure flow as if the bridge acted as
a sluice gate.

5. Low Chord Information

When importing HEC-2 special bridge routines into HEC-RAS, the user must enter
the low chord of the bridge since it is not on the HEC-2 BT records.

6. Definition of Weir Flow Geometry

HEC-2 requires input of geometry on BT records along the approach roads and
bridge deck where it was estimated that effective weir flow exists, even though it
may be along cross section geometry that already exists on the GR records.
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• HEC-RAS merges the approach roads or bridge deck information with the cross
section geometry, therefore only the data pertaining to the bridge needs to be
entered.

C. HEC-2 Normal Bridge Methodology

When importing HEC-2 normal bridge data, HEC-RAS should not have any
problems. The following point out the important differences.

1. Low Flow Bridge Hydraulic Computations

HEC-2' pier information is entered on the BT or GR records and is utilized for
solution of energy based equations.

HEC-RAS can use either energy, momentum or Yarnell method for low flow
conditions whereas only energy is available in HEC-2.

• If the user wants to use the energy method, no adjustments to the piers are needed.

If the momentum or Yarnell methods are to be used, the pier information must be
removed and entered as separate pier information through the pier data editor of
HEC-RAS.

2. Cross Section Sequencing and Number

HEC-2 utilizes 6 cross sections for the normal bridge routine.

HEC-RAS utilizes only 4 cross sections for bridge modeling.

The two cross sections within the bridge are automatically determined by using the
adjacent ground information and the bridge geometry.

•
If the geometry immediately outside of the bridge and inside the bridge (sections 2
and 3 and sections 4 and 5 of the HEC-2 normal bridge routine) are different in
HEC-2, HEC-RAS, when importing the data, will add 2 additional cross sections
just outside the bridge at zero distance from the bridge.
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This may cause undesired additional expansion and/or contraction losses.

3. Limited Number of Points for Bridge Information

HEC-2 limited the data points on the BT records to less 100.

HEC-RAS utilizes separate input screens for bridge deck/roadways, abutments, and
piers which HEC-2 required to be input using the BT records.

The total available input points for these screens are more than adequate to model
complex bridges.

4. Matching of BT and GR Stations

•

HEC-2 requires that the bridge table (BT data) stations match the stations on the
ground (GR data).

HEC-RAS does not require the bridge data stations to match the ground stations. •

IV. Culvert Hydraulic Computations

The culvert routines in both HEC-2 and HEC-RAS are based upon the Federal
Highway Administration methodology. The differences between the application of
the methodology are as follows:

1. Culvert Shape Limitations

HEC-2 computes culvert hydraulics for box and circular culverts only.

HEC-RAS simulates the following culvert shapes: box, circular, semi-circular, arch,
pipe arch, vertical ellipse, horizontal ellipse, low profile arch, and high profile arch.

2. Mix of Culverts at Same Location

HEC-2 is limited to one culvert shape, size, place and elevation at the same location. •
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•

•

HEC-RAS has the ability to mix the culvert shape size, place, and elevation at the
same location.

v. Floodway Encroachment Computations

The HEC-RAS floodway optimization methods were generally adapted from the
methods in HEC-2.

In essence, Methods 1 through 3 are the same in HEC-2 and HEC-RAS. The
following gives some of the differences between the two programs.

1. Encroachment Buffer Zone

HEC-2 allows encroachment up to the limits of the channel.

HEC-RAS has the ability to define a buffer zone by input of an offset from the left
and/or right channel station.

Encroachments are not allowed beyond each offset from that side of the overbank:.
This offset works with Methods 2 through 5.

2. Accuracy of Method 4

HEC-2 uses a parabolic method to interpolate encroachment stations between cross
section points.

HEC-RAS computes encroachment stations to an accuracy of 0.01 feet, therefore,
the results are generally more accurate than HEC-2 results. This is minimized if
there is a large number of geometric points bounding the final encroachment station.

3. Energy and Water Surface Increase Targets

HEC-2 Method 5 is an optimization of Method 4 and Method 6 uses an energy
increase target.
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HEC-RAS Method 5 optimizes Method 4 also but allows the user to specify an •
energy increase target in addition a water surface increase target as an added
criterion.

HEC-RAS allows the user to utilize either target or both.

There is no Method 6 in HEC-RAS since the energy increase target is included in
Method 5.

4. Encroachment at Culverts and Bridges

HEC-2 default is to not allow encroachment at culverts and bridges.

HEC-RAS default is to allow encroachment at culverts and bridges.

5. Encroachments Through Bridge Cross Sections

HEC-2 determines the encroachment stations at the downstream side of the bridge •
and fixes them upstream through the bridge.

HEC-RAS, if using the energy based method, determines the encroachment stations
at each cross section through the bridge.

6. Fixed Encroachments

HEC-2 will override any encroachment Method if encroachment (ineffective)
stations are specified on the X3 record. No optimization is performed at these cross
sections.

HEC-RAS, when an HEC-2 input is imported, will convert the X3 information into
a blocked obstruction but will continue to try to optimize.

•
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• VI. New Computational Features in HEC-RAS

In the current version of HEC-RAS (July 1995, version 1.0), all the major
computational capabilities of HEC-2 are in HEC-RAS (or improved) except for
channel improvement, split flow, vertical variation of n values, use of k values for
roughness, automatic n calibration and ice cover.

The following are new computational capabilities of HEC-RAS that are not available
in HEC-2.

1. Mixed Flow Regime

HEC-RAS can perform subcritical, supercritical, or mixed flow regime calculations
in a single execution. This provides the ability to locate hydraulic jumps.

The user does not have to reorder the cross sections as in HEC-2 to go from sub- to
• supercritical flow calculations.

2. Multiple Openings

HEC-RAS has the ability to perform calculations on multiple bridge and/or culvert
openings at the same road crossing.

3. Momentum Based Solution for Bridge Low Flow

In HEC-2, the momentum based solution is used for class Band C low flow utilizing
a trapezoidal approximation with a single pier for the channel geometry.

HEC-RAS uses the momentum based solution for class A, B, and C low flow and
takes into account friction and weight forces associated with the actual bridge
geometry within the channel.

•
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4. Looped and Dendritic River Systems •HEC-2 can analyze single reaches and a limited number of tributaries up to three
stream orders.

HEC-RAS can model single reaches, dendritic stream systems, and fully looped
network systems. For the looped network systems, the flow direction and magnitude
must be known.

5. Stream Junctions

HEC-2.utilizes the energy based method to determine the loss at a flow junction.

HEC-RAS can use either the energy based or momentum based method to determine
these losses.

HEC-RAS has the following cross section adjustments that HEC-2 does not have:

6. Cross Section Adjustments •
a. blocked ineffective flow area

b. normal ineffective flow area located at any station (HEC-2 is limited to
the channel bank stations)

c. blocked obstructions

d. specification of levee locations

7. Cross Section Points

HEC-2 allows up to 100 points to define a cross section (GR records).

HEC-RAS allows up to 500 points to define a cross section.
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• 8. Cross Section Interpolation

•

•

HEC-2 cross section interpolation is based upon raising, lowering, expanding or
contracting the current cross section and linear elevation adjustments.

HEC-RAS interpolates cross sections by true interpolation of geometric properties
of the upstream and downstream cross sections.

9. Lateral Flow Distribution Calculations

HEC-2 flow distribution option breaks at coordinate points, is determined by percent
flow and cannot subdivide the channel.

HEC-RAS has control over the number and location of subdivisions over the entire
cross section, even within the main channel.
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• HEC-RAS, River Analysis SysteDl

Optional Capabilities of HEC-RAS

Presented by
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•

•

Note: This lecture was partially derived from Chapter 4 of the HEC-RAS
Hydraulic Reference Manual.

HEC-RAS has numerous optional capabilities that allow the user to model unique
situations.

Contents

• Cross Section Interpolation

• Mixed Flow Regime Calculations

• Modeling Stream Junctions

• Flow Distribution Calculations
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I. Cross Section Interpolation

Cross Section interpolation is activated from the Options menu of the Geometric
Data editor screen.

A. Need for Interpolated Cross Sections

Geometric Requirements

Occasionally it is necessary to supplement surveyed cross section data by
interpolating cross sections in between two surveyed sections.

Cross sections should be located at significant breaks in slope or shape; therefore,
interpolation of cross sections should not be used when these breaks occur between
the cross sections.

Hydraulic Requirements

Interpolated cross sections are often required when the change in velocity head is too
large to accurately determine the change in the energy gradient.

An adequate depiction of the change in energy gradient is necessary to accurately
model friction losses as well as contraction and expansion losses.

When cross sections are spaced too far apart, the program may end up defaulting to
critical depth.

B. String Model Concepts

General

The HEC-RAS program has the ability to generate cross sections by interpolating
the geometry between two user entered cross sections.
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• The geometric interpolation routines in HEC-RAS are based on a string model, as
shown in Figure 1.
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Figure 1. String Model for Geometric Cross Section Interpolation

Concept of Master and Minor Cords

The string model in HEC-RAS consists of cords that connect the coordinates of the
upstream and downstream cross sections.

•
The cords are classified as "Master Cords" and "Minor Cords" .
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Master Cords

The master cords are defined explicitly as to the number and starting and ending
location of each cord.

The default number of master cords is five and are based on the following location
criteria:

1. First coordinate of the cross section (May be equal to left channel bank)

2. Left bank of main channel (Required to be a master cord)

3. Minimum elevation point in the main channel

4. Right bank of main channel (Required to be a master cord)

5. Last coordinate of the cross section (May be equal to right channel bank)

The interpolation routines are not restricted to a set number of master cords.

At a minimum there must be two master cords, but there is no maximum; therefore,
additional master cords can be added by the user.

This is explained in Chapter 6 of the HEC-RAS User's Manual, under cross section
interpolation.

Minor Cords

The minor cords, automatically generated by the interpolation routines, are
determined by taking an existing coordinate in either the upstream or downstream
section and establishing a corresponding coordinate at the opposite cross section by
either matching an existing coordinate or interpolating one.

•

•

The station value at the opposite cross section is determined by computing the
proportional distance that the known coordinate represents between master chords,
and then applying the proportion to the distance between master cords of the
opposite section. •
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• The number of minor cords will be equal to the sum of all the coordinates in the
upstream and downstream sections minus the number of master cords.

Geometric Interpolation of Cross Sections Using String Model

Once all the minor cords are computed, the routines can then interpolate any number
of sections between the two known cross sections.

Interpolation is accomplished by linearly interpolating between the elevations at the
ends of a cord.

Interpolated points are generated at all of the minor and master cords.

Interpolation of Roughness Coefficient

The interpolation routines will also interpolate roughness coefficients (Manning's n
values and is based on a string model similar to the one used for geometry.

• Cords are used to connect the breaks in roughness coefficients of the upstream and
downstream sections.

The default number of master cords is set to four, and are located based on the
following criteria:

1. First coordinate of the cross section (may be equal to left channel bank)

2. Left bank of main channel

3. Right bank of main channel

4. Last coordinate of the cross section (may be equal to right channel bank)

When either of the two cross sections has more than three n values, additional minor
cords are added at all other n value break points.

Interpolation of roughness coefficients is then accomplished in the same manner as
• the geometry interpolation.
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II. Mixed Flow Regime Calculations

A. General

The HEC-RAS software has the ability to perform subcritical, supercritical, or
mixed flow regime calculations.

The Specific Force equation is used in HEC-RAS to determine which flow regime
is controlling, as well as locating any hydraulic jumps.

Detailed information on the computations are presented in Chapter 4, pages 4-6 and
4-7 of the Hydraulic Reference Model.

B. Calculation Scheme

•

The mixed flow regime calculations in HEC-RAS are performed as follows:

1. A subcritical water surface profile is computed starting from a known
downstream boundary condition.

During the subcritical calculations, all locations where the program
defaults to critical depth are flagged for further analysis.

•
2. A supercritical profile calculation is started from the upstream end with

a user specified upstream boundary condition.

If the boundary condition is supercritical and has a greater specific
force than the previously computed subcritical water surface at this
location, then it is assumed to control, and the program will begin
calculating a supercritical profile from this section.

3. If the subcritical answer has a greater specific force, then the program
begins searching downstream to find a location where the program
defaulted to critical depth in the subcritical run upon which the program
uses it as a boundary condition to begin a supercritical profile
calculation.

6
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• 4. A supercritical profile in the downstream direction is calculated until
it reaches a cross section that has valid subcritical and a supercritical
answers, calculates the specific force of both computed water surface
elevations selects the one with the greater specific force.

•

5. If the supercritical answer has a greater specific force, the program
continues making supercritical calculations in the downstream direction
and comparing the specific force of the two solutions.

When the program reaches a cross section whose subcritical answer has
a greater specific force than the supercritical answer, the program
assumes that a hydraulic jump occurred between that section and the
previous cross section.

6. The program then goes to the next downstream location that has a
critical depth answer and continues the process.

Example of Mixed Flow

An example mixed flow profile, from HEC-RAS, is shown in Figure 2.

Mixed Flow Regime Example

.
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•
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Figure 2. Example Mixed Flow Regime Profile from HEC-RAS
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III. Modeling Stream Junctions

A. General

Stream junctions can be modeled in two different ways within HEC-RAS.

Energy Method

The default method is an energy based solution.

The energy method solves for water surfaces across the junction by performing
standard step backwater and forewater calculations through the junction.

The energy method does not account for the angle of any of the tributary flows.

•

Because use most streams are highly subcritical flow, the influence of the tributary
flow angle is often insignificant. •

Momentum Method

If the angle of the tributary plays an important role in influencing the water surface
around the junction, then the user should switch to the alternative method available
in HEC-RAS, which is a momentum based method.

The momentum based method is a one dimensional formulation of the momentum
equation, but the angles of the tributaries are used to evaluate the forces associated
with the tributary flows.

•
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• B. Possible Junction Conditions

There are six possible flow conditions that HEC-RAS can handle at a junction:

1. Subcritical flow - flow combining

2. Subcritical flow - flow split

3. Supercritical flow - flow combining

4. Supercritical flow- flow split

5. Mixed flow regime - flow combining

6. Mixed flow regime - flow split

The most cornmon situations are the subcritical flow cases (1) and (2).

• B. Energy Based Junction Method

Detailed information on the computations for each of these cases using the energy
based method is presented in Chapter 4 of the Hydraulics Reference Manual.

C. Momentum Based Junction Method

General

The user ca~ choose a momentum based method to solve the junction problem
instead of the default energy based method.

•
The momentum based method uses essentially the same logic as the energy based
method for solving the junction problem.

The only difference is that the momentum based method solves for the water
surfaces across the junction with the momentum equation.
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The momentum equation is formulated such that it can take into account the angles •
at which reaches are coming into or leaving the junction.

Required Data

To use the momentum based method, the user must supply the angle for any reach
who's flow lines are not parallel to the main stem's flow lines.

Combining Junctions

An example of a flow combining junction is shown below in Figure 3.

In this example, angles for both reaches 1 (8 1) and 2 (82) should be entered. Each
angle is taken from a line that is perpendicular to cross section 3.0 of reach 3.

3.0-

I
I
of

Reach 3

•

Figure 3. Example Geometry for Applying the Momentum Equation
to a Flow Combining Junction •
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• For subcritical flow, the water surface is computed up to section 3.0 of reach 3 by
normal standard step backwater calculations.

If the momentum equation is selected, the program solves for the water surfaces at
sections 4.0 and 0.0 by performing a momentum balance across the junction.

Split Flow Junction

An example of applying the momentum equation to a flow split is shown in Figure
4:

I

~ Reach 1

•

•

- 4.0

Figure 4. Example Geometry for Applying the Momentum Equation
to a Flow Split Type of Junction

Subcritical Flow at Split Junctions

For subcritical flow, the water surface elevation is known at sections 2.0 and 3.0,
and the water surface elevation at section 4.0 can be found.
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Supercritical Flow at Split Junctions

For supercritical flow, the water surface is know at section 4.0 only, and, therefore,
the water surface elevations at sections 3.0 and 2.0 must be solved simultaneously.

In order to solve the equations for supercritical flow, it is assumed that the water
surface elevations at sections 2.0 and 3.0 are equal.

Mixed Flow

Mixed flow regime computations for a flow split are handled in the same manner as
the energy based solution, except the momentum equation is used to solve for the
water surface elevations across the junction.

IV. Flow Distribution Calculations

A. Default Flow Distribution

The general cross section output shows the distribution of flow in three subdivisions
of the cross section: left overbank, main channel, and the right overbank.

Additional output showing the distribution of flow for multiple subdivisions of the
left and right overbanks, as well as the main channel, can be requested by the user
through Options menu of the Steady Flow Simulation window.

B. DerIDing Distribution Locations

The user can. either select specific locations or all locations in the model.

The number of slices for the flow distribution computations must be defined for the
left overbank, main channel, and the right overbank.

•

•

Up to 45 total slices can be defined and the number of slices can vary at each of the
cross sections. •
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•

Each flow element (left overbank, main channel, and right overbank) must have at
least one slice.

C. Computations

During the computations, at each cross section where flow distribution is requested,
for each of the defined slices, the program will calculate:

1) percentage of flow

2) area

3) wetted perimeter

4) conveyance

5) average velocity

For further details on how to request and view flow distribution output, see Chapters
7 and 8 of the HEC-RAS User's manual.

The computations for the flow distribution are performed after the program has
calculated a water surface elevation and energy by the normal methodology.

The flow distribution computations are performed as follows:

1. water surface is computed in the normal manner of using the three flow
subdivisions (left overbank, main channel, and right overbank), and
balancing the energy equation.

2. computes an area, wetted perimeter, and hydraulic depth (area over top
width) for each user defined slice.

Ie

3. Using the originally computed energy slope ( Sf ), the cross section
Manning's n values, the computed area and wetted perimeter for each
slice, and Manning's equation, the conveyance and percentage of
discharge are computed for each of the slices.
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4. The computed conveyance for each of the slices are summed (note: the
slice computed conveyance is usually greater than the original
conveyance because, as a cross section is subdivided, the computed
conveyance, for a given water surface elevation, will increase).

•
5. A ratio of the original total conveyance (from the normal calculations)

divided by the total slice conveyance is determined.

6. The ratio is applied to each of the slices, in order to achieve the same
conveyance as was originally computed.

7. An average velocity for each slice is computed by taking the discharge
and dividing by the area for each of the user defined slices.

An example of the flow distribution output is shown in Figure 5.

Figure 5. Example Output for the Flow Distribution Option
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• D. Cautions for Usage of the Flow Distribution Option

Multi-Dimensional Reality of Flow

In general, the results of the flow distribution computations should be used
cautiously.

A true velocity and flow distribution varies vertically as well as horizontally.

To achieve such detail, the user would need to use a three-dimensional hydraulic
model, or measure the flow distribution in the field.

Use of Flow Distribution Option

•

•

While the results for the flow distribution, provided by HEC-RAS, are better than
the standard three subdivisions (left overbank, main channel, and right overbank)
provided by the model, the values are still based on average estimates of the one­
dimensional results.

The results obtained from the flow distribution option can vary with the number of
slices used for the computations.

In general, it is better to use as few slices as possible.
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• HEC-RAS, River Analysis SysteDl

Modeling Multiple Bridge and/or
Culvert Openings

Presented by
David T. Williams, Ph.D., P.E.

WEST Consultants, Inc., Carlsbad, CA

Note: This lecture is derived from Chapter 7 of the HEC-RAS Hydraulic
Reference Manual.

• I. Introduction

The HEC-RAS program has the ability to model multiple bridge and/or culvert
openings at a single location.

The HEC-RAS program is capable of modeling up to seven openings at anyone
location.

Contents of Lecture

• General Modeling Guidelines

• Multiple Opening Approach

• Divided Flow Approach

•
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II. General Modeling Guidelines

A. Problem Description

Occasionally, a river crossing cannot be modeled adequately as a single bridge
opening or culvert group.

This often occurs in wide floodplain areas where there is a bridge opening over the
main river channel and a relief bridge or group of culverts in the overbank areas.

B. Methods Within HEC-RAS

There are two ways that HEC-RAS can model this type of problem.

The preferred method is to use the multiple opening capability in HEC-RAS.

•

A second method is to model the two openings as divided flow which requires the •
user to define the flow path for each opening as a separate reach.

III. Multiple Opening Approach

A. General

The multiple opening features in HEC-RAS allow users to model complex bridge
and/or culvert crossings within a one dimensional flow framework.

HEC-RAS has the ability to model three types of openings:

1. Bridges

2. Culvert Groups (a group of culverts IS considered to be a single
opening)

3. Conveyance Areas (an area where water will flow as open channel
flow, other than a bridge or culvert opening).

2
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• Up to seven total openings can be defined at anyone river crossing with up to two
conveyance openings and the rest a combination of bridge or culvert openings.

The HEC-RAS multiple opening methodology is limited to subcritical flow profiles.

Mixed flow regime mode can be used; however, only a subcritical profile will be
calculated in the area of the multiple opening.

An example of a multiple opening is shown in Figure 1.
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Figure 1. Example Multiple Opening River Crossing

•
As shown in Figure 1, the example river crossing has been defined as three
openings: Opening #1 represents a Conveyance Area, opening #2 is a Bridge
opening, and opening #3 is a Culvert Group.
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B. Method Approach

The approach used in HEC-RAS is to evaluate each opening as a separate entity.

An iterative solution is applied, in which an initial flow distribution between
openings is assumed.

The water surface profile and energy gradient are calculated through each opening.

The computed upstream energies for each opening are compared to see if they are
within a specified tolerance (the difference between the opening with the highest
energy and the opening with the lowest energy must be less than the tolerance).

If the difference in energies is not less than the tolerance, the program makes a new
estimate of the flow distribution through the openings and repeats the process.

This iterative technique continues until either a solution that is within the tolerance
is achieved, or a predefined maximum number of iterations is reached (the default
maximum is 30).

c. Flow Boundaries

The distribution of flow requires the establishment of flow boundaries both upstream
and downstream of the openings.

The flow boundaries represent the point at which flow separates between openings.

These flow boundaries are referred to as "Stagnation Points" (the term "stagnation
points" will be used from this point on when referring to the flow separation
boundaries) .
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• A plan view of a multiple opening is shown in Figure 2.

•

~ Stagnation Points___________

-3

- 2

1

•

Figure 2. Plan view of a Multiple Opening Problem

D. Locating the Stagnation Points

User Defined Stagnation Points

The user has the option of fixing the stagnation point locations or allowing the
program to solve for them within user defined limits.
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In general, it is better to let the program solve for the stagnation points because it •
provides the best flow distribution and computed water surfaces.

Stagnation Points Allowable Lateral Range

Allowing the stagnation points to migrate can be important when evaluating several
different flow profiles in the same model since this affects the distribution of flow
through the openings.

If the range in which the stagnation points are allowed to migrate is vary large, the
program may have difficulties in converging to a solution.

Whenever this occurs, the user should either reduce the range that the stagnation
points can migrate or fix their location.

Within HEC-RAS, stagnation points are allowed to migrate between any bridge
openings and/or culvert groups.

•Allowable Range for Conveyance Areas

If the user defines a conveyance area opening, the stagnation point between this type
of opening and any other must be a fixed location.

Conveyance area openings are limited to the left and/or right ends of the cross
section, therefore they cannot be between other types of openings.

E. Computational Procedure for Multiple Openings

HEC-RAS uses an iterative procedure for solving the multiple opening problem.
The following approach is used when performing a multiple opening computation:

1. The upstream water surface (cross section 3) is set equal to the
computed energy on the downstream side of the river crossing (cross
section 2).

6
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• 2. The assumed water surface is projected onto the immediate upstream
side of the openings and a flow distribution is computed based on the
percent of flow area in each opening.

3. Stagnation points are located by apportioning the conveyance in the
upstream cross section, so that the percentage of conveyance for each
section is equal to the percentage of flow in each opening.

4. The stagnation points in the downstream cross section (section just
downstream of the river crossing) are located in the same manner.

5. The water surface and energy profiles through each opening IS

calculated using the assumed flow in each opening.

6. A comparison is made between the energies to see if a balance has been
achieved (i. e., the difference between the highest and lowest computed
energy of the openings is less than a predefined tolerance).

• 7. If the energies are not within the tolerance, the program computes an
average energy by using a flow weighting for each opening.

•

8. The average energy computed in step 7 is used to estimate the new flow
distribution.

This estimate of the flow distribution is based on adjusting the flow in
each opening proportional to the percentage that the computed energy
for that opening is from the weighted average energy.

9. A continuity check is made to ensure that the sum of the flows in all the
openings is equal to the total flow and, if not, the flow in each opening
is adjusted proportionately.

10. Steps 3 through 9 continue until either a balance in energy is reached
or the program gets to the fifth iteration.

11. If the program gets to the fifth iteration, then the program switches to
a second iteration method which formulates a flow versus upstream
energy for each opening (energy rating curve).
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12. The rating curve is based on the first four iterations. The rating curves •
are combined to get a total flow verses energy curve for the entire
crossmg.

13. A new upstream energy guess is based on entering this curve with the
total flow and interpolating an energy and returning to the individual
opening curves with this energy and interpolating a flow for each
opemng.

14. New water surface and energy profiles are computed for each opening.

15. If all the energies are within the tolerance, the program is finished.

If not within the tolerance, the rating curves are updated with the new
computed points, and the process continues until either a solution
within the tolerance is achieved, or the program reaches the maximum
number of iterations.

16. The tolerance for balancing the energies between openings is 5 times •
the default cross section water surface tolerance (0.05 feet or 0.015
meters).

17. The default number of iterations for the multiple opening solutions
scheme is 1.5 times the default cross section maximum (the default for
cross sections is 20, therefore the default for openings is 30).

18. Once a solution is achieved, the program places the mean computed
energy into the upstream cross section and computes the corresponding
water surface for the entire cross section.

In general, this water surface will slightly differ from the water
surfaces computed for the individual openings. These mean energy and
water surface are reported as the final solution at the upstream section.

•
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• F. Limitations of the Multiple Opening Approach

The multiple opening method within HEC-RAS is a one-dimensional flow approach
to a complex hydraulic problem.

The methodology has the following limitations:

1) energy grade line is assumed to be constant upstream and downstream
of the multiple opening crossing

2) stagnation points are not allowed to migrate past the edge of an adjacent
opening

3) stagnation points between a conveyance area and any other type of
opening must be fixed (i.e. can not float)

•

•

Given these limitations, if you have a multiple opening crossing in which the water
surface and energy vary significantly between openings, then this methodology may
not be the most appropriate approach.

IV. Divided Flow Approach

A. General Description

An alternative approach for solving a multiple opening problem is to model the flow
paths of each opening as a separate river reach.

This approach is more time consuming, and requires the user to have a greater
understanding of how the flow will separate between openings.

The benefit of using this approach is that varying water surfaces and energies can
be obtained between openings.
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B. Example Application •An example of a divided flow application is shown in Figure 3.
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Figure 3. Example of a Divided Flow Problem

Description of Flow Conditions

In the example shown in Figure 3, high ground exist between the two openings (both
upstream and downstream).

Under low flow conditions, there are two separate and distinct channels. •
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• Under high flow conditions the ground between the openings may be submerged,
and the water surface continuous across both openings.

Development of Separate Reaches

To model this as a divided flow, the user must create two separate river reaches
around the high ground and through the openings.

Cross sections 2 through 8 must be divided at estimated stagnation points for each
cross section.

The cross sections must be physically split into two or use the same cross sections
in both reaches and block out the area of each cross section (using the ineffective
flow option) that is not part of the flow path for that particular reach.

Development of Flow Distribution

• When modeling a divided flow, you must define how much flow is going through
each reach.

The current version of HEC-RAS does not optimize flow splits (this will be added
in later versions).

The user makes a first guess at the flow distribution, and then runs the model.

The results at cross section 8 are compared.

If one branch has a higher energy than the other one at section 8, then that branches
flow should be reduced and the other increased by the same amount.

The user should continue to do this until the energies from both branches at section
8 are within a reasonable tolerance.

•
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• HEC-RAS Workshop 4

Modeling Multiple Openings

Objective: Show how to develop conveyance, bridge, and culvert openings at the
same cross section and make comparisons.

1. Introduction

The bridge from Workshop #3 caused too much of a backwater effect, according to
the reviewing agency. The client has asked us to consider adding two "relief'
culverts under the right approach road (see plot below).

Workshop 3; Bridge Problem Solutions Plan: Bridge in Place 2/19/96 2:36:00 AM
Reach = WEST Creek Downstream Inside 1-5 Bridge on WEST Creek
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Also, after looking at the profiles of Workshop #3, we have decided that the approach •
on the left side should be modeled as conveyance flow instead of weir flow.

2. Accessing Bridge Workshop #3

Get into the HEC-RAS program and click on File, and then on Workshop #3 (your
work) at the bottom of the menu.

If you did not finish, click on the solution, which is wrkshp3s.prj

Click File again, then Save Project As. From the Save File As window, double click
on the root directory of c (c:\) in the Directories window on the right, then click
Create Directories.

Create directory Workshp4.

For the Project title, type "Workshop 4, Multiple Openings" and for the file name,
type workshp4.prj. and then enter or press OK.

Enter the Geometric Data screen (3rd icon from the left), click File, then Open
Geometric Data, and double click on the bridge geometry file.

Then click File again, then Save Geometric Data As. Type "Bridge and Culvert
Geometry" and press OK.

We have copied the bridge geometry and will now add the other openings to this
geometry while still keeping the bridge only geometry unchanged.

3. Entering the Culvert Data

Press the Bridge/Culvert button. You should see the same bridge as on the previous
page, which is the first downstream-most bridge section.

Since the upstream and downstream bridge cross sections will be the same, click
View and then Display Upstream XS.

2
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•

If you had other bridges and wanted to edit them, they could have been accessed by
clicking on the arrows at the upper right for movement by cross section or the arrows
on the upper left for movement by reach.

1. Entering Culvert Group #1

Press the Culvert button and enter the following data for culvert group #1. To help
select the proper Chart and Scale number, see pages 6-22 to 6-27 of the Hydraulic
Reference Manual.

If you want, you can change the names of the culvert group from the default by
pressing the Rename button at the upper right.

A. One concrete box culvert similar to Figure 6.9 in the Hydraulic Reference
Manual - 6 feet high and 20 feet wide

B. Wingwall flared 45 degrees, entrance is square-edge at crown

C. Length = 40 feet

D. Concrete is to be formed by smooth wood and unfinished (see Table 6.1,
page 6-18 of the Hydraulic Reference Manual)

E. Use exit loss = 1.0

F. Upstream invert is at 521 feet and centered at 760

G. Downstream invert is at 520.9 and centered also at 760.

After the data is entered, click OK. This will return you to the Bridge Geometry
Screen.

Click on Apply Data and check the bridge plot to see if the culvert was entered
properly.
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2. Entering Culvert Group #2

Press the Culvert button again, then press the Add button at the top of the screen.
Enter the following data for culvert group #2.

A. One corrugated metal arch, fully paved - 3 foot rise and 20 foot span

B. Inlet is similar to Figure 6.11, page 6-24 of the Hydraulic Reference
Manual

C. Length = 40 feet

D. End section of pipe conforming to the roadway side slope

E. Use exit loss = 1.0

F. Upstream invert is at 526 feet and centered at 820

G. Downstream invert is at 525.9 and centered also at 820.

After the data is entered, click OK. This will return you back to the Bridge Geometry
Screen. Click on Apply Data and check the bridge plot to see if the culvert was
entered properly.

4. Defining the Openings

Press the Multiple Opening Analysis button.

Enter the dat~ only for the upstream cross section (see headings under the first group
of push buttons).

4
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• 1. Conveyance

We want to define a conveyance area on the left side of the cross section.

Click on the first field under Opening Type. Then press the Conveyance button at
the top of the screen.

Enter 98 feet (or any number less than this) under Station Left since this is the first
station of the cross section.

Enter a station for the right side limit where you think the stagnation point is located.
On the left side of this point, the flow is by conveyance and to the right side, it is by
weir flow over the approach road/bridge deck.

Do not go beyond station 400, which is the left limit of the bridge.

2. Bridge

• Click on the second field under Opening Type. Then press the Bridge button at the
top of the screen.

Enter the left station, which should be the same as the right station of the conveyance
limit.

Enter a right station where you think the flow is divided between the bridge and the
culvert group. You may extend this slightly beyond your estimated location but
cannot go beyond 750 feet since this is the left side limit of the culvert group (box is
20 feet wide centered on 760 feet: 760 - [12 x 20] = 750).

In general, as a first trial, extend the stagnation points to the limits of the other
opening groups which then allows the computations to "wander" over a wider range
to determine the computed stagnation points.

•
If there are computational difficulties, then move them closer to where you think the
stagnation point is located or set them to the limits of the adjacent stagnation points ..
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3. Culvert

Click on the third field under Opening Type. Then press the Culvert button at the
top of the screen.

Enter the left station but do not go beyond station 550, which is the right limit of the
bridge.

Enter the right station as 940 feet (or any number greater than this), which is last
station of the cross section.

4. Applying Data to Downstream Cross Section and Examining Plots

Push the Copy Up to Down button at the lower right of the screen to use the same
information for the downstream cross section.

View the plots of the stagnation limits to check the input data.

5. Ineffective Flow Areas

Just as we defined ineffective flow areas for the cross sections immediately
downstream and upstream of the bridge in Workshop #3, we must define additional
separate ineffective flow areas associated with each of the openings.

From the Geometric Data Editor screen, go to the cross section just downstream of
the crossing, click on Options, then Ineffective Flow Areas, and then click on
Multiple Blocks.

Define the ineffective flow areas for the area between the left end of the cross section
to the left of the bridge, between the bridge and the left side of the culverts, and the
area to the right of the culverts to the right end of the cross section.

Repeat for the cross section immediately upstream of the crossing.

6
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•

•

Plot each of the cross section and the bridge section to check if the data was input
properly.

If the data appears correct, press the Apply Data button at the upper right of the
screen, return to the Stream Network screen, and save the geometric file.

6. Creating Plans

The discharge information does not change for any of the plans.

Go to the main HEC-RAS screen and enter the Simulate menu or the fifth icon from
the left (running stick man).

1. Existing Conditions

This plan should have already been created from Workshop #3. If you do not see it,
create it with the existing conditions geometry and flow data. Execute this plan.

2. Plan 2

This plan is the bridge only geometry. If not already done, create this plan and
execute.

3. Plan 3

This plan is the bridge with culverts. Create this plan and execute.

7



7. Output Analysis •From the profile tables, answer the following:

1. Why do the water surface elevations not differ between the bridge only (Plan
2) and bridge with culverts (Plan 3) for profile 17

2. For profile 2, at cross section 5, how much did the water surface elevation
decrease between Plan 2 and Plan 37

3. For profile 3, at cross section 5, how much did the water surface elevation
decrease between Plan 2 and Plan 37

4. Why is the difference so little from question 37

5. Why is the discharges of culvert #1 and #2 for the profile #2 greater than for
Profile #3, which has a greater discharge (Hint: see Standard Tables for
culverts and for Multiple Openings)7

6. What is the right stagnation point for the bridge for profile 27 Compare it with
the right stagnation limit for the bridge.

8
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• 7. What is the right stagnation point for the bridge for profile 3? Compare it with
the left stagnation limit of the culverts.

•

8. From the answers of questions 6 and 7, what do you propose to make the
model better?

9. For Plan #2, profile 3, what is the weir flow?

10. Realizing that the culverts are relatively close, what assumption ofHEC-RAS
in modeling culverts could cause an overestimation of the energy loss?

•

11. What would you suggest to compensate for the overestimation in question 10?

9



HEC-RAS Workshop 4

Modeling Multiple Openings

Solutions

1. Culvert # 1 Information

10
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•

•

2.

3.

Culvert # 2 Information

Multiple Opening Data

11



4. Ineffective Flow Areas at Cross Sections 2 and 5 (same for both) •

5. Cross Section Plot of Bridge, Ineffective Flow Areas, and Stagnation Limits

Reach: WEST Creek Riv. Sta.: 2 (Multiple Opening)
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• • •6. Profile Standard Table 1

RAS Reach: WEST Creek

River Sta. Plan Q Total Min Ch El W.S. Elev Crit W.S. E.G. Elev E.G. Slope Vel Chnl Flow AreaTop Width

(cfs) (ft) (ft) (ft) (ft) (ft/ft) (ft/s) (sq ft) (ft)
6 Bridge- 1000.00 510.00 514.08 514.29 0.002479 3.68 271.74 96.21

Culv.

6 Bridge 1000.00 510.00 514.08 514.29 0.002478 3.68 271.80 96.22
6 Exist. 1000.00 510.00 514.20 514.40 0.002192 3.53 283.53 97.51
6 B rid g e - 25000.00 510.00 529.50 530.65 0.001487 9.12 3708.09 393.16

Culv.

6 Bridge 25000.00 510.00 529.86 530.95 0.001365 8.87 3851.00 401.33
6 Exist. 25000.00 510.00 526.77 528.68 0.002998 11.46 2721.39 331.24
6 B rid g e - 50000.00 510.00 535.30 537.25 0.001808 12.33 6466.69 595.25

Culv.

6 Bridge 50000.00 510.00 535.30 537.25 0.001811 12.33 6461.67 594.83
6 Exist. 50000.00 510.00 534.33 536.55 0.002160 13.07 5911.67 546.64

5 Bridge- 1000.00 510.00 513.28 512.52 513.67 0.006305 5.06 197.75 87.63
Culv.

5 Bridge 1000.00 510.00 513.28 512.52 513.68 0.006286 5.05 197.94 87.65
5 Exist. 1000.00 510.00 513.64 513.93 0.004036 4.35 230.04 91.47
5 B rid g e - 25000.00 510.00 529.14 522.29 530.39 0.001636 9.42 3159.53 709.35

Culv.

5 Bridge 25000.00 510.00 530.01 522.78 530.49 0.000755 6.63 6664.74 736.20

5 Exist. 25000.00 510.00 526.85 527.88 0.001938 9.25 4491.96 639.38
5 B rid g e - 50000.00 510.00 535.78 524.50 536.43 0.000794 8.28 11312.79 829.45

Culv.

5 Bridge 50000.00 510.00 535.77 528.36 536.43 0.000795 8.29 11306.16 829.43
5 Exist. 50000.00 510.00 534.86 535.62 0.000959 8.85 10547.08 827.14

13



3.5 Mult Op

3.5 Bridge

2 Bridge- 1000.00 510.00 512.52 512.52 513.38 0.019892 7.42 134.73 79.59
Culv.

2 Bridge 1000.00 510.00 512.52 512.52 513.38 0.019892 7.42 134.73 79.59
2 Exist. 1000.00 510.00 512.52 512.52 513.38 0.019892 7.42 134.73 79.59
2 B rid g e - 25000.00 510.00 526.24 523.02 528.26 0.003379 11.84 2478.12 620.43

Culv.

2 Bridge 25000.00 510.00 525.91 522.78 528.60 0.004323 13.16 1899.11 608.27
2 Exist. 25000.00 510.00 526.70 527.77 0.002044 9.42 4390.53 634.50
2 B rid g e - 50000.00 510.00 534.80 527.82 535.57 0.000971 8.89 10499.12 826.99

Culv.

2 Bridge 50000.00 510.00 534.80 528.36 535.57 0.000971 8.89 10499.12 826.99
2 Exist. 50000.00 510.00 534.80 535.57 0.000971 8.89 10499.12 826.99

1 Bridge- 1000.00 505.50 510.57 508.03 510.68 0.001002 2.69 371.95 106.75
Culv.

1 Bridge 1000.00 505.50 510.57 508.03 510.68 0.001002 2.69 371.95 106.75
1 Exist. 1000.00 505.50 510.57 508.03 510.68 0.001002 2.69 371.95 106.75
1 Bridge- 25000.00 505.50 526.73 518.48 527.60 0.001000 8.00 4422.97 432.51

Culv.

Bridge 25000.00 505.50 526.73 518.48 527.60 0.001000 8.00 4422.97 432.51
Exist. 25000.00 505.50 526.73 518.48 527.60 0.001000 8.00 4422.97 432.51
B rid g e - 50000.00 505.50 534.15 523.95 535.38 0.001002 10.08 8734.14 762.28
Culv.

Bridge 50000.00 505.50 534.15 523.95 535.38 0.001002 10.08 8734.14 762.28
Exist. 50000.00 505.50 534.15 523.95 535.38 0.001002 10.08 8734.14 762.28
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•
7. Multiple Opening Table

• •
RAS Reach: WEST Creek

River Sta. Plan Opening QTotal Flow Area E.G. Elev W.S. Elev Top Wdth Vel Total Crit W.S. Left Stagn Right
Act Stagn

(cfs) (sq ft) (ft) (ft) (ft) (ftIs) (ft) (ft) (ft)

3.5 B rid g e - Left Cony 260.00
Culv.

3.5 B rid g e - Bridge #1 1000.00 197.94 513.68 513.28 87.65 5.05 512.52 260.00 700.00
Culv.

3.5 B rid g e - Cuiv Grp 700.00
Culv. #1

3.5 B rid g e - Left Cony 260.00
Culv.

3.5 Bridge- Bridge #1 23147.74 2344.50 530.39 528.88 150.00 9.87 522.29 260.00 750.00
Culv.

3.5 B rid g e - Culv Grp 1852.26 1900.58 530.42 530.41 185.20 0.97 750.00 935.20
Culv. #1

3.5 B rid g e - Left Cony 6735.41 987.52 536.44 535.71 151.43 6.82 108.57 260.00
Culv.

3.5 Bridge- Bridge #1 32152.83 6643.20 536.43 535.79 440.00 4.84 524.50 260.00 700.00
Culv.

3.5 Bridge- CulvGrp 11111.76 3798.54 536.43 536.30 238.15 2.93 700.00 938.15
Culv. #1
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8. Culvert Only Table

RAS Reach: WEST Creek

River Sta. Plan Culvert ID E.G. US. W.S. US. E.G.IC E.G.OC Min Top Culv Q QWeir Delta WS Culv Vel Culv Vel
Rd In Out

(ft) (ft) (ft) (ft) (ft) (cfs) (cfs) (ft) (ftls) (ft/s)
3.5 B rid g e -Culvert #1 530.00

Culv.

3.5 B rid g e -Culvert #2 530.00
Culv.

3.5 B rid g e -Culvert #1 530.42 530.41 529.67 530.42 530.00 1195.19 132.77 2.26 9.96 9.96
Culv.

3.5 B rid g e -Culvert #2 530.42 530.41 530.43 529.99 530.00 524.29 132.77 2.26 9.20 8.68
Culv.

3.5 B rid g e -Culvert #1 536.43 536.30 526.93 536.43 530.00 798.85 9864.88 0.88 6.66 6.66
Culv.

3.5 B rid g e -Culvert #2 536.43 536.30 529.72 536.44 530.00 448.03 9864.88 0.88 6.34 6.34
Culv.

•
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9. Bridge Only

• RAS Reach: WEST Creek

River Sta. Plan E.G. Elev Min El Prs Prs 0 WS QTotal Min Top Q Weir Delta EG
Rd

(ft) (ft) (ft) (cfs) (ft) (cfs) (ft)
3.5 #1 Bridge- 513.68 525.00 1000.00 530.00 0.30

Culv.

3.5 #1 Bridge- 530.39 525.00 23147.74 530.00 298.14 2.14
Culv.

3.5 #1 Bridge- 536.43 525.00 32152.83 530.00 18388.41 0.87
Culv.

3.5 Bridge 513.68 525.00 1000.00 530.00 0.30

3.5 Bridge 530.49 525.00 25000.00 530.00 1745.91 1.89

3.5 Bridge 536.43 525.00 50000.00 530.00 36169.20 0.86

•
10. Answers to Questions

From the profile tables, answer the following:

1. Why do the water surface elevations not differ between the bridge only (Plan
2) and bridge with culverts (Plan 3) for profile 1?

2. For profile 2, at cross section 5, how much did the water surface elevation
decrease between Plan 2 and Plan 3?

•
3. For profile 3, at cross section 5, how much did the water surface elevation

decrease between Plan 2 and Plan 3?

17



4. Why is the difference so little in question 3?

5. Why is the discharges of culvert #1 and #2 for the profile #2 greater than for
Profile #3, which has a greater discharge (Hint: see Standard Tables for
culverts and for Multiple Openings)?

6. What is the right stagnation point for the bridge for profile 2? Compare it with
the right stagnation limit for the bridge.

•

7. What is the right stagnation point for the bridge for profile 3? Compare it with
the left stagnation limit of the culverts.

8. From the answers of questions 6 and 7, what do you propose to make the
model better? •

9. For Plan #2, profile 3, what is the weir flow?

10. Realizing that the culverts are relatively close, what assumption ofHEC-RAS
in modeling culverts could cause an overestimation of the energy loss?

11. What would you suggest to compensate for the overestimation in question 10?

18
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• HEC-RAS, River Analysis System

Floodway Determination

Presented by
David T. Williams, Ph.D., P.E.

WEST Consultants, Inc., Carlsbad, CA

Note: This lecture is derived from Chapter 8 of the Hydraulic Reference Manual
and Chapter 9 of the User's Manual.

• I. Purpose of Floodway Determination

A. General

The evaluation of the impact of floodplain encroachments on water surface profiles
can be of substantial interest to planners, land developers, and engineers.

It is also a significant aspect of flood insurance studies (FIS).

B. FEMA Regulations

The Federal Emergency Management Administration (FEMA) is the administrator
of the National Flood Insurance Program (NFIP).

•
Communities participating in the NFIP must prevent undue development of the
floodplain that could cause a significant increase in potential flood damage.

Under certain rules, generally established by local ordinances, the floodplain can be
developed but cannot encroach on the "regulatory floodway".

1



C. Concepts of Floodway and Allowable Encroachment •

FEMA defines the floodway as "the channel of a river or other watercourse and the
adjacent land areas that must be reserved in order to discharge the base flood
without cumulatively increasing the water-surface elevation more than a designated
height."

The base flood used to determine the floodway is usually the 100 year flood.

FEMA sets the designated height (sometimes called surcharge) as 1.0 foot but local
agencies can specify a smaller, but not higher, height.

Floodways are determined by modeling encroachments at each cross section (from
both sides of the channel) such that the subsequent rise in the water surface
elevation, when compared to the un-encroached (natural) condition, is not more that
the designated height at any cross section.

The area between the floodway and 100 year floodplain is called the floodway
fringe.

D. General Procedure for Floodway Determination

The HEC-RAS floodway procedure is based on calculating a natural profile (existing
conditions geometry) as the first profile in a multiple profile run.

Other profiles, in a run, are calculated using various encroachment options.

Before performing an encroachment analysis, the user should have developed a
model of the existing river system.

This model should be calibrated to the fullest extent that is possible.

Verification that the model is adequately modeling the river system is an extremely
important step before attempting to perform an encroachment analysis.

2
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• II. Encroachment Methods

HEC-RAS contains five optional methods for specifying floodway encroachments.
How to implement each of these methods is discussed later. The Methods can be
changed at any cross section or profile.

A. Encroachment Method 1

With encroachment method 1, the user specifies the exact locations of the
encroachment stations for each individual cross section.

The encroachment stations can also be specified differently for each profile. An
examele of encroachment method 1 is shown in Figure 1.
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Figure 1. Example of Encroachment Method 1
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B. Encroachment Method 2 •
General

Method 2 utilizes a fIxed top width which can be specifIed separately for each cross
section.

The left and right encroachment stations are made equal distance from the centerline
of the channel, which is halfway between the left and right bank stations.

If the user specified top width resulting in an encroachment inside the channel, the
program sets that encroachment (left and/or right) to the channel bank station.

An example of encroachment method 2 is shown in Figure 2.
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Figure 2. Example of Encroachment Method 2 •
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• C. Encroachment Method 3

Description of Method

Method 3 calculates encroachment stations for a specified percent reduction in the
conveyance (% K Reduction) of the natural profile for each cross section.

One-half of the conveyance is eliminated on each side of the cross section (if
possible).

An example of encroachment method 3 is shown in Figure 3.
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Figure 3. Example of Encroachment method 3
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Limitations of Encroachments

The computed encroachments can not infringe on the main channel or any user
specified encroachment offsets (discussed later).

If one-half of the conveyance exceeds either overbank: conveyance, the program will
attempt to make up the difference on the other side.

If the percent reduction in cross section conveyance cannot be accommodated by
both overbank areas combined, the encroachment stations are made equal to the
stations of left and right channel banks (or the offset stations, if specified).

Procedure

Encroachment method 3 requires that the first profile (of a multiple profile run) must
be a natural (unencroached) profile.

•

Subsequent profiles (profiles 2-15) of a multiple profile run may be utilized for •
Method 3 encroachments.

A value of 10 percent for the second profile would indicate that 10 percent of the
conveyance based on the natural profile (first profile) will be eliminated - 5 percent
from each overbank.

Equal conveyance reduction of each overbank area is the default but can be changed
to the proportional conveyance reduction method.

Proportion Conveyance Reduction

An alternate, scheme to equal conveyance reduction is conveyance reduction in
proportion to the distribution of natural overbank conveyance.

For instance, if the natural cross section had twice as much conveyance in the left
overbank as in the right overbank, a 10 percent conveyance reduction value would
reduce 6.7 percent from the left overbank and 3.3 percent from the right overbank.

6
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• D. Encroachment Method 4

Description of Method

Method 4 computes encroachment stations so that conveyance within the encroached
cross section (at some higher elevation) is equal to the conveyance of the natural
cross section at the natural water level.

This higher elevation is specified as a fixed amount (target increase) above the
natural (e.g., 100 year) profile.

The encroachment stations are determined so that an equal loss of conveyance (at
the higher elevation) occurs on each overbank, if possible.

Limitations of Encroachments

•

•

If half of the loss cannot be obtained in one overbank, the difference will be made
up, if possible, in the other overbank, except that encroachments will not be allowed
to· fall within the main channel.

A target increase of 1.a indicates that a 1 foot rise will be used to determine the
encroachments based on equal conveyance.

Proportional Conveyance Reduction

An alternate scheme to equal conveyance reduction is to reduce conveyance in
proportion to the distribution of natural overbank conveyance.

See Method 3 for an explanation of this.

Differences Between Method 3 and 4

A key difference between Method 4 and method 3 is that the reduction in
conveyance is based on the higher water surface (target water surface) for method
4, while Method 3 uses the lower water surface (natural water surface).
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An example of a Method 4 encroachment is shown in Figure 4. •
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Figure 4. Example of Encroachment Method 4

E. Encroachment Method 5

Description of Method

Method 5 operates much like Method 4 except that an optimization scheme is used
to obtain the target difference in water surface elevation between natural and
encroached conditions.

A maximum of 20 trials is allowed in attempting a solution. •
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• General Procedure

Equal conveyance reduction is attempted in each overbank, unless this is not
possible (i.e., the encroachment goes all the way into the bank station before the
target is met).

The input data for Method 5 consists of a target water surface increase and/or a
target energy increase.

Procedure for Water Surface Target Only

The program will keep encroaching until the water surface target is met.

Procedure for Energy Target Only

The program will keep encroaching until the target energy is met.

• Procedure for Water Surface and Energy Targets

The program objective is to match the target water surface without exceeding the
target energy.

If this is not possible, the program will then try to find the encroachments that match
the target energy.

If neither of the criteria is met after 20 trials, the program will take the best answer
from all the trials and use it as the final result.

The target water surface and energy can be changed at any cross section, like
Methods 1 through 4.

•
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An example of method 5 is shown in Figure 5. •
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Figure 5. Example of Encroachment Method 5

F. Encroachment Offsets.

HEC-RAS also allows the user to establish a left and right offset.

The left and right offset is used to establish a buffer zone around the main channel
for further limiting the amount of the encroachments. •
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•

•

For example, if a user established a right offset of 5 feet and a left offset of 10 feet,
the model will limit all encroachments to 5 feet from the left bank station and 10 feet
from the right bank station.

If a use entered top width (Method 2) is within an offset, the program will set the
encroachment at the offset stationing.
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III. Bridge, Culvert, and Multiple Opening
Encroachments

A. General

Encroachments can be turned off at any bridge, culvert, or multiple openings.

The default methodology for encroachments at bridges, culverts, and multiple
openings is to use the downstream computed encroachments and project them
through the structure and to the cross section just upstream of the structure (the
program does this automatically).

B. Using Method 1 for Openings

When using Method 1, the user can enter separate encroachment stations
downstream of the structure, inside the structure, and upstream of the structure.

Only one set of encroachments can be entered for inside of the structure.

c. Methods 2 through 5 for Openings

For encroachment Methods 2 through 5, the program will allow for separate
encroachment calculations at a bridge when using the energy based bridge
computation method.

For all other bridge computation methods (Momentum, Yarnell, Contracted
Opening, Pressure Flow, Pressure and Weir Flow, and Low Flow and Weir Flow)
the program will use the tomputed downstream encroachments through the bridge
and at the cross section just upstream.

At a culvert crossing or a multiple opening, when using encroachment Methods 2
through five, the program will always use the computed downstream encroachments
through the structure and just upstream of the structure.

The only way to override this is to use Method 1 encroachments.

12
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• IV. Entering Floodway Encroachment Data

A. General

Within HEC-RAS, the data for performing a floodway encroachment analysis are
entered from the Steady Flow Analysis window.

Encroachment information is not considered as permanent geometry or flow data,
and therefore saved as part of the existing Plan data.

B. Getting Into the Encroachment Option

To bring up the floodway encroachment data window, select the Encroachments
option from the Options menu of the Steady Flow Analysis window.

•

•

An Encroachment window will appear as shown in Figure 6 (except yours will be
blank when you first bring it up).

There are several pieces of data that the user must supply for an encroachment
analysis.

The encroachment analysis can only be performed for profiles 2 through 15 (or what
ever number has been set by the user in the flow data editor.

Encroachments are not performed on profile one because most of the encroachment
methods rely on having a base profile for comparison.
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Figure 6. Floodway Encroachment Data Editor

The data for an encroachment analysis should be entered in the following manner:

c. Global Information

Global information are data that will be applied at every cross section for every
profile computed.

Equal Conveyance Reduction

The first piece of global information is the Equal Conveyance Reduction selection
box at the top of the Encroachment data editor window.

Equal conveyance reduction applies to encroachment Methods 3, 4, and 5.

14
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•

•

•

If this option is turned off, the program will encroach by trying to maintain a loss
in conveyance in proportion to the distribution of natural overbank conveyance.

The default is to have equal conveyance reduction turned on.

Offsets

The second item under global information, is the Left bank offset and the Right
bank offset.

The left and right offset is used to establish a buffer zone around the main channel
for further limiting the amount of the encroachments.

For example, if a user established a right offset of 5 feet and a left offset of 10 feet,
the model will limit all encroachments to 5 feet from the left bank station and 10 feet
from the right bank station.

The default is to have no left or right offset which would allow the encroachments
to go up to the main channel bank stations, if necessary.

D. Reach and River Station Selection Boxes

The next piece of data for the user to select is the reach III which to enter
encroachment data.

The user is limited to seeing one reach at a time on the encroachment data editor.

Once a reach is selected, the user can then enter a Starting and Ending River
Station to work on.

By default, the program selects all the sections in the reach. The user can change
this to any range of cross sections within the reach.
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E. Profile

Next, the user must select a profile number to work on.

Profiles are limited to 2 though the maximum number set in the currently opened
flow data (e.g. 2 through 4, if the user has set 4 profiles in the flow data editor).

The user can not set encroachments for profile 1.

F. Method and Target Values

The next step is to enter the desired encroachment method to be used for the
currently selected profile.

Once a method is selected, the data entry boxes that corresponds to that method will
show up below the method selection box.

•

Some of the methods require only one piece of data, while others require two. •

The user should then enter the required information that corresponds to the method
that they have selected.

For example, if the user selects encroachment method 4, only one piece of
information is required, which is the target change in water surface elevation.

G. Set Selected Range

Once the encroachment method is selected, and its corresponding data are entered,
the user should press the Set Selected Range button.

Pressing this button will fill in the table below with the selected range of river
stations; the selected method; and the corresponding data for the method.

Note that, if the selected method only has one data item, that method's data will go
under the Value 1 column of the table. •
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If the selected method has two data items, the first goes into the Value 1 column and
the second goes into the Value 2 column.

Once the data is put into the table, the user can change the method and
corresponding data values directly from the table.

F. Completion of Data Entry

At this point the user should repeat these tasks until all of the encroachment data are
entered (i.e. for all the reaches and locations in the model, as well as all of the
profiles for which the user wants to perform the encroachment analysis).

Press the OK button and the data will be applied and the window will close.

To save the data to the hard disk, the user should either select Save Project from
the File menu of the main HEC-RAS window, or select Save Plan from the File
menu of the Steady Flow Analysis window.

G. Additional Options

The Set All Reaches option allows the user to set the selected method and
corresponding data for all reaches and locations in the model (all cross sections,
bridges, culverts, etc .. ).

This is a quick way to start a preliminary encroachment analysis without having to
enter a lot of data.

The Import Method 1 option, allows the user to transfer the computed
encroachment stations from a previous run to the input data for a future run.

For example, if the user performs a preliminary encroachment analysis using any
of the Methods 2 through 5, they may want to convert the results from one of the
runs to a Method 1 encroachment method.

The import of encroachment stations IS limited to the results of a single
encroachment profile for each reach.
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V. Performing The Floodway Encroachment Analysis •

A. General Procedure

The HEC-RAS floodway procedure is based on calculating a natural profile (no
encroachments) as the first profile of a multiple profile run.

Subsequent profiles are calculated with the various encroachment options available in
the program.

B. Initial Trials

When performing a floodway analysis, encroachment methods 4 and 5 are nonnally
used to get a first cut at the encroachment stations.

Recognizing that the initial floodway computations may provide changes in water
surface elevations greater, or less, than the "target" increase, initial computer runs are •
usually made with several "target" values.

The initial computer results should then be analyzed for increases in water surface
elevations, changes in velocities, changes in top width, and other parameters.

Also, plotting the results with the X-Y-Z perspective plot, or onto a topo map, is
recommended.

From these initial results, new estimates can be made and tested.

c. Refinements Using Method 1

After a few initial runs, the encroachment stations should become more defined.

Because portions of several computed profiles may be used, the final computer runs are
usually made with encroachment Method 1 defining the specific encroachment stations
at each cross section.
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Additional runs are often made with Method 1, allowing the user to adjust
encroachment stations at specific cross sections to further define the floodway.

D. Obtaining easonable Encroachment Alignments

While the floodway analysis generally focuses on the change in water surface elevation,
it is important to remember that the floodway must be consistent with local
development plans and provide reasonable hydraulic transitions through the study
reach.

Sometimes the computed floodway solution, that provides computed water surfaces at
or near the target maximum, may be unreasonable when transferred to the map of the
actual study reach.

If this occurs, the user may need to change some of the encroachment stations, based
on the visual inspection of the topo map and the floodway computations re-run with the
new encroachment stations to ensure that the target maximum is not exceeded.
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VI. Viewing the Floodway Encroachment Results •

A. Cross Section Plots

An example cross section plot is shown in Figure 7.
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Figure 7. Example Cross Section Plot With Encroachments

As shown in' Figure 7, the encroachments are plotted as outlined blocks.

In this example, the water surface profile for the base run (first profile) is plotted
along with one of the encroached profiles.

The user can plot as many profiles as they wish, but it may become a little confusing •
with several sets of encroachments plotted at they same time.
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• B. X-Y-Z Perspective Plots

Another type of graphic that can be used to view the encroachments is the X-y-z
perspective plot, as shown in Figure 8.
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Figure 8. Example X-Y-Z Perspective Plot with
Base and Encroached Profiles

In this example, the base profile (profile 1) as well as one of the encroached profiles
is plotted at the same time over a range of cross sections.

This type of plot allows the user to get a reach view of the floodway encroachment
and quickly see if the encroachments transition smoothly or if they are erratic.
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D. Encroachment Tables

Encroachment results can displayed in tabular mode from the Profile Output Tables.

Select Profile Table from the View menu of the main HEC-RAS window.

When the table comes up, the user can select from three different pre-defined
encroachment tables.

Encroachment Table 1

To display Encroachment table 1, select Encroachment 1 from the Std. Tables
menu on the Profile table window.

The table shows the basic encroachment results of:

•

1) computed water surface elevation

2) change in water surface from the base profile •
3) computed energy

4) top width of the active flow area

5) flow in the left overbank, main channel, and right overbank

6) left encroachment station

7) station of the left bank of the main channel

8) station of the right bank of the main channel

9) right encroachment station

An example output is shown in Figure 9.
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Figure 9. Example of the Encroachment 1 Standard Table

Encroachment Table 2

Encroachment 2 table provides some additional information that is often used when
plotting the encroachments onto a map.

This table includes:

1) ~hange in water surface elevations from the first profile

2) top width of the active flow area

3) percentage of conveyance reduction in the left overbank

• 4) left encroachment station
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5) distance from the center of the main channel to the left encroachment •6) station of the center of the main channel

7) distance from the center of the main channel to the right encroachment

8) right encroachment station

9) percentage of conveyance reduction in the right overbank

An example of the Encroachment 2 standard table is shown in Figure 10.
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Figure 10. Example of the Encroachment 2 Standard Table
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Encroachment Table 3

The last encroachment table, Encroachment 3, provides the minimum floodway data
for reporting, and as shown in Figure 11, includes:

1) active flow top width

2) flow area (including any ineffective flow area)

3) average velocity of the entire cross section

4) computed water surface elevation

5) base water surface elevation (profile 1)

6) change in water surface from the first profile.
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HEC-RAS Workshop 5

Floodway Encroachment

Objective: Show how to set up an existing condition plan, encroachment plans, and
developing a defensible floodway that meet regulatory requirements.

1. Introduction

An HEC-RAS model of North Buffalo Creek has been developed and set up to run
the 100 year flood, which is 8,000 cfs.

A FEMA floodway study must be conducted to establish a floodway by
encroachment analysis.

The important guidelines are:

A. Establish the maximum encroachment limits.

B. Elevation difference between the existing and encroached condition
(surcharge) cannot exceed 1.0 feet at any cross section in the model.

C. The final floodway alignment must be reasonable and have "smooth"
transitions from one cross section to another. The maximum expansion
rate should be about 1 to 3 or 4 and the maximum contraction rate should
be about 1 to 1.

2. Modeling Conditions

A. The 100 year flood, 8,000 cfs is to be analyzed and its starting water
surface elevation is 698.3 feet

B. The encroachment profile is to use the same discharge but its starting
water surface elevation is 699.3 (l foot higher).
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C. Equal Conveyance Reduction method is to be used.

D. Method 4 or 5 are to be used for optimization but the final run is to use
Method 1.

E. Start with seven total profiles ("scatter gun" approach): natural
condition, Method 4 and Method 5 with targets of 0.8, 1.0, and 1.2 feet.

F. Change Methods (between 4 and 5) and targets throughout the reach as
necessary to maximize the surcharge but still meet the guidelines above.

3. Getting into the Existing Conditions Model

The existing conditions model of North Buffalo Creek is in the Workshp5
subdirectory off of the c: root directory and is named workshp5.prj.

•

From the main HEC-RAS menu, enter the flow data screen, enter 7 for number of
profiles, enter 8000 cfs for the 7 discharges, and enter 698.3 feet for the starting
water surface elevation of the first profile and 699.3 feet for the remaining 6
discharges.

4. Setting up the Flow Data •
Save the flow data as another file titled" 100 Yr. Discharge, 7 profiles".

s. Setting Encroachment Methods and Targets

From the Steady Flow screen, set up a plan using the new flow data and save it with
the title "Floodway Encroachment Analysis".

Click on Options, then Encroachments.

For profile 2, select Method 4, use a target of 0.8, and then click Set All Reaches .
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This will set Method 4 and 0.8 foot target for all cross sections.

So the same for profile 3 with a target of 1.0 feet and for profile 4 with a target of
1.2 feet.

Repeat for profile 4 through 7 but use Method 5 and do not enter a value for the
energy grade target.

6. Running the Profiles and Examining the Output

Click on Compute, get into the profile output screen from the main HEC-RAS
screen, click on Std. Tables, and then on Encroachment 1. Make sure to request
all profiles and only the Floodway Encroachment Plan from the Options menu.

7. First Adjustments Using Method 4 and 5

From the output, it appears that Method 5, up to cross section 36950, works the
best, i. e., surcharge is close to 1.0 for most of the cross sections.

For now, if the surcharge is slightly off of 1.0, accept it and go on since they can
be adjusted later when using Method 1. If the surcharge is much different from 1.0
(say less than 0.9 and greater than 1.1), then change the target or change methods.

Go back to the encroachment screen.

For profile 2, click on Start Riv Sta and set it to 36950.

Change to Method 5 with 1.0 foot as the WS target, and press the Set Selected
Range button. For the other profiles, simply select each profile, press the Set
Selected Range button and the information will be automatically applied.

This will set the reach from the downstream boundary to cross section 36200 at
Method 5 with a 1.0 foot target. Upstream of cross section 36200, we are still
trying the different targets with the two Methods (scatter gun approach).

3



8. Second Adjustments Using Method 4 and 5 •The results at the bridge are not very encouraging. Note: encroachments at bridges
are often hard to model, especially if weir and/or pressure flow is involved.

Select the best method and target through the bridge and use the same scatter gun
approach for the cross sections upstream of the bridge.

Continue in the upstream direction until you are finished.

When finished, view the results utilizing the cross section plots as well as the X-Y-Z
plots to assure that the floodway alignment is acceptable (smooth transitions).

If an expansion is too abrupt, either reduce the target at the upstream end or increase
the target at the downstream end. The converse should be done for a contraction.

9. Transforming the Results to Method 1

After you are generally satisfied with your encroachment analysis, you should have •
the same results for all the profiles if you continue using the method outlined above.

Weare now ready to put the results into Method 1 but we should retain the
optimization Methods and targets we used so that we can demonstrate to the
reviewer the basis for Method 1.

From the encroachment screen, push the Import to Method 1 button. Select any
of the profiles and tell the program to put the Method 1 results to profile 3.

10. Setting Up to Opt~mize Using Method 1

Since we are using your Method 4 and 5 optimization for profile 2 and Method 1 for
profile 3, we do not need the other profiles.

Enter the Flow Data screen and change the numbers of profiles to 3.

•
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• 11. Optimizing Method 1

Return to the Simulation screen and execute.

Make sure that the results of profile 2 and profile 3 are essentially the same.

Adjust the encroachment stations for Method 1 to refine the floodway yet keeping
the surcharge less than 1 foot.

12. Questions

1. In the optimization using Methods 4 and 5, why are the encroachment stations
of the cross sections upstream and downstream of the bridge the same as at
the bridge?

• 2. If you used Method 5 with 1.0 feet energy surcharge limit in addition to what
was used for the water surface surcharge, what would be the general effects
on the width of the floodway?

•

3. How could we have "manipulated" the floodway to the left or right but still
use the equal conveyance reduction rules? Hint: What adjustments to the
existing condition model?

4. For the first optimization run with the "scatter gun" approach, why did the
program llQ1 encroach to the left beyond station 508 at cross section 29900.
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HEC-RAS Workshop 5

Floodway Encroachment

Solutions

1. Final Methods and Targets Used

The following is the optimized Methods and targets used by cross section.

Note that you answer may not be the same but may be just as defensible.

•

The results were imported to Method 1.

Cross Sections Method Target. Ft.

29900 to 36200 5 1.0 •
36950 4 1.0

36975 to 37200 4 1.2

40150 to 40800 5 1.0

2. Answers to Questions

1. In the optimization using Methods 4 and 5, why are the encroachment stations
of the ~ross sections upstream and downstream of the bridge the same as at
the bridge?

•
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• 2. If you used Method 5 with 1.0 feet energy surcharge limit in addition to what
was used for the water surface surcharge, what would be the general effects
on the width of the floodway?

•

•

3. How could we have "manipulated" the floodway to the left or right but still
use the equal conveyance reduction rules? Hint: What adjustments to the
existing condition model?

4. For the first optimization run with the "scatter gun" approach, why did the
program llQ1 encroach to the left beyond station 508 at cross section 29900.

7



• • •
3. Result of Method 4 and 5 with Natural, 0.8, 1.0, and 1.2 feet Target Profiles

RAS Plan: Encroached Reach: Buffalo Cr. 2/24/96 12:12:36 PM

River Sta. W.S. Prof Delta E.G. E1ev Top Wdth Q Left QChannel QRight Enc Sta L Ch Sta L Ch Sta R Enc Sta R
E1ev WS Act

(ft) (ft) (ft) (ft) (cfs) (cfs) (cfs) (ft) (ft) (ft) (ft)

40800 712.11 712.87 218.91 215.72 5952.09 1832.19 95.00 145.00

40800 713.18 1.07 713.98 118.84 6310.99 1689.01 95.00 95.00 145.00 213.84

40800 713.39 1.28 714.21 110.81 6461.20 1538.80 95.00 95.00 145.00 205.81

40800 713.57 1.46 714.44 103.28 6615.21 1384.79 95.00 95.00 145.00 198.28

40800 714.78 2.67 716.08 50.00 8000.00 95.00 95.00 145.00 145.00

40800 714.87 2.75 716.15 50.00 8000.00 95.00 95.00 145.00 145.00

40800 713.94 1.83 714.54 148.73 99.19 5930.07 1970.74 88.11 95.00 145.00 236.84

40150 710.97 711.49 248.39 249.41 5641.06 2109.53 95.00 145.00

40150 711.81 0.83 712.34 131.36 5882.93 2117.07 95.00 95.00 145.00 226.36

40150 712.01 1.03 712.56 124.66 6005.38 1994.62 95.00 95.00 145.00 219.66

40150 712.18 1.21 712.76 118.26 6131.47 1868.53 95.00 95.00 145.00 213.26

40150 714.43 3.46 714.76 164.03 188.49 5445.00 2366.51 83.02 95.00 145.00 247.06

40150 714.51 3.54 714.84 161.30 166.20 5474.31 2359.49 84.32 95.00 145.00 245.63

40150 712.14 1.16 713.07 76.01 7255.27 744.73 95.00 95.00 145.00 171.01
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37200 708.82 708.96 467.15 1592.75 4702.94 1704.32 180.00 250.00

37200 709.36 0.54 709.53 272.81 1361.11 5092.45 1546.44 87.83 180.00 250.00 360.63
37200 709.57 0.75 709.74 258.90 1301.25 5182.77 1515.98 94.66 180.00 250.00 353.55
37200 709.73 0.91 709.91 246.21 1238.98 5277.76 1483.26 101.02 180.00 250.00 347.23

37200 711.06 2.24 711.58 70.00 8000.00 180.00 180.00 250.00 250.00

37200 711.17 2.36 711.69 70.00 8000.00 180.00 180.00 250.00 250.00
37200 709.85 1.04 710.01 272.25 1409.18 5043.92 1546.91 85.82 180.00 250.00 358.06

37000 708.71 708.86 465.01 1585.46 4720.80 1693.73 180.00 250.00

37000 709.19 0.48 709.41 221.17 1198.63 5545.95 1255.43 105.58 180.00 250.00 326.75
37000 709.38 0.67 709.62 205.32 1115.30 5699.93 1184.77 113.31 180.00 250.00 318.64

37000 709.53 0.82 709.78 191.26 1030.23 5855.28 1114.48 120.33 180.00 250.00 311.59

37000 710.74 2.03 711.28 70.00 8000.00 180.00 180.00 250.00 250.00
37000 710.86 2.15 711.39 70.00 8000.00 180.00 180.00 250.00 250.00

37000 709.60 0.89 709.88 171.39 955.61 6123.71 920.68 127.00 180.00 250.00 298.39

36975 BU 708.71 708.86 180.00 250.00

36975 BU 709.19 0.48 709.41 105.58 180.00 250.00 326.75

36975 BU 709.38 0.67 709.62 113.31 180.00 250.00 318.64

36975 BU 709.53 0.82 709.78 120.33 180.00 250.00 311.59

36975 BU 710.74 2.03 711.28 180.00 180.00 250.00 250.00

36975 BU 710.86 2.15 711.39 180.00 180.00 250.00 250.00

36975 BU 709.60 0.89 709.88 127.00 180.00 250.00 298.39
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36975 BD 708.38 708.86 180.00 250.00

36975 BD 708.58 0.20 709.41 105.58 180.00 250.00 326.75

36975 BD 708.72 0.34 709.62 113.31 180.00 250.00 318.64

36975 BD 708.83 0.45 709.78 120.33 180.00 250.00 311.59

36975 BD 709.37 0.99 711.07 180.00 180.00 250.00 250.00

36975 BD 709.45 1.07 711.17 180.00 180.00 250.00 250.00

36975 BD 708.86 0.49 709.88 127.00 180.00 250.00 298.39

36950 705.99 706.27 416.47 1356.90 5289.64 1353.46 180.00 250.00

36950 706.86 0.87 707.19 221.17 1087.85 5771.25 1140.90 105.58 180.00 250.00 326.75

36950 707.20 1.21 707.53 205.32 1023.45 5883.95 1092.60 113.31 180.00 250.00 318.64

36950 707.40 1.41 707.74 191.26 950.31 6013.55 1036.14 120.33 180.00 250.00 311.59

36950 706.74 0.74 707.59 70.00 8000.00 180.00 180.00 250.00 250.00

36950 706.97 0.98 707.81 70.00 8000.00 180.00 180.00 250.00 250.00

36950 707.20 1.21 707.60 171.39 870.55 6274.73 854.72 127.00 180.00 250.00 298.39

36200 705.10 705.40 402.02 1449.29 3974.26 2576.45 230.00 270.00

36200 705.99 0.88 706.33 189.03 1179.45 4292.43 2528.11 182.64 230.00 270.00 371.67

36200 706.35 1.25 706.70 179.88 1111.66 4364.98 2523.36 187.08 230.00 270.00 366.96

36200 706.55 1.45 706.91 171.73 1040.31 4450.33 2509.36 191.06 230.00 270.00 362.79

36200 705.92 0.82 706.20 230.54 1420.72 3977.12 2602.16 161.44 230.00 270.00 391.99

36200 706.10 1.00 706.41 203.24 1303.47 4152.39 2544.13 174.14 230.00 270.00 377.38

36200 706.29 1.19 706.67 168.66 1079.41 4495.34 2425.25 189.71 230.00 270.00 358.38

35100 703.80 704.11 325.03 435.42 3539.32 4025.26 115.00 150.00

35100 704.73 0.93 705.07 235.41 4.49 3819.14 4176.37 114.24 115.00 150.00 349.65

35100 705.08 1.28 705.35 224.45 3498.58 4501.42 115.00 115.00 150.00 339.45
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35100 705.27 1.46 705.55 214.62 3573.42 4426.58 115.00 115.00 150.00 329.62
35100 704.62 0.81 704.90 234.11 3476.47 4523.53 115.00 115.00 150.00 349.11
35100 704.83 1.02 705.10 234.12 3442.00 4558.00 115.00 115.00 150.00 349.12
35100 705.04 1.23 705.29 234.12 3409.06 4590.94 115.00 115.00 150.00 349.12

33700 702.25 702.47 466.90 2092.02 3490.84 2417.13 245.00 285.00
33700 703.24 0.99 703.49 305.99 1928.70 3741.17 2330.14 124.52 245.00 285.00 430.52
33700 703.41 1.16 703.67 290.38 1877.88 3823.73 2298.39 131.93 245.00 285.00 422.31
33700 703.58 -1.33 703.85 276.42 1826.76 3905.96 2267.28 138.84 245.00 285.00 415.26
33700 703.04 0.79 703.25 356.99 2065.10 3472.92 2461.98 100.04 245.00 285.00 457.03
33700 703.24 1.00 703.47 327.05 2004.96 3604.89 2390.16 114.68 245.00 285.00 441.73
33700 703.45 1.20 703.69 300.72 1930.33 3736.18 2333.49 126.76 245.00 285.00 427.48

29900 698.30 698.51 526.75 3945.98 3733.96 320.06 460.00 508.00
29900 699.30 1.00 699.50 340.57 4202.50 3797.50 167.43 460.00 508.00 508.00
29900 699.30 1.00 699.52 322.40 4079.52 3920.47 185.60 460.00 508.00 508.00
29900 699.30 1.00 699.54 305.49 3957.38 4042.62 202.51 460.00 508.00 508.00
29900 699.30 1.00 699.50 340.57 4202.50 3797.50 167.43 460.00 508.00 508.00
29900 699.30 1.00 699.52 322.40 4079.52 3920.47 185.60 460.00 508.00 508.00
29900 699.30 1.00 699.54 305.49 3957.38 4042.62 202.51 460.00 508.00 508.00
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4. Final With Method 1

RAS Plan: Encroached Reach: Buffalo Cr. 2/24/96 6:16:08 PM

River Sta. W.S. Elev Prof Delta E.G. Elev Top Wdth Q Left QChannel Q Right Enc Sta L Ch Sta L Ch Sta R Enc Sta R
. WS Act

(ft) (ft) (ft) (ft) (cfs) (cfs) (cfs) (ft) (ft) (ft) (ft)

40800 712.11 712.87 218.91 215.72 5952.09 1832.19 95.00 145.00

40800 713.11 1.00 713.85 139.34 22.07 6140.95 1836.97 92.69 95.00 145.00 232.03

40800 713.07 0.96 713.69 155.00 5767.37 2232.63 95.00 95.00 145.00 250.00

40150 710.97 711.49 248.39 249.41 5641.06 2109.53 95.00 145.00

40150 711.98 1.01 712.47 139.25 5722.02 2277.98 95.00 95.00 145.00 234.25

40150 711.97 1.00 712.46 155.00 63.79 5753.25 2182.96 90.00 95.00 145.00 245.00

37200 708.82 708.96 467.15 1592.75 4702.94 1704.32 180.00 250.00

37200 709.46 0.64 709.65 246.21 1229.38 5301.14 1469.48 101.02 180.00 250.00 347.23

37200 709.50 0.68 709.73 208.00 1329.78 5652.94 1017.29 100.00 180.00 250.00 308.00

37000 708.71 708.86 465.01 1585.46 4720.80 1693.73 180.00 250.00

37000 709.28 0.57 709.52 205.32 1111.70 5707.13 1181.17 113.31 180.00 250.00 318.64

37000 709.34 0.63 709.59 195.00 1022.30 5824.58 1153.12 120.00 180.00 250.00 315.00

36975 708.71 708.86 180.00 250.00
BU

36975 709.28 0.57 709.52 113.31 180.00 250.00 318.64
BU

36975 709.34 0.63 709.59 120.00 180.00 250.00 315.00
BU
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36975 708.38 708.86 180.00 250.00
BD

36975 708.65 0.27 709.52 113.31 180.00 250.00 318.64
BD

36975 708.68 0.31 709.59 120.00 180.00 250.00 315.00
BD

36950 705.99 706.27 416.47 1356.90 5289.64 1353.46 180.00 250.00
36950 706.91 0.92 707.26 205.32 1008.56 5913.82 1077.62 113.31 180.00 250.00 318.64
36950 706.90 0.91 707.27 195.00 926.87 6021.92 1051.21 120.00 180.00 250.00 315.00

36200 705.10 705.40 402.02 1449.29 3974.26 2576.45 230.00 270.00
36200 706.10 1.00 706.41 203.24 1303.47 4152.39 2544.13 174.14 230.00 270.00 377.38
36200 706.10 1.00 706.40 210.00 1354.15 4097.05 2548.80 170.00 230.00 270.00 380.00

35100 703.80 704.11 325.03 435.42 3539.32 4025.26 115.00 150.00
35100 704.83 1.02 705.10 234.12 3442.00 4558.00 115.00 115.00 150.00 349.12
35100 704.71 0.91 705.13 211.00 7.57 4078.27 3914.16 114.00 115.00 150.00 325.00

33700 702.25 702.47 466.90 2092.02 3490.84 2417.13 245.00 285.00
33700 703.24 1.00 703.47 327.05 2004.96 3604.89 2390.16 114.68 245.00 285.00 441.73
33700 703.24 1.00 703.47 327.05 2004.89 3604.92 2390.19 114.68 245.00 285.00 441.73

29900 698.30 698.51 526.75 3945.98 3733.96 320.06 460.00 508.00
29900 699.30 1.00 699.52 322.40 4079.52 3920.47 185.60 460.00 508.00 508.00
29900 699.30 1.00 699.52 322.40 4079.54 3920.46 185.60 460.00 508.00 508.00
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5. Final Profile X-Y-Z Plot

Develop. Solutions Plan: Floodway Encroachment Analysi
Reach = Buffalo Cr. Riv Sta = 40800 to 29900 PF#: 3

I
I

I
I

I
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• HEC-RAS, River Analysis System

Trouble Shooting with HEC-RAS

Presented by
David T. Williams, Ph.D., P.E.

WEST Consultants, Inc., Carlsbad, CA

Note: This lecture is derived from Chapter 10 of the HEC-RAS User's Manual.

• A. General

I. Introduction

•

The HEC-RAS software is designed to continue its computations all the way through
completion, even when the user has entered poor data.

The fact that the program executes a complete run does not necessarily mean that the
results are good.

The user must carefully review the results to ensure that they adequately represent
the study reach and that they are reasonable and consistent.

The HEC-RAS software is an engineering tool, it is by no means a replacement for
sound engineering.
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B. Description of Lecture Contents

The HEC-RAS software contains several features to assist the user III the
development of a model; debugging problems; and the review of results.

These features include: built in data checking; an Errors, Warnings, and Notes
system; and a computational Log Output file.

The user can use the graphical and tabular output to review the results and check the
data for reasonableness and consistency.

II. Built in Data Checking

A. General

The HEC-RAS user interface has two types of built-in data checking.

The first type of data checking is performed as the user enters the data.

Each data field of the data entry editors has some form of data checking.

The second type of data checking occurs when the user starts the steady flow
computations.

When the user presses the Compute button in the Steady Flow Analysis window,
the entire data set is processed through several data checks before the computations
are processed.

B. Checking the Data as it is Entered

This type of data checking occurs whenever the user enters data into a single data
field or table.

•

•

Once the user leaves a particular data entry field or table, the program will •
automatically check that data for reasonableness.
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• The following is a list of some of the types of data checks that are performed:

1. Minimum and maximum range checking for variables.

2. Alpha and numeric data checks to ensure that the right type of data is
entered in each field.

3. Increasing order of station for cross sections, bridge deck/roadway, and
abutments.

4. Data consistency checks (i.e., when the main channel bank stations are
entered, the program checks to see if they exist in the cross section
station and elevation data).

5. Data deletion warnings where if data is to be deleted, HEC-RAS will
give a warning before it is deleted.

•
6. File management warnings (i.e., HEC-RAS will give you a chance to

save the data to the hard disk before the program is closed, or a
different data set is opened).

•

7. Data geometry checks (i.e., when a bridge deck/roadway is entered,
the program checks to ensure that the deck/roadway intersects with the
ground data).

C. Data Checking Before Computations are Performed

The second type of data checking is performed to evaluate the completeness and
consistency of the data and occurs before the computations take place.

When the user presses the Compute button on the Steady Flow Analysis window,
the program will perform a series of data checks before the computations are
allowed to proceed.

If any data errors are found, the program will not perform the computations.

3



The following is a list of some of the types of checks that are made during the •
computations:

1. Data completeness

These data checks insure that all of the required data exists for the
entire data set.

If any missing data are found, a complete list of all the missing data
and their specific locations is displayed on the screen.

An example of this is shown in Figure 1.

p--~-,--=-:-:;--- -:-:---- - -----------~~~~
I; ~ <~ j \' ~t~j "/~ ;.~~1?,. ,i~·(:'''~lt~~/lr~l-!lU~1~~(/?~'~ '~"i G~~_. _ ~__ ~ .. ~ _ . _~~;~~~J

- ',_~ •• ,~. • __ •••.....--., A • ~ • ..t. "" - l.=_~~......>............. '

:::..I.r.!~9..'IlP..!.~!~..q.~1~Lq.!!.J3.E.!ac..!:I_.~~.J..~.~ ..~LI3.!Y..~r. ::;J~!i.Q.r:!.:.J"? __ _ _ .
- Channel Manning's n value not set

- Incomplete data on Reach" 1" at River Station: 11
- Coefficient of Expansion not set

- Incomplete data on Reach" 1" at River Station: 10
- Main channel length not set

Zero or Undefined Flow VflIues on Reach: 1 Prof # 2

Figure 1. Data Completeness Checking Window

2. Data consistency

)'his type of data checking is performed to ensure that the data IS

consistent with the computations that are being requested.

For example, if the user asks to perform a mixed flow regime
computation, the program checks to ensure that upstream as well as
downstream boundary conditions have been specified.
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•

For example, if an encroachment analysis is requested, the program
checks to ensure that the number of profiles lines up with the number
specified in the encroachment data.

There are several other checks of this type.

III. Errors, Warnings, and Notes

A. General

The HEC-RAS software has a system of Errors, Warnings, and Notes that are
passed from the steady flow computation program to the user interface.

During the computations, the steady flow computation program will set flags for at
a particular node (nodes are cross sections, bridges, culverts, or multiple openings)
whenever it is necessary.

These message flags are written to the standard output file, along with the computed
results for that node.

When the user interface reads the computed results from the output file, if any
errors, warnings, or notes exist, they are interpreted and displayed in various
locations from the interface.

B. Requesting/Viewing Errors, Warnings and Notes

The user can request a summary of all the errors, warnings, and notes by selecting
Summary E~rors, Warnings, and Notes from the View menu on the main HEC­
RAS window.

Once this is selected, a window will pop up displaying all of the messages.

The user has the options of expanding the window; printing the messages; or sending
them to the windows clipboard.
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An example of the Errors, Warnings, and Notes window is shown in Figure 2.

Reach: 1 Riv Sta: 2 Profile: 1
Wflr·n·in·g··~·-6Tvi·(fe(ffl"o·w··co·m-p·u·teii··io·r"thi's"'cr'oss'~s'e'ctio'n':"""""""""""""'" -............................... .
Warning - The energy loss was greater than 1.0 ft (0.3 m). between the current and previous
cross section. This may indicate the need for additional cross sections.

Reach: 1 Riv Sta: 3 Profile: 1
Warning - The energy equation could not be balanced within the specified number of iterations.
The program used critical depth for the water surface and continued on with the calculations.
Warning - Divided flow computed for this cross-section.
Warning - The velocity head has changed by more than 0.5 ft (0.15 m). This may indicate the
need for additional cross sections.

Figure 2. Summary of Errors, Warnings, and Notes Window

When a specific cross section or hydraulic structure is being displayed, any errors,
warnings, or notes that were set at that location, for the displayed profile, will show
up in the message box at the bottom of the table as shown in Figure 3.

Figure 3. Cross Section Table with Errors, Warnings, and Notes
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• C. ERRORS

Error messages are only sent when there are problems that prevent the program
from being able to complete the run.

D. WARNINGS

Warning messages provide information to the user that mayor may not require
action on the user's part.

In general, whenever a warning is set at a location, the user should review the
hydraulic results at that location to ensure that the results are reasonable.

If the hydraulic results are found to be reasonable, then the message can be ignored.

•

•

In many instances, a warning level message may require the user to take some action
that will cause the message to disappear on future runs.

Many of the warning messages are caused by either inadequate or bad data. Some
common problems that cause warning messages to occur are the following:

Cross sections spaced too far apart

This can cause several warning messages to be set.

Cross sections starting and ending stations not high enough

If a computed water surface is higher than either end point of the cross section, a
warning message will appear.

Bad Starting Water Surface Elevation

If the user specifies a boundary condition that is not possible for the specified flow
regime, the program will take action an set an appropriate warning message.

7



Bad Cross Section Data

This can cause several problems, but most often the program will not be able to
balance the energy equation and will default to critical depth.

E. NOTES

Note level messages are set to provide information to the user about how the
program is performing the computations.

IV. Log Output

A. Log File Output Level

General

This option allows the user to set the level of the Log file.

The Log file is a file that is created by the computational program and contains
information tracing the program process.

Log levels can range between 0 and 10, with 0 resulting in no Log output and 10
resulting in the maximum Log output.

In general, the Log file output level should not be set unless the user gets an error
during the computations.

If an error occurs in the computations, set the log file level to an appropriate value,
re-run the computations, review the log output, and try to determine why the
program got an error.

8
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• Setting the Log File Output Level

When the user selects Set Log File Output Level, a window will appear as shown
in Figure 4.

Fall Cr.
Fall Cr.

RS=10
RS= 9.8

LL= 4
LL= 6

PF = 1
PF = 3

•

•

Figure 4. Log File Output Level window

The user can set a "Global Log Level", which will be used for all cross sections and
every profile.

Setting Log Levels for Specific Locations and Profiles

In general, it is better to set the log level only at the locations where problems are
occurring in the computations.

To set the sp~cific location log level, first select the desired reach and river station
and then select the log level and the profile number (the log level can be turned on
for all profiles).

Once everything is set, press the Set button and the log level will be displayed in the
window below.

9



Log levels can be set at several locations individually.

Once all of the Log Levels are set, press the OK button to close the window.

Warning !!! - setting the global log output level to 4 or 5 can result in very
large log file output. Global log level values of 6 or larger can result in
extremely large log files.

B. Viewing The Log File

This option allows the user to view the contents of the log file by using the Windows
Write program.

If the user sets a font in the Windows Write program that uses proportional spacing,
the information in the log file will not line up correctly; therefore, it is
recommended to use non-proportional fonts such as: Line Printer; Courier (8 pt.);
and Helvetica (8 pt.).

V. Reviewing and Debugging the Normal Output

A. General

After the user has successfully completed a run, and reviewed all the errors,
warnings, and notes, the normal output should be reviewed for consistency and
reasonableness.

B. Viewing Graphics

In general, the graphical output should be used as much as possible to get a quick
view of the results.

10
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• Cross Section Plots

The user should look at all of the cross sections with the cross section plotting
capability .

The cross section plots will assist the user in finding data mistakes, as well as
possible modeling mistakes (mistakes in ineffective flow areas, levees, n values,
etc ... ).

Profile Plots

The profile plotting capability is also a way to get a quick overview of the entire
study area.

Look for sudden changes to the energy grade line and the water surface.

In general, these two variables should transition smoothly along the channel.

• If the user finds rapid changes in the energy or the water surface, the results at those
locations should be reviewed closely to ensure that they are correct.

X-Y-Z Perspective Plots

The X-Y-Z Perspective Plot can also be used to get a quick view of an entire reach.

This plot is very helpful for viewing the top width of the flow area.

If the user finds dramatic changes in the top width from one cross section to the
next, then the results at those locations should be reviewed closely.

Dramatic changes in top width may indicate the need for additional cross sections.

•
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c. Viewing Tabular Output

The user should try to make use of all output types when viewing tabular results.

In general, the profile types of tables should be used to get an overview of some of
the key variables at several locations.

If any problems are found, or any results that seem suspect, the user should use the
cross section specific tables to get detailed results at a single location.

D. The Occurrence of Critical Depth

During the water surface profile calculations, the program may default to critical
depth at a cross section in order to continue the calculations.

•

Critical depth can occur for the following reasons:

1. Bad cross section data

If the energy equation can not balance because of bad cross section
data, the program defaults to critical depth.

•
2. Cross sections spaced to far apart

If the cross sections are spaced to far apart, the program may not be
able to calculate enough energy losses to obtain a subcritical water
surface at the upstream section.

3. Wrong flow regime

When calculating a subcritical profile, and the program comes to a
reach that is truly supercritical, the program will default to critical
depth.

When calculating a supercritical profile. if" t.he reach is truly subcritical,
the program will default to critical dep. ,.

12
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4. Program can not balance the energy equation above or below the top
of a levee or ineffective flow area

When the program is balancing a water surface that is very close to the
top of a levee or an ineffective flow area, the program may go back and
forth (above and below the levee) without being able to balance the
energy equation.

When this occurs, the program will default to critical depth.
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• HEC-RAS, River Analysis System

Channel Geometry and
.Flow Resistance Considerations for

One-Dimensional Modeling

Presented by
David T. Williams, Ph.D., P.E.

WEST Consultants, Inc., Carlsbad, CA
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2. OBJECTIVES

The objective of this presentation is to:

1) point out and give guidance on the important geometric considerations
associated with I-D numerical modeling of natural channels,

2) understanding of stream behavior,

3) present the important parameters that affect hydraulic losses, and

4) to identify the relative effects on hydraulic computations.
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3. CROSS SECTIONS

A. Map and Field Location

Make sure that the orientation and placement of the cross section on the map or quad
sheets are as described in the field note.

Checks can be made by noting the contour elevations and distances on the quad
sheets and comparing them with the graphs of the encoded cross sections. This will
also be a check to see if the cross section is from left to right or vice versa.

B. Channel Limits

Sometimes its hard to delineate the channel from the overbanks. A good rule of
thumb is to partition the cross section into areas of similar "n" values and then
determine the channel and overbank limits. This requires a field visit.

The secondary consideration is to locate the bank limits where there are obvious
breaks in the geometry (e.g., change in bank slope).

HEC-RAS's normal "n" value assignment is for the channel and both overbanks.
If significant areas have differing roughnesses (say over 10% of the flow area),
subdivide the overbanks and vary "n" by distance across the cross section.

C. Cross Section Orientation

If the overall cross section is skewed more than 18 degrees from the perpendicular
of the flow line (discussed later), either the cross section needs to be resurveyed or
reduced by an appropriate multiplier.

Copying cross sections in a meandering stream may require adjustments (increasing
or decreasing flow area) to the overbank areas but the channel size may not change.
This can be accommodated in HEC-RAS since it can adjust the cross section for the
three major subsections .

3



D. Cross Section Representation

Remembering that each cross section in a model is assumed to be representative of
the geometry half way to the upstream and downstream cross sections, the cross
section should be located at the places that fully describes the geometry of the reach.

Such things to consider are changes in flow width, discharge, slope, and distance
between cross sections for computational stability.

Sketch of Cross Section Orientation and Location (by participants)
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4. FLOWLINES AND REACH LENGTHS

Quad sheets should be overlaid with mylar or other transparent film and flow lines
sketched for bankfull and flood discharges (or largest event to be analyzed). If there
are radical changes in flow area between these two discharges, you may want to add
an intermediate discharge.

Remember to restrict the flowlines to a 1 to 1 contraction ratio and a 4 to 1
expansion ratio.

For any subsection, such as the channel or overbanks, the representative reach
length should be along the flow line that is intersects the center of mass of the water
in the subsection.

For a quick check, when scanning the reach lengths in HEC-RAS, the overbank side
that the stream is curving toward, looking in the downstream direction, should have
the smallest reach length.

For instance, if the reach lengths between R.M. 1.0 and R.M. 2.0 is LOB = 3,000
ft., Channel = 5,280 ft., and ROB = 6,000 ft., these values would be shown as
reach lengths for R.M. 2.0.

This would indicate that the stream is curving to the left, looking in the downstream
direction. Note that it would be very unusual if billh of the overbank reach lengths
were greater than the channel reach length.

If necessary, do not hesitate to change reach lengths for different discharges. This
can be done in HEC-RAS by creating a Plan with certain reach lengths for a low
flow range and another Plan with adjusted reach lengths for a high flow range.
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Sketch of Centers of Mass for Reach Length Determination (by participants)

5. INEFFECTIVE FLOW AREAS

Inspection of the flow lines will help in determining ineffective flow areas. In
general, if the closest flowline to the boundary starts to significantly depart from the
act"'Jal boundary, the area between the flowline and the boundary may be ineffective.

Identify those areas that contain obstructions to the flow. If these obstructions cover
a significant portion of the projected flow area (length perpendicular to the flow
lines), cross sections must be inserted at these locations.

If a cross section is located in these areas, you should use the blocked obstruction
option of HEC-RAS. Note that you should place cross sections in the influence
zones upstream and downstream of these obstructions. They should be located,
again, using the 1 to 1 contraction ratio and 4 to 1 expansion ratio as rules of thumb. •

6



•

•

•

If cross sections are located in "shadow" areas (downstream of obstructions), the
limits of these ineffective flow areas may be determined using the 4 to 1 expansion
ratio rule of thumb used in bridge modeling (discussed in a later lecture) and the
blocked obstruction option used to simulate these ineffective flow areas.

Note that the blocked obstruction option adds wetted perimeter to the computations:
this is applicable to the blocked areas but may not be directly applicable to the
"shadow" areas. In that case, you may want to adjust the "n" value in those areas
so that the effects of the additional wetted perimeter does not significantly affect the
computations.

Also check if natural or artificial levees are truly tied to high ground. This is
important because it helps to determine if the Levee Option is to be used.

6. VELOCITY AND FLOW DISTRIBUTION

Look at the velocities and flow percentage of the main channel and overbank areas.
If the prototype is fairly uniform in the longitudinal direction, the velocities and flow
distribution of the channel and overbanks should be fairly consistent also.

If the model shows severe changes occurring from cross section to cross section,
there should be a physical reason for the changes.

For instance, if channel velocity goes from 6.0 to 2.0 to 7.0 in the downstream
direction and the channel geometry and slope is relatively the same throughout the
reach, this is not a reasonable model result.

It may be that where the channel velocity was 2.0, there was a large increase in
overbank flow area, thus decreasing the channel discharge, resulting is a lower
channel velocity. One may then consider if all the overbank areas should be
available for conveyance.

Another example would be if the percentage of discharge (say 60 %) in one overbank
changed to 10% in the next downstream cross section and the percentage in the
channel stayed the same (say 20 %). This means that the other overbank changed
from 20 % to 70 % in the downstream direction.
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You must judge if the reach length between the cross sections was sufficiently long
to allow such a large transfer of water from one overbank, through the channel, and
to the other overbank.

Appropriate adjustments would be to use the ineffective flow options or adjust the
overbank "n" values. Again, remember to check the channel discharge and velocity
in relation to the adjacent cross sections.

Consider also when a levee completely separated the overbanks and channels such
that no water could interchange between the three major subsections. This means
that the percentage of discharge in each subsection should not change from one cross
section to another.

This should be accomplished by use of the ineffective flow option and, to some
extent, adjustments to the overbank "n" values.

7. TYPES OF HYDRAULIC LOSSES

Hydraulic losses can be grouped into three types of losses.

A. Hydraulic roughness (friction loss)

1) Surface roughness

2) Bedform roughness

B. Geometric related losses

C. Hydraulic transients

These losses are not mutually exclusive in that they can occur together in space and
time.

•

•

An understanding of the relative contributions of each of these losses is essential if
proper predictions of other flow conditions (especially unmeasured conditions) are
to be made. •
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• 8. HYDRAULIC ROUGHNESS

A. Resistance Equations.

Sometimes referred to as surface roughness, hydraulic roughness is the measure of
that portion of flow resistance brought on by the friction between the fluid and the
wetted perimeter thereby causing fluid energy to be dissipated.

B. Surface roughness.

The roughness coefficient most frequently used in natural channels is Manning's "n"
value. Numerous textbooks and guides give recommended values for different types
of streams. Chow, Henderson, and lately Limerinos are the most popular.

•

•

Note that in actuality, Manning's "n" varies with the hydraulic radius, which
requires an evaluation of "n" for various discharges and resulting depths. This
make the extrapolation of a rating curve to unmeasured discharges and depths fairly
difficult.

A better method is the use of a roughness indicator, k, which does not change with
hydraulic radius. The boundary surface roughness, k, which is a physical
representation of the height of the roughness elements is presented in EM 1110-2­
1601.

Note that this is for hydraulically rough channels, which is the usual field case.
Various publications, such as Chow and Henderson, give typical values for different
surfaces. Natural river beds have k ranging from 0.1 to 3.0 (Chow).

This k is different from the equivalent roughness k, which takes into account the
resistance contributions of bedforms, turbulence and eddies. However, the k
analysis is usually the best approach because once it is established, it stays relatively
constant for the same bedform and varying hydraulic parameters such as flow depth.

C. Form Roughness

It has long been recognized that form roughness, e.g., dunes and ripples, contribute
to the overall resistance to flow (Fig. 1). The ASCE Manual 54 identifies many
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researchers that have developed. methods for bedform prediction and the resulting
bedform resistance. •
. '

(Water surface ___W~ter surface,

•~);.y;:W(r0PS~·.:::.:::.:\::>-)::::~-;:_~HVX/;~:t/::~_::-J:-
F Antidune standing waves

/;"i"ii';"";""';'';'''i"./,''':';!,~tL:
G Antidune breaking wave

tWeak bOil__----
--:;::

C Dunes

:1?~::};~//~bJH~!;~~\\Wi;W&N@ljjij!:M~!@lW{[i1j~Wt.~h{?{;
A Typical ripple paltern

,60il Boi'\-
------:-'"---.,,;:::----_.-:.:?------

~!lisM'.','i;~irw2M;m\lt.
D Washed-out dunes or transition

Figure 1. Schematic of Bedforms, after Simons and Richardson (1966) •
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•

•

Some interesting observations about bedforms were made by 'Siinoils .a~d
Richardson. To get a feel for the Manning's n, the Darcy friction faetbr.'f quoted
in Simons and Richardson is converted to n, assuming a hydraulic radius of 5 feet.
Referring to Figure 1, the following observations were made.

(1) Plane bed without sediment movement.

Flow resistance is relatively small. Use of k based upon grain size is appropriate
or the Strickler equation, n= 0.034d , where d is the median sediment size of the
bed in feet. Limerinos' relationship is also adequate for sand-gravel beds.

(2) Ripples.

Resistance to flow is large and as depth increases, resistance to flow decreases.
Resistance is also independent of grain size because form roughness is much
greater than surface roughness. Ripples do not occur in· streams having a
median bed material greater than 0.6 mm. (0.05 < f < 0.13 ; 0.027 < "n"
< 0.044)

(3) Dunes.

Resistance to flow is large but less than for ripples. The resistance to flow
increases with increasing depth for median bed size greater than 0.3mm and
decreases with increasing depth for finer bed size. Dunes are the dominant
bedform in the field and are out of phase with the
water surface. (0.04 < f < 0.16; 0.024 < "n" < 0.048 )

(4) Plane bed with sediment movement.

Resistance to flow is slightly less than for plane bed without movement and is
related to the grain size. (0.02 < f < 0.03 ; 0.017 < "n" < 0.021 )-

(5) Antidunes.

If the antidunes waves do not break (often called standing waves), they are in
phase with the water elevation and have flow resistance slightly higher than for
a plane bed. If the antidune waves break, the resistance is relatively high. Note
that since the water surface and bed are in phase, the Froude number is greater
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than 1. (0.02 < f < 0.035; 0.017 < "n" < 0.023 for standing waves and:
0.03 < f < 0.07; 0.021 < "n" < 0.032 for breaking waves)

(6) Chutes and Pools.

This condition only occurs in very steep slopes. Flow resistance is relatively
-- _high. (0.07 < f < 0.09; 0.032 < "n" < 0.036)

D. Bedform prediction.

Various investigators have developed bedform predictors and are described in
Sim ns and Richardson (1966). These relationship are empirical, site specific and

\ do not take into account all variables of importance.

They should be used only as indicators of possible bed behavior for sensitivity
analysis and not as design parameters.

E. Recommended procedures for flow resistance including bedforms.

(1) Assume a rvfann.ing's "n" using Chow or other guidelines.

(2) Compute hydraulic parameters and using the bed sediment size,
determine the bedform based upon the accepted method for analysis
(see Simons and Richardson, 1966).

(3) Estimate the "n" for the determined bedform. If the assumed and
estimated "n" are close, go to (4), if not, go to (2) above using the new
estimated "n" value.

(4) Compare the resulting "n" with the range of "n" for the stream type
using Chow or other guides. If outside the range, reevaluate the

- sediment size, or investigate if the "n" used is reasonable. To
maximize the water elevation and minimize the velocity, use the high
e _d of the range. For the opposite effect, use the low end of the
roughness range.

12
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• F. Vegetation.

Vegetative resistance is usually associated with overbank roughness. Often the bank
can contribute vegetative resistance to the channel, and if so, the channel should be
subdivided into representative zones with varying "n" values.

Excellent references on Manning's "n" for overbanks are Arcement and -Schneider,
Barnes, and Pasche and Rouve.

G. Urban areas

. - ... .... ~.... , .. ',
, ,
.. l'

•

Not much research has been done in determining flow resistance in urban' apeaS.
Heil developed a method based upon' assumed spacings and distances between
buildings, taking into account the alignment of the streets to the flow. However, this
method has not been fully tested.

. . ~!,

H. Seasonal variation
-.- i

The changing of the seasons cause the vegetation and foliage density to change. The
change also changes the Manning n. This becomes' important when calibrating a
rating curve in which the points on the curve are from different seasons.

If there is a significant difference, a separate rating curve for each season should be
generated and "n" values calibrated and interpolated or extrapolated based upon
these rating curves.

9. GEOMETRIC RELATED RESISTANCE

A. Channel contractions and expansions
" .

. ,

If the channel width transition slopes inward or outward at a slope of is 1:4, then 0.1
and 0.3 are recommended by Chow for contraction and expansion coefficients,
respectively. These values should be increased for more ablupt transitions.

• The maximum values, such as at 90 degree angles, are 0.6 and 0.8 for contraction
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and expansion, respectively, although EM 1110-2-1601 has a maximum of 0.3 for
contractions:. •"'" \" I. ,.

Note also that these values are for subcritical flows and separate analysis is required
f0r supercritical flow of various types of transitions .

.,.- .> , ,

:: J - ';R. ChannelaHgmnent
"i .. '

Hydraulic losses- occur in bends and meanders due to induced secondary flows. For
,'a ratio -of radius of curvature to channel width greater than 3, bend losses are

~ negli-gibl'e. .

Scobey (referenced in EM 1110:.2-1601) recommended that "n" be increased 0.001
for each 20 degree of curvature per 100 feet of curvature, up to 0.003.

Cowan suggested that for meandering, the total "n" value be multiplied by 1.15 to
1.3 for appreciable to severe meandering, respectively, with a sinuosity (ratio of
channel length to valley length) of 1.2 to 1.5 being appreciable and severe being a •
sinuosity greater than 1.5.

C. Other losses related to geometry

Irregular channels are channels that vary in elevation laterally along a cross section.
An example is a channel with alternating sand or gravel bars. This tends to increase
the roughness but no quantitative guidance is available.

Bridges cause head loss but since there are sufficient references, this will not be
covered.

Junctions of rivers with tributaries create hydraulic losses and can be simulated in
HEC-RAS.

Knowledge of these types of losses help you to understanding the physical
phenomena, and thus, help in understanding the relationship between the prototype
and the model. •
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• EM 1110-2-1601 contains information on estimating the losses associated with
hydraulic jumps. ,"!' ~ " ,.::. ,: ;".11 ~.P(,/~

Note that HEC-RAS can predict the location and head loss due to a hydraulic jump.
However, since a hydraulic jump is a rapidly varied flow phenomenon, HEC-RAS
(which is a gradually varied flow program) can only give YOll th~;estirnatedJlpsfteam

and downstream cross section locations between which the hydraulic jump occurs .
. t ~.l(i "1("; ~.:..; > !~. :... ·'.i' :~ :: ;-:!J_:.':'·i~T;~ :....

For locating jumps;' insertion ,oLadditionat- cross sections'betwee.n the$~BGrOSS

sections is recommended because it gives a better definition of the geom~tryl.1Je.~the

jump and a better estimate of the approach Froude number which indicates how
"sharp" the hydraulic jump is. )' ., ),~:._,' .; " ::'</.~~:'

:~.. l
, ;

Note that these additional cross section may cause computations to locate the
hydraulic jump beyond the original cross s,~ctiGm ocations ofthe,.jUf:('lp:.>: . ;".,~, ;/.j~;

• ... >'c •••.
;

; - .. "~ 1.; ..,

. ,...~..
• .;.~ -~ '__ :. .l':""'':':''

•

• ·)... 1-,-.... :' ,.l.

'~';
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